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Welcome...

“If you are passionate about shooting landscapes, then we hope
you'll find this comprehensive guide helps you take your best

ever pictures. Millions of photographers around the world have
discovered the benefits of capturing images with a digital SLR -
their ease of use, wide choice of lenses and incredibly high image
quality are just three reasons why DSLRs remain the most popular
type of camera with photo enthusiasts. The Nikon Guide to
Landscape Photography has been produced to allow Nikon DX and
FX-format DSLR users to make the most of their Nikon camera outfit. It's packed
with essential advice, photo techniques, expert guides and stunning photography
and aims to deliver all the information, advice and inspiration you need to improve
your photo skills. It's brimming with tutorials from many of the UK's favourite
outdoor photographers, with emphasis on key in-camera techniques, as well as
essential and creative post-processing skills. Before heading out with your Nikon
kit, be sure to read up and learn from the UK's leading experts before heading out
to capture landscape images like a pro. All the best!”

DANIEL LEZANO, EDITOR

Meet our landscape experts

All our experts are regular contributors to Digital SLR Photography magazine. For expert advice
and inspiration to help you improve your photo skills, pick up the latest issue, available on the
second Tuesday of every month. For further information, visit: www.digitalslrphoto.com

®ROSSHODDINOTT @®HELEN DIXON ®LEEFROST ®ADAM BURTON
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THE NIKON GUIDE TO LANDSCAPE PHOTOGRAPHY Thebasics

THE BASICS

CAPTURE STUNNING LANDSCAPES — we all want to be able to been a little bit disappointed by a photo that doesn't quite live up
doit. Fantastic landscapes inspire more photographers than any to our great expectations. The difference between a decent snap
other type of image and on the face of it, well, it should be easy to | and a stunning image is often down to a few versatile ideas, some
do. Find an awesome vista and point your camera at it, pressthe | easily learned expert knowledge, the right equipment choice and
shutter and that should do the trick. This simple approach will careful planning. This inspirational guide will provide you with an
probabl bag you a decent snap, but often the image you capture | excellentgrasp of these fundamentals and help you transform

e glorious scene i iali
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Composition

Learn the art of composition and you'll be
halfway there to taking brilliant photos

MORE THAN ANY other factor, composition can turn an
average image into a masterpiece. There are a small
number of techniques that, once learned, will serve you
well in many different situations.

Composing the elements in the frame is an important
skill of taking great pictures. You need to carefully
consider how points of interest are arranged and how
they relate to each other in the scene.

Placing a subject centrally in the frame usually results
in a static rather than dynamic composition. Placing the
subject off-centre encourages the eye to move around
the frame more. One way of dividing the frame up to
achieve harmony is to use the rule-of-thirds (see
below). There is research to suggest that our brains are
wired to find these arrangements more attractive.

The rule-of-thirds

This is a simple way of organising the elements in the

frame so that they create a balanced composition. As a

compositional tool, it's been around for a few centuries

and is a simplified version of the ‘golden section’, which

is used in art and architecture.

Imagine two vertical lines dividing the viewfinder into

thirds. Now do the same with two horizontal lines. You
_ then organise the main elements of the picture within

this grid. For example, with a simple landscape, place

the horizon on one of the lines so that you have

two-thirds land and one-third sky, or vice versa.
S If you have a strong focal point, such as a tree or
building, you can place it on one of the points where the
horizontal and vertical lines intersect. This willmake a
much more dynamic composition than if you were to
place the focal point centrally, which can make a picture
look rather static. Inexperienced photographers often
put the subject right in the middle and it rarely works.

Moving an element of a scene to a different

intersection can create a startlingly differentimage,
such is the power of the rule-of-thirds. Don't be afraid
to experiment with different variations on a theme.

RULE-OF-THIRDS GRID: This image follows the rule-of-
thirds quite closely. There is approximately two-thirds land/
sea and one-third sky. The lighthouse and obelisk are divided
by the left vertical, each equidistant from it.
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@ Foreground interest

As the world is three-dimensional but a photograph is two-
dimensional, one of the main reasons that landscape images fail is that
they don't convey the sense of depth that our eyes see. Fortunately,
there are a few compositional tricks that we can employ to get around
this rather frustrating little problem.

A very effective way to create depth in a photograph is to include
a strong foreground, often in conjunction with a wide-angle lens.
Emphasising the foreground in this way will add depth to the picture by
creating an entry-point for the eye, pulling the viewer into the scene
and giving the picture a sense of distance and scale.

Wide-angle lenses help this technique because they stretch
perspective, exaggerating the elements close to the lens and opening
up the view beyond the foreground.

But be careful, this can result in the middle distance looking empty
and lacking in interest so the trick is to shoot from a lower viewpoint.
This compresses the middle distance, so that there isn't too much
empty space in the composition. You'll also need to use a small aperture
and focus carefully to maximise depth-of-field, keeping foreground
and distant objects in focus (we'll explain how to do this later).

BOTH: MARK BAUER

GETTING IT RIGHT: The cow parsley and gorse make attractive foregrounds to
lead the eye into the scene and provide suitable frames for the view beyond.
Awide-angle lens and a small aperture of f/22 provide plenty of depth-of-field.

HELEN DIXON

@ Layers and planes

Another in-camera technique that can be used to add depth to an
image is the creation of a layers. Layers in an image can be created by
having a series of overlapping shapes, like the hills in this image, right,
or by strong side-lighting, creating alternate bands of light and shade
that can create the effect of layers of light.

This kind of technique works particularly well with longer lenses that
compress perspective and stack overlapping forms. Each layer, or
plane, appears thinner and closer to the next, exaggerating the effect.
Just remember longer lenses produce less depth-of-field so you'll
need to use smaller apertures, such as f/16, if elements are in the
foreground or near the middle distance.

This shot was taken at dawn near Lyme Regis using a 70-200mm
zoom at around 100mm. The longer focal length compresses the
distances between the layers and the strong, directional light helps
emphasise the layers — the early morning mist adds bags of atmosphere.

NOXIN313H

BIG FOREGROUND OR SMALL DETAIL: It's not always necessary to have a
large foreground; colour, texture and pattern can provide foreground interest.
This carpet of flowers is as effective as the strong shapes of rocks, opposite.

® Lead-inlines

Lines represent depth in a picture and can be used to lead your eye into
the picture and guide it around the scene. Lines are everywhere:
man-made, such as roads, paths and hedgerows; or natural, such as
rivers or the coastline. All willadd dynamism to your photographs. Lines
don't have to be real, they can be implied like the patterns created by
waves over a longish exposure, or objects pointing into the frame.

Lots of things can bring linear energy into your work.

Straight, converging lines are very dynamic and can give a lot of impact
to a picture, but there is always the danger that the eye follows the lines into
and then very quickly out of the frame again. Pictures with only converging
lines might have immediate impact, but can still be unsatisfying. It's a good
idea to try to place some object of interest within the frame — a figure or a
tree, for example — to give the eye something to settle on within the scene.

Lines that curve gently inan 'S’ shape lack the immediate impact of
straight, converging lines, but can result in a more satisfying image.

They can lead the eye gently through the whole picture, allowing the
viewer to take in other elements within the composition.

dINVEHIYW




TOPTIP
Keep it simple!
Composition is all about
what you choose to include
in the frame — and also
what you choose to leave
out. Often, less is more and
compositions that are
uncluttered can be the

most successful

NOXIAN33H
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Break the rules!

Like all rules, the rule-of-thirds needs to be applied with
judgement rather than as a matter of course and there
willalways be situations where it can be ignored. For
example, when shooting a scene where the sky is
reflected in water, you might want to place the horizon
across the middle of the frame, giving the two elements
of the shot — sky and reflection — equal weighting.

If there is no interest in the sky, place the horizon
higher in the frame or crop it out altogether. To increase
a sense of emptiness and isolation, the horizon can be
placed very low in the frame. The beauty of shooting
digitally is the ease at which you can review your efforts
and experiment to ensure the perfect composition.

>
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@ Find natural frames

A popular compositional device is to use elementsin a
scene to frame the view beyond, such as an archway,
doorway, window or the overhanging branches of trees.

Try using frost-covered plants and gateposts to create
a natural frame for the main subject of your shot. Use
the frame to lead the viewer's eye into the scene for
some truly eye-catching results.

Controlyour focus and depth-of-field carefully
though. While a small aperture often works best,
blurring the frame significantly can help keep attention
on the main subject. If you do want to render your frame
out of focus, make sure you blur it enough so that the
effect looks deliberate and not like a mistake in focusing.

® Experiment with viewpoints

Finding the right viewpoint is key to successful landscape
composition. Rather than shooting everything from head
height, experiment with high and low viewpoints.

Higher viewpoints have the effect of opening up the
planes in the image and are useful when using standard
and telephoto lenses. When photographing well-
known landmarks, it's tempting to use the established
viewpoints, but spend time looking for a fresh view, as
it's much more satisfying to capture something original.

While there’s nothing wrong with the first picture, it's
the 'standard’ view of Old Harry Rocks in Dorset. Without
having to move very far, however, a less photographed
and more dramatic viewpoint has been found.

YINVEHIVW 'H1O8
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Lead-inlines

Master one of the mostimportant
compositionaltools: lead-in lines

FEW COMPOSITIONAL devices canimprove
the impact and add depth to your landscape
pictures as well as lead-in lines.

When you think of lead-in lines, what
comes to mind? Rows of crops, a seemingly
never-ending road, a bendy stream? What
about shadows, footprints, clouds, the
coastline, windows, piers, cracks, paths or
rocks? The list can go on and on. Although
lead-in lines come in many guises, some
natural, others man-made, all of them tend
to either lead the viewer in and out of the
picture or towards a focal point. The latter
being the preferred choice as it allows the
eye to settle within the scene, but both can
work well depending on the picture.

Some of the most effective lead-in lines
start from the bottom edge of the frame and
go straight in to the centre of the picture, like
a pier towards the horizon, but there are
many variations that can have just as much
impact, depending on the scene. While
straight lines quickly draw the eye to the
point of interest, curved lines force the
viewer to take a more leisurely journey
through the image. Vertical lines, shot froma
low angle, like those on a building, add
tension to a picture and diagonal lines work
well if they travel from the bottom left to the
top right of a picture, as that's where the
human eye naturally gravitates. It doesn't
have to be a single line either: multiple lines
only strengthen the effect of one line, as
long as they're clearly defined and heading
in the same direction. It's very important to
try to keep the elements within a scene
connected, as any break in the flow of the

Think differently

Try photographing lead-in lines from different

NOXIAN313H

line will leave the composition feeling
disjointed and allow the viewer's gaze to
wander aimlessly in and out of the frame.

You can enhance your lead-in lines
depending on what viewpoint and lens you
choose, as both can either flatten or stretch
perspective. The most dynamic distortion of
lead-in lines is converging verticals.
Converging diagonal lines create a powerful
impression of distance and depth, especially
if they converge in to the centre of the frame
and run parallel to each other. By standing in
the middle of them, you'll find that the
further the lines are away from the camera,
the closer they get to each other, creating
what's known as a vanishing point when
they join. Awide-angle lens can greatly
enhance this effect as it stretches
perspective — so the lines seem wider at the
start and narrower in the distance — whereas
atelephoto lens compresses perspective
and hinders the feeling of depth.

LIONIQdOH SSOY
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1) Lead-in lines don't have to be straight or lead
to afocal point: the line can also be the interest
in the picture. Note how your eye is led through
the scene by the wintry tree-lined road.

2) When using converging verticals, you need
to get the entire scene in focus. Set the camera
onatripod, select a small aperture (f/11-f/22) and
focus on the hyperfocal distance for maximum
depth-of-field.

3) Simple compositions can sometimes be the
most effective. Think about creating a graphic
coastal landscape with nothing more than
groynes or a pier as a lead-in line. By connecting
it to the horizon, too, it means the viewer's gaze
isled in to the far reaches of the scene and led
out of the frame by the horizon line.

4) Diagonal lines can be used to draw the gaze
from bottom left to top right, where the eye
naturally gravitates, as in this coastal landscape
where the lines of rocks converge towards the
stunning sunset sky.

5) The fence in this picture is used as a neat
device to draw the eye in towards the focal point:
the elevated castle in the distance.

NOLYNE Wvav
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angles. You may find that photographing the lines
entering the frame at an angle works better than
if you captured them starting within the frame.
The opposite can be true, too. Try different
perspectives: get low to the ground for extreme
converging verticals. Tilt the camera up to see
what vertical lines you can find and try to elevate
your position by standing on a bridge, for instance.
Above all, keep your eyes and your mind open for
less obvious linear aspects and don't forget the
other guidelines for composition, including
foreground interest and the rule-of-thirds.

NOXIAN313H
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Foreground interest

Swot up on how you should use foreground interest to give your
shots depth and scale and improve the impact of yourimages

THE LATE, GREAT war photographer

Robert Capa once said, “If a picture’s not
good enough, you weren't close enough.” He
was talking about capturing the drama of
human conflict, of course, and the need to be
in the heart of the action — an approach that
unfortunately eventually cost him his life.
However, the same maxim can easily be
applied to landscape photography because if
you want to capture the drama of a great
scene, you need to move in close and make
the most of the foreground — it's one of the
important elements you need to create a
dynamic composition.

Foreground interest is useful for a number
of reasons. First and foremost, emphasising
the foreground will help to give your
photographs a sense of distance and scale.
This is due to perspective — features close to
the camera look much bigger than those
further way, so our brainimmediately
registers that the smaller features must be in
the distance and we see the image as
three-dimensional, making it more realistic.

Second, the foreground provides a
convenient entry point into the composition
for the viewer's eye, which then naturally
travels up through the scene to the focal
point or the background. A successful
composition needs a ‘hook’ to entice the
viewer and hold the attention. With
landscapes, the foreground is that hook.

Third, the foreground contains more
information than the rest of the scene, and
being closest to the camera allows you to
record the fine detail that isn't affected by
haze, mist and fog. Distant features will record
softer and undefined in such conditions.

Wide-angle lenses are the most useful for
exploiting foreground interest as they allow
you to include elementsin a shot that are
literally at your feet. The way wide-angle
lenses ‘stretch’ perspective also makes those
elements loom large in the frame while

NOLING Wvay

everything else seems to rush away into the
distance. The lower the viewpoint you adopt,
the more the foreground will dominate.

Lenses with a focal length of 16-18mm
(24-27mm on full-frame sensors) are a
relatively safe bet to begin with as they're wide
enough to include lots of foreground interest
without being so wide that you end up with all
foreground and nothing else. Once your
confidence grows, you can produce amazing
images with ultra wide-angle lenses from
10-15mm (15-22mm full-frame), but you need
to getreally close to the foreground, otherwise
it will seem miles away due to the excessive
‘stretching’ of perspective that you get with
these wider lenses.

Telephoto lenses are less dynamic in this
respect, as the foreground interest you include
is formed by elements or features in the scene
that are obviously further away, while the
foreshortening of perspective 'squeezes’ the
elements together so that you don't get the
same sense of distance and three-dimension
as with awide-angle. Nevertheless, the effect
can still be strong, with a single feature
dominating the foreground.

What can be used as foreground interest?
Pretty much anything — rocks, rivers, walls,
gates, fences, trees, moored boats, sand
ripples, reflections, people. Features and
elements in the scene that create natural or
assumed lines work the best of all, as they
lead the viewer's eye into and through the
scene. Lines that travel vertically work well,
lines that travel diagonally from bottom left to
top right work even better, and lines that
converge into the distance, such as railway
tracks or straight roads, are the most
powerful of all. To make the most of vertical
and converging lines, turn your camera on its
side and shoot in portrait format. Diagonal
lines are better shot in landscape format as
they have further to travel through the
composition, holding attention for longer.

1S0¥433
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1) Use a wide-angle lens to ‘stretch’
perspective and a low viewpoint to make the
foreground interest more prominent.

2) Try picking subjects that form diagonal lines
leading from the bottom left to the top right of
the frame, like these boats do, as it draws the
viewer into the picture.

3) Instead of using foreground interestas a
prelude to a distant focal point, try composing
pictures where the dominant subject is in the
foreground and keep the background simple.
4) One good reason why you shouldn't leave
home without an array of ND grad filters is to
ensure your foreground is correctly exposed.
In low-light conditions, like a sunset, it's easy
to render the foreground dark and distracting.
5) Practically anything can work as foreground
interest, as long as it's composed well and fits
with the rest of the scene. Look for unusual
subjects or for objects that you may never
have considered using before, such as
driftwood, shells or wreckage remains.

6) Rocks are the most popular subjects to use
in a coastal landscape and can be the most
effective when used as a lead-in line, also.
Jetties and piers work well, too, and have the
added bonus of you being able to introduce
converging verticals.
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Maximise depth-of-field

There's no pointincluding fantastic
foreground if it's out of focus; what you need
is enough depth-of-field for front-to-back
sharpness. As a rule of thumb, if you use a
camera with an APS-C sensor with a focal
length around 16-18mm, focus the lenson a
point 1.5m from the camera, stop down to
f/11 and everything will be sharp from around
75cm to infinity. For wider focal lengths in the
10-15mm range, focus on a point one metre
away, stop down to f/11 and everything will
be sharp from around 50cm to infinity. For
full-frame DSLRs with a focal length in the
24-28mm range, focus on a point1.5m
away, stop down to /16 and depth-of-field
will extend from around 75cm to infinity. For
wider lenses in the 16-20mm range, focus
on 1m, stop down to f/16 and you'll get
depth-of-field from around 50cm to infinity.
Basically, to maximise depth-of-field with
wide-angle lenses, you need to focusona
point relatively close to the camera; many
photographers focus further into the scene,
resulting in an unsharp image.
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How to use natural frames

Forideas, inspiration and information on how to improve your
landscape pictures by using environmental frames, read on...

ONE OF THE MOST effective ways to
produce a tight, structured composition is by
framing the scene or subject you're shooting.
Not only does this help to direct the viewer's
eye towards the most important part of the
picture, but frames can also be used to hide
uninteresting areas, such as a broad expanse
of empty sky. Natural frames can be used in
all types of photography, but are abound in
the landscape if you keep your eyes peeled.

When you think of natural frames, what
comes to mind? The overhanging branches
of a tree are perhaps the most obvious. A gap
between trees that frames a distant focal
point? How about overhanging cliffs or the
entrance to a cave? On the coast, the gaps
between rock outcrops or cliffs can be used
to frame the beach and sea beyond.

These are all fairly obvious options, but if
you start to think laterally, other ideas will
present themselves. For example, the shape
of a hillside or mountain can be used to
frame features positioned in front of it.
Clouds in the sky can act like a frame, too
— containing elements on the ground and
forcing the eye down towards them.

When shooting using a frame and the sun
is behind you, light will fall onto the entire
scene, so everything will be of a similar
brightness and should record more or less as
you see it. If you're shooting into the light,

OLOHdXDOLSI

however, or the suniis to the side of the
camera’s position, the main part of the scene
may be well lit, but little or no light will fall
directly onto the frame and it will record dark
oreven as asilhouette. If the frame and the
scene beyond itis evenly lit, you shouldn't
experience any problems obtaining
well-exposed images. If you're standing in
the shadow of the frame, however,
overexposure is likely. If this proves to be the
case, step beyond the frame and out of the
shade, take an exposure reading, setiton
your camera using the AE-Lock or by
shooting in manual exposure mode, and
don’t change anything once you recompose
with the frame included. Alternatively, take a
shot from your shooting position, check the
preview image and histogram, then apply
negative or positive exposure compensation
as required and retake your exposure.

Finally, if you want the frame and the
scene beyond to be rendered in focus,
select a smalllens aperture, such as f/13, and
use hyperfocal focusing to maximise
depth-of-field (see page 32 for details).
Alternatively, by setting a wide aperture such
as f/4 and focusing on the scene beyond the
frame, depth-of-field will be reduced so
that the frame itself is thrown out of focus
and all attention is directed towards your
main subject.

15044331
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The effect the frame has on the
composition is partly determined by your
lens choice. Wide-angle lenses stretch
perspective so the apparent distance
between the elementsinasceneis
increased. If you move close to a natural
frame, you can include it in the shot, but
you'llstill get a clear view of the scene
beyond. Telephoto lenses have the
opposite effect — they compress
perspective so the elementsin a scene
appear closer together. This makes them
less suited to shooting natural frames,
though they can be handy at times if
you're unable to get close to an effective
frame and you're happy for the scene
beyond the frame to be more selective.

1) Using archways is something we've seen many
times before, but they always lend themselves
beautifully to frame a focal point. It works
particularly well with this church because the
detailin the frame complements the subject.

2) Think about symmetry when looking for
natural frames; it is always pleasing to the eye.
Even the most simple of arrangements can
create impact, as seen here.

3) Using natural frames is a great way of adding
foreground interest to a scene. While the castle is
the focal point in this image, it's the dramatic
spikes that add impact for the viewer.

4) Your subject doesn't have to fill the frame to be
striking — here the extra space in fact helps to
frame and draw emphasis to the small chapel. Try
using subtle but graphic shapes in the landscape,
such as clouds or hills, to improve your
composition — simply centring the church would
fail to create the same energy as it does here.
Think outside the box and you'll begin to see
frames in the most unlikely places.

5) The dark frame here is a striking contrast to the
lighter scene beyond. Look for differences in
colour to emphasise your frame and add impact.
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Exposure

Digital SLRs have extremely accurate, multi-zone metering systems with a histogram function to help us
check accurate exposure, so getting it right has never been easier. However, to take more creative control,
you heed to take things into your own hands. Here are a few techniques for perfect exposures

Mark Bauer
. lwaslooking for an unusual view of
d "*1 Corfe Castle in Dorset, so | sauntered
- along to this graveyard in the village.
ﬂ Having found a composition based
around one of the crosses, the next

problem was sorting out the exposure. Here's
how | tackled the challenge:

1) This is what the camera’s multi-zone meter
came up with, without the aid of any filtration. The
scene is high in contrast, and the camera has
struggled to capture all the tonalinformation.

2) Spot meter readings from the base of the cross
and the sky revealed a difference in brightness of
about 4.5 stops. Setting an exposure for the land,

| fitted a 0.9ND grad (three stops) and pulled it
down below the horizon to the edge of the darkest
shadow area. | used a soft grad so that it wouldn't
cutalineinto the cross. As there is some loss of
detailin the brighter parts of the sky, | reduced the
exposure by two thirds of a stop and reshot.

3) Theresultis that the image has now been
‘exposed to the right’ (see over the page for
details), without ‘clipping’ the highlights. The
histogram shows that there are still dark tones, but
also plenty of information in the top section, and
no clipped shadows.

4) A straight conversion of the Raw file looks dull,
the picture lacks contrast. For the final version, I've
brought the exposure down slightly and added
more contrast, especially in the shadows, to
recreate the drama of the original scene. I've also
tweaked the White Balance to add warmth and
increased the saturation too.

5) For comparison purposes, | also took a shot that
was underexposed by one stop. As you can see, it's
left the shadows muddy and lacking in detail.

MID-TONE METERING

Metering systems in digital cameras are

calibrated to an 18% grey mid-tone. Basing
exposure readings on a mid-tone such as grass
is a good starting point for accurate exposures

Expose correctly

@Shadows

These two examples on the
right show why it'snota
good idea to underexpose
your shot and then try to
open up the shadows
during post-processing.
The nearestimage is around
one stop underexposed (to
maintain highlight detail)
and the shadow curve has
been pulled up to match the
exposure in the correctly
exposed version on the
right. As you can see, not
only is there posterisation in
the shadows, rather than
smooth tonal transitions,
and tons of noise, but also
the sensor has recorded
significantly less detail.
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@ Exposure for coastal landscapes
Achieving the correct exposure in coastal shots can be a bit trickier
than for inland landscapes, as there are several things that can fool the
camera’s metering system — for example, bright highlights on water or
bright white foamy waves can lead to underexposure. On the other
hand, if you have chosen a large, dark rock for your foreground, this
could cause the camera to overexpose. You need to keep an eye out
for any large areas of particularly bright or dark tones and apply
exposure compensation accordingly. Itis good practice to check the
histogram after each shot and be prepared to reshoot if necessary.
There can also be a huge range of contrast within any one scene, with
bright skies, dark rocks and bright highlights on water. Neutral Density
(ND) graduate filters are essential, and depending on the conditions and
the brightness of the sky and sea relative to your foreground, you may
need to pull the grad down very low in the frame. This could even be
below the horizon, to the top of your foreground. If you don't, you
might end up with a correctly exposed sky and foreground with a band
of over-bright water in the middle of the picture. So when metering the
scene to choose the strength and placement of the filter, remember to
take readings from the foreground, sky and sea.

Long exposures

@ Exposing to capture movement

One of the great things about taking photos
by the sea is the opportunities it gives for
capturing the movement of waves and
adding atmosphere. In low light, with the
lens stopped down to extend depth-of-field,
long exposures are a hecessity. They may
range from several seconds to minutes,
depending on lighting conditions. As waves
wash around rocks or up and down the
shore while the shutter is open, they will
record as a romantic, mysterious mist. To
capture the drama of waves breaking on the
shore, speeds of 1/4sec or slower work well.
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Histograms: An aid to checking exposure

IN SIMPLE TERMS, a histogram is a two-dimensional graph, often resembling a range of mountain
peaks, which represents an image'’s tonal extent. While, at first glance, histograms might appear
complex and confusing, they're actually very simple to read. They are an essential aid for digital
photographers striving to achieve consistently correct exposures in-camera and are a more
accurate method of assessing exposure than looking at images you've taken on the LCD monitor.
Therefore, if you're not already in the habit of regularly reviewing your images’ histograms, itis time
you did so. With our guide, you will soon feel confident assessing histograms.

® Whatis a histogram? A histogram is a visual representation of an image’'s tonal range. The
horizontal axis indicates the picture’s extent from pure black (O, far left) to pure white (225, far right).
The vertical axis shows how many pixels have that particular value. Looking at animage'’s
histogram, you can tell whether the picture is made up of predominantly light, dark or mid-tones.

Although its appearance is also dictated by the colour and tone of the subject, a histogram with a
large number of pixels (or a sharp peak) grouped at either edge is an indication of poor exposure.
For example, a histogram with a large number of black pixels (grouped to the left) often signifies
underexposure and that subject detail will be obscured in the shadow areas. A large number of
pixels grouped to the right of the histogram normally indicates an overexposed image. The image's
highlights will burn out (or ‘clip’) and this detail is irretrievable. A graph with a narrow peak in the
middle and no (or few) black or white pixels indicates an image lacking contrast.

® So what should a histogram look like? This is a tricky one to answer. Despite what some people
may say, there is no such thing as the perfect histogram. It simply tells us how a picture is exposed,
allowing photographers to decide whether — and how - to adjust exposure settings. Therefore, a
histogram of a light scene will be very different from one with predominantly black tones or one
with a mix of both. However, generally speaking, a histogram should show a good spread of tones
across the horizontal axis, with the majority of pixels positioned near to the middle (100,
mid-point). Normally, it is desirable to avoid peaks to the right-hand side of the graph, as this is
usually an indication of ‘burnt out’ (overexposed) highlights, resulting in lost detail.

When assessing a histogram, it is important to consider the brightness of the subject itself. For
example, a scene or subject boasting a large percentage of light or dark tones — like snow or a
silhouette — will naturally have an effect on the overall look of the resulting graph. Therefore, while
it is possible to make recommendations, it is impossible to generalise about what is and isn't a good
histogram. While an even spread of pixels throughout the greyscale is often considered desirable,
you will also need to use your own knowledge gained through experience.

®How do | check animage’s histogram? Most Nikon digital SLRs allow you to view the histogram
on the LCD monitor during playback. To do this, press the playback button to view the image and
then cycle through the additional photo info screens until the histogram is displayed. Make this
your default setting so you can quickly access the histogram and assess exposure immediately
after taking the picture when required. If the histogram indicates underexposure, apply positive
exposure compensation. If pixels are grouped to the right-hand side and the image appears
overexposed, dial in negative compensation. Using the histogram is a far more reliable method of
assessing exposure than looking atimages on the LCD screen, particularly when trying to view
images outdoors in bright light when the light reflecting from the LCD can prove deceptive.
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Exposure warnings

Hi

IRE
NIKON D3

Most DSLRs are designed with a playback
function known as the ‘highlights screen’.
While histograms provide a graphic
illustration of animage’s tonal extent,
helping you assess exposure overall, the
highlights screen — or highlights alert — helps
photographers to avoid highlights burning
out. White or very light subjects in direct
sunlight are especially prone to this. A
histogram with a sharp peak to the far right
normally indicates areas of overexposure.
However, the highlights alert actually
identifies the pixels that exceed the value for
pure white (255). Those pixels are not given a
value, meaning they cannot be processed
and are effectively discarded, having no
detail or information recorded. When the
image is reviewed on the LCD, the pixels
falling outside the camera’s dynamic range
flash or blink, providing a quick and graphic
illustration of where picture detail is ‘burned
out’and devoid of detail. To rectify this, set
negative exposure compensation so that the
nextimage is recorded darker. Acamera’s
highlights alert is not always switched on by
default. Consult your manual and switch it
on when you feel this type of exposure
warning would prove useful; normally it's via
the camera’s Playback Menu.
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Peaks to the left: The histogram is skewed to the
left. The dark backdrop means many of the pixels
arein shadow areas, but the image is well exposed.

Perfect exposure: A typical landscape scene gives
aso-called ‘perfect histogram’ as it has a good
spread of tones and peaks through the mid-tones.

Peaks to the right: A well-exposed shot of an overly
light scene gives a histogram skewed to the right,
much like that of an overexposed image.
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TOPTIP

Colour histograms
Some DSLRs allow you the
option to view separate
histograms for the red,
green and blue channels.
You're better off ignoring
this option and using the
standard greyscale
histogram

Expose to the right

‘Exposing to the right'is fast becoming a widely accepted approach to help
maximise image quality — although it only applies if you shoot in Raw. With this
technique you effectively push exposure settings as close to overexposure as
possible without actually clipping the highlights. The result is a histogram with
the majority of pixels grouped to the right of the mid-point — hence the name
‘expose to the right'. So, when you're confident you understand exposures
well enough, give this technique a try and push the exposure as far to the right
of the histogram as you can, without clipping the highlights. The image will
probably look a little light once in the Raw converter, but this is easily
corrected with the brightness and contrast controls, and will give much better
results than trying to lighten a darker image.

CCD and CMOS sensors count light in a linear fashion. Most digital SLRs
record a 12-bitimage capable of recording 4,096 tonal values over six stops. e
But the tonal values are not spread evenly across the six stops; each stop - VAR W
records half the light of the previous one. So, half of the levels are devoted to i I‘\ \‘\ ¥ X ‘-\
the brightest stop (2,048), half of the remainder (1,024 levels) are devoted to )¢ F\
the next stop and so on. As a result, the last and darkest of the six stops only e e
boasts 64 levels. This might seem confusing but, simply, if you do not properly D & O "
use the right side of the histogram, which represents the majority of tonal
values, you are wasting up to half of the available encoding levels. If you Mainimage & inset: Exposure to the right of the histogram will
deliberately underexpose to ensure detail is are retained in the highlights — capture maximum detail and minimum noise. Once in the Raw
acommon practice among many digital photographers — you are potentially converter, theimage will look too light and washed out, so use the
losing a large percentage of the data that can be captured. Brightness and Contrast controls to adjust the image’s appearance.
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Aperture-priority is the mode for you!

Sowhatis it that makes aperture-priority
mode more useful than any of the other
exposure modes for taking pictures of
landscapes? Read on — all will be revealed

APERTURE-PRIORITY MODE gets its name because it
allows you to decide which aperture (f/number) you want
to use to take a photograph, while the camera
automatically sets the corresponding shutter speed,
based on light levels, to achieve the correct exposure. In
other words, it lets you prioritise the aperture selection,
and it chooses the shutter speed accordingly.

As the lens aperture is the most influential factor over
depth-of-field (the zone of focus) in a photograph,
aperture-priority mode is the most practical shooting
mode if you are photographing a subject or situation in
which control over depth-of-field isimportant.
Landscape photography is the best example. Generally,
when shooting landscapes, you'll want to make sure your
depth-of-field is broad enough to record the whole
scene in focus, from the immediate foreground to infinity,
which means that you'll need to set a small aperture, such
as f/11. Aperture-priority mode lets you do this easily,
because you have to actively set the required aperture.

When shooting portraits, the opposite tends to apply
— you want shallow depth-of-field so that your subjectis
recorded in focus but the background is thrown out of
focus. That means making sure you take the picture with a
wide aperture such as f/4 or f/2.8, which again is easy
when shooting in aperture-priority mode because it's you
and not the camera that decides which aperture to use.

That said, you can still control which aperture is set
using other exposure modes, but it just requires a slightly
different (and longer) way of working. In shutter-priority
(S) mode, for example, you need to change the shutter
speed until the camera sets the aperture you want. In
program mode, you can use the program shift function to
change the aperture and shutter combination that the
camera has set until you get the right aperture.

Where aperture-priority mode trumps other modes is
that once you've set an aperture, the camera won't change
it, even if light levels fluctuate. Instead, the shutter speed
adjusts to maintain the correct exposure. This wouldn't be
the case if you set shutter-priority — if light levels change,
your camera gives shutter speed priority, automatically
adjusting the aperture to maintain correct exposure, and so
your control over depth-of-field is diminished. Similarly, in
program mode, the camera would change the aperture/
shutter speed combination in response to changing light.

Aperture-priority mode is also handy for general use; ie
when you're wandering, shooting anything that takes
your fancy, such as architecture, details, abstracts or
candids. Depth-of-field requirements will vary depending
on the shot — one minute you need lots, the next as little
as possible — but you can alter it quickly with the flick of
the camera’s input dial, and the viewfinder display will
keep you informed of exactly which aperture (and
corresponding shutter speed) you're using.
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THE EFFECT OF APERTURES: With depth-of-field having such an effect on the finalimage, it’s
no surprise that many experienced photographers rate aperture-priority mode as their favourite
mode. These two shots show how different apertures can produce very different results.

Setting aperture-priority mode

Choosing aperture-priority mode is simple — all you need to
dois turn your exposure dial (or in some cases push the
exposure mode button) and select A. Your Nikon digital SLR
will then be set to aperture-priority mode and all you need to
dois rotate the small adjustment dial (found either on the
handgrip or on the top-right corner of the rear of your camera)
to change your aperture. If you lightly depress the shutter
button to activate the exposure system, you can keep a check
on the shutter speed the camera has selected.

How other V

exposure - M

maodes work [N

We've already established @ Full-automode ®Program mode @ Shutter-priority ® Metered manual ®Subjectmodes
thatin aperture-priority The camera sets the Programworksina You set the shutter You manually set both These program
mode, you set the desired shutter speed and similar way to full auto, speed and your the aperture and modes are tailored to
aperture and the camera aperturetoachievethe | butyoucanusuallyalter | camerasetsthe shutter speed suit a specific subject,
sets the accompanying correct exposure. the aperture/shutter appropriate aperture. independently of with various camera
shutter speed to give the You can't change the speed combination if Iflight levels change, each other, so neither functions like the
correct exposure. Here's combinationto use a youneedtousea the same shutter changes unless you AF, flashand

a quick rundown of how specific aperture or specific aperture or speed is used and the adjust them, even if exposure systems
the other modes work. shutter speed. shutter speed. aperture changed. light levels fall or rise. setaccordingly.



TOPTIP

Aperture increments
Most cameras allow you to
change the apertures in
1/2-stop increments. Check
the custom function menu
in your camera — many
models also allow you to set
it to 1/3-stop increments
if you so wish

Shot at f/22
Aperture-priority mode
allows photographers to
controlhow much of the
scene s sharply in focus.
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Shoot landscape movement

Don'tletablustery day put you off from heading out with your DSLR.
Grabyour tripod and master capturing movement in the landscape

Ross Hoddinott
Camera: Nikon DS80OE
Lens: NIKKOR AF-S 16-35mm f/4GED VR

When photographing landscapes,
motion can prove a powerful
aesthetic tool — giving your shots
added interest, life and depth. By

W intentionally blurring motion, your
images will appear less static and more
atmospheric. Naturally, this technique relies
on there being some degree of movement
within your scene. By employing arelatively
long exposure, any subject motion within the
time the shutter is open will blur, creating
dreamy, ethereal-looking results.

Without doubt, water is the most popular
subject to blur. Look through the pages of
almost any issue of Digital SLR Photography
magazine and you will notice a number of
waterfall and coastal images where a slow
shutter speed has been employed to render
water as a milky blur. Admittedly, the effectis
one you either love or hate. The results can
look amazing, though, and itis a popular
technigue among landscape photographers.

Water isn't the only subject that you can
creatively blur. The landscape is full of
movement and the same technique can be
applied to such things as moving cloud or

Set up On location, lock your camera on a

tripod and compose the shot, filling the
foreground with the gently swaying crop. Select
alow ISO and a smallish aperture to drag out the
shutter speed — | choose ISO 100 and f/16. The
resulting shutter speed of 1/30sec is too fast to
create any visible motion.

wind-blown grasses, flowers, leaves or crops.
Using a slow shutter speed, foliage or crops
swaying in the wind can create intriguing
waving patterns in the foreground of wider
views. Effectively, you are generating your
own foreground interest. This type of implied
motion can transform an otherwise
mundane scene into one bursting with life.

Summer is a particularly good time of year
for capturing this type of image, with trees in
full leaf, meadows brimming with tall grasses
and crops fully grown. You shouldn't have to
venture far to find a suitable scene. In order to
capture good images of motionin the
landscape, a tripod is essential. Ideally, you
also need a Neutral Density filter. These are
designed to absorb light and therefore
lengthen shutter time. They are available in
different strengths. A filter with a three- or
four-stop density is ideal. A polariser is also
useful, as italso absorbs up to two stops of
light. Ten-stop ND filters are popular, but
their effect can prove too extreme, creating
exposures so long that the subject becomes
unrecognisable or important detail is lost.

In addition to your camera, tripod and ND
filter, you also need it to be windy! Look at the
weather forecast and pick a day with a
predicted wind speed of at least 15-20kph
— this will create a nice level of motion.

With polariser

Use a polariser To create a longer shutter

speed, | need filtration. | decide to attach a
polarising filter — doing so absorbs a couple of
stops of light and also boosts colours. Keeping
the ISO and aperture constant, the shutter speed
increases to 1/8sec. Movement is noticeable,
but it doesn't look deliberate enough.

THE NIKON GUIDE TO LANDSCAPE PHOTOGRAPHY

Check the weather

In order to photograph subject
motion, you need wind. Keep an eye
on the forecast and look for a day
where the predicted wind speed is at
least 15-20kph — this will create a
good, constant level of subject
movement. | rely on www.metoffice.
gov.uk and www.metcheck.com.

Awide-angle lens, in the region of 16-28mm,
is ideal, allowing you to fill your foreground
with your subject in order to emphasise its
movement. As your priority is a slow shutter
speed, select your camera’s lowest ISO
speed, together with a small aperture of f/16.
The key ingredient to capturing images of
motion is exposure length. The trick is to
achieve enough motion that the effect looks
creative and intentional — too little or too
much and the shot won't work. Sadly, there is
no magic formula here. The optimum shutter
length will greatly depend on the amount the
subject is moving and the effect desired. A
degree of trial and error is often needed, but
a good starting point is using an exposure of
around 1/2sec. However, depending on the
wind speed an exposure of several seconds
may be required. Timing can also be
important. If the wind is gusty, you will need
to release your shutter to coincide with the
gusts of wind. This type of motion shot s
great fun, no two shots will ever be identical!

With polariser + ND filter Sted

T L%

Use a Neutral Density filter To lengthen

shutter speed further, | attach a three-stop
ND filter. The resulting shutter speed is one
second long. | trigger the shutter again and this
time there is obvious subject blur. The effect
looks deliberate and adds interest and implied
movement to my foreground.
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TOPTIP
Although tempting to
select f/22 or f/32 to help

generate a slow shutter
speed, avoid doing so if
possible — the softening
effect of diffraction will
grow obvious at very
small f/stops.
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Finalimage

Towards sunset, my exposure
lengthens considerably. | continue
to shoot, triggering my shutter to
coincide with the wind.

Exposure: 20 seconds at f/16 (ISO 100)
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The basic skills for shooting
water in landscapes

It'sallabout technique and the right gear when shooting stunning water
scenics: be prepared before you head into the great outdoors

WE'RE NOT SURE if you've ever noticed, but the

majority of stunning landscape images usually
have some form of water in the scene. Whether
it's as subtle as a small river trickling through or
as obvious as a dominating sea in a coastal
seascape, water represents a key elementin
many landscape images.

One of the main reasons for this is because
water is such a photographically pliable
element. By using filters and/or manipulating
the shutter speed, it's possible to record water
in allmanner of ways, from freezing its
movement so droplets are suspended in midair,
to using a long exposure to transform itinto an
ethereal mist. While potentially causing
problems with our exposure, the reflective

Choosing shutter speeds

The shutter speed you use to capture water will

depend on a number of factors: if it's moving;
how quickly it's moving; how much of it there
is; and whether you want to stop it dead to
freeze its movement or let it blur.

For big waterfalls and breaking waves, a
shutter speed of 1/1000-1/200sec will
guarantee you freeze every droplet. For
fast-flowing rivers and smaller waterfalls like
this one pictured here, try 1/200-1/500sec,
while for slower rivers and streams,
1/125-1/250sec should do the trick.

When it comes to blurring, one second will
have a good effect on big waterfalls or try two
seconds for smaller waterfalls. Rivers and
streams need a slower speed of two to four
seconds, though you can go much slower —
tento 20 seconds — if you like.

Overexposure can be a problem when large
volumes of water are concentrated in certain
areas, so keep an eye on the histogram and use
a slower speed if you start to clip the highlights.
For coastal scenes, one to two seconds will
blur waves, while 20 to 30 seconds will
produce a milky effect.

1/20sec

nature of water also plays its part in improving
images, too. On days where there s little or no
wind, by heading to a lake, reservoir or any
other large body of water, it's possible to
produce a striking result by capturing a clean
reflection of the scene on its surface. The
possibilities don't stop there — rivers can be
used as strong lead-in lines through the scene
or, along with the likes of secluded rockpools
and meandering streams littered with rocks,
can form highly effective foreground interest.
The listis endless, but here we cover the
basics of shutter speeds when shooting water,
as well as the gear that should make it easy to

take on our landscape projects, starting on page

91. What are you waiting for? Get exploring!
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® Wide-angle zoom:
An ultra-wide zoom like
a12-24mm or similar is
ideal as it allows you to
fill the foreground with
water and deliver plenty
of depth-of-field for
scenes that are sharp
throughout. The Sigma 10-20mm lens,
costing around £400, is hugely popular due
to its excellent performance and value-for-
money price tag.

@ Spirit level: If your
tripod kit has a spirit
level, use it to ensure
horizons are even — you
dontwant to spend
ages in Photoshop
levelling them if you can
avoid it at the picture-
taking stage. Otherwise, buy a basic £10
spirit level to slip into a hotshoe or treat
yourself to a funky £30 Seculine Action
Level (www.intro2020.co.uk).

@Filters: If you're

serious about landscape
photography, it'll pay to
investin a slot-in filter
system. Cokin’s P-system
(www.intro2020.co.uk)
represents great value for
money, while if quality is
paramount, look to Lee Filters' superb 100mm
system — the choice of the professionals
(www.leefilters.com). A polariser helps

boost blue skies and deliver clear reflections
off the water's surface. A 0.6 or 0.9ND filter
(not ND grad!) is also worth considering, as

it will allow you to use long shutter speeds in
daylight to blur moving water.

®Tripod: When

shooting water, you'll

be looking to use

small apertures

to maximise depth-of-
field and the slow shutter
speeds require you to
keep the camera stable
to avoid shake. Check out the essential kit
section later in this guide for advice on the
best tripods to buy for outdoor photography,
whatever your budget.

@ Photo backpack:
When you're walking for
miles and milesonend, a
decent photo-dedicated
backpack s a far better
(and comfier)option

for protecting your
prescious photo kit than
ado-it-all gadget bag. Those with an
all-weather cover will offer superior
protection from water and the other
elements. Turn to page 160 for our top
bag recommendations.

@ Clothing: There's
nothing worse than
slipping into a river and
having to spend the day
in wet clothes. Wear
decent footwear from
reputable brands such as
Berghaus and consider
waterproof trousers or gaiters
from brands such as Paramo, as they allow
you to step into rivers and stay dry.
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Shoot water like a pro

Dramatic coastlines are the perfect
place to put theory into practice when
it comes to photographing scenes
with water. Follow our advice on the
gear to use, the techniques to try and
the settings to make and you'll soon
be taking landscape images like a pro.
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The wotld's first* lens offering an aperture of F1.8
throughout the zoom range. Introducing a new
large-aperture APS-C format standard zoom lens.
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Q Art
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Learn how to capture sharp images likea pro

Master the fundamentals of focusing, depth-of-field and camera shake to vastly improve your photography

IMAGINE YOU'VE FOCUSED on an object that is five metres away. How
sharp will something be at six metres? Or even five-and-a-half metres?
The answer is governed by the depth-of-field: the distance either side of
the point of focus that is deemed to be acceptably in focus. As long as
you control the aperture you are shooting at, you're in control of
depth-of-field, and you can use it creatively. There will be occasions
when you don'twant much of it at all, and you'll get that effect by
shooting with a large aperture like f/4. However, for most of the time that
you're shooting landscapes you'll want to maximise depth-of-field to
getas much of a scene in focus as you possibly can.

Foreground detail isimportant and has to be in focus, but so does the
rest of the scene. This means using small apertures to get good
sharpness either side of the focus point. But just consider this last phrase
foramoment, and then think about where you might focus when
shooting alandscape. Many novice landscape photographers are happy
focusing at infinity when shooting a landscape, but don't forget that
depth-of-field extends either side of the point of focus. In fact, the area

| of depth-of-field extends one-third in front of the focused point and

two-thirds behind: in other words, you get more depth-of-field behind
the subject than in front of it. Obviously there is no benefit to having
acceptable sharpness extending beyond infinity, but you can pull the
point of focus back towards you, soit's the end of the depth-of-field
zone thatis atinfinity instead. This way you'll get more of the scene sharp.
This is called hyperfocal focusing and has been used by pro landscape
photographers for decades. The optimum point of focus for any scene
relies on the choice of aperture setting and the focal length of the lens
you use — and changes for full-frame and APS-C-sensor DSLRs! There
are calculators and pocket reference tables you can stash in your camera
bag, or you can use a dependable rule of thumb that suggests you aim a
third of the way into the picture with your lens set to a small aperture.
We'll be covering both focusing techniques, as well as providing you with
advice to ensure you maximise image sharpness. This includes revealing
why using the smallest aperture won't necessarily produce the sharpest
results, even though it gives the most depth-of-field!

NOLYNG Wvav
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How to maximise your depth-of-field

Hyperfocal point

The hyperfocal distance is the point where you can maximise depth-of-field for any given
aperture — everything from half this distance to infinity will be recorded acceptably sharp.
Calculating and focusing on this point is important if you require extensive depth-of-field.
Although the hyperfocal distance can seem daunting, it is not actually as complex as it first
seems. If you use a prime lens with good distance and depth-of-field scales, simply align the
infinity mark against the selected aperture. However, few modern lenses — particularly zooms
— are designed with adequate scales, meaning photographers have to calculate it themselves.
Thankfully, there are depth-of-field calculators and hyperfocal charts available to download

Including foreground interest
can make itdifficultto achieve
front-to-back sharpness, but
this guide willgetyou there...

@ Flick through the pages of any
photo or country magazine, and
you will quickly notice that
foreground interest is an important
component in the majority of great
landscape images. It provides an entry point
into the composition and helps add context,
depth and interest to views. As long as it
complements the overall scene, practically
anything can work as foreground interest —
rocks, a stone wall, winding footpath, colourful
reflections or reeds. Flowers are another good
subject to include in the foreground of your
shots. Not only do they help to add scale to
wider views, but they also add a welcome
splash of colour. There is no better time of year
than spring to look for flowers to include in
your shots, particularly along the coast where
pink thrift grows. Thrift can carpet clifftops,
providing colour and interest to views of sandy
bays and rugged coastline.

Including foreground interest typically
requires a large depth-of-field to render
everything from front to back acceptably
sharp. Opt for a small f/stop in the region of
f/16, but avoid stopping down even further as
the effects of diffraction (softening of the
image) will grow more apparent. You also need
to select your point of focus carefully.
Depth-of-field falls roughly two-thirds beyond
the point of focus and one-third in front of it.
Therefore, if you focus too far into the frame,
you waste the depth-of-field available to you.
Arough-and-ready method to maximise
front-to-back sharpness s to simply focus a
third of the way into the frame (see p34 for
details). However, a more precise method is to
focus on the hyperfocal distance (see panel). It
seems like a complicated calculation, butit's
much easier than you may think.

To help give yourimages a three-
dimensional appearance, opt for an ultra
wide-angle lens — in the region of 17-24mm
— and get near to your foreground. This
exaggerates the size of foreground subjects
and stretches perspective, resulting in
eye-catching shots.

online. Visit www.dofmaster.com —

it also offers an app for your smartphone.

Below are two hyperfocal distance charts covering the most popular focal lengths and
various apertures for full-frame and APS-C sensors. Photocopy or cut out the chart relevant
to your camera type and keep it handy for when you come to compose and focus your shots.

@ APS-Cssize sensors

3.2ft 6.4ft
f/ 1 2.3ft 3.5t 4.5ft
f/16 1.7ft 2.5ft 3.3t
f/22 1.2ft 0.9ft 2.3ft

@ Full-frame sensors

8.9ft
6.2ft
4.4ft
3.2ft

12.6ft 17ft 27ft

oft 12ft 19ft 39ft
6.4ft 8.6ft 14.5ft 27ft
4.5ft 6ft 9.5ft 19.2ft

3.8ft 5.6ft
f/ 11 2.6ft 3.9ft 5.8ft
f/16 19ft 2.9ft 4ft
/22 14ft 2ft 2.9ft

Find your view Images lacking foreground

interest can look flat and boring. Despite
finding this impressive vista, by notincluding
anything of aesthetic value in the foreground to
complement the view and direct the eye into the
photo, this shot is nothing more than a snap.

11ft 17ft 35ft
7.8ft 12ft 25ft
5.5ft 8.5ft 17.5ft
3.9ft 6ft 12.5ft

Alter your viewpoint By simply moving a few
metres, my nextimage is much better. By
including some flowering thrift in the foreground,
the image immediately has more depth and
interest. However, the sky is overexposed, so

filtration or exposure blending is needed.

Set your exposure | take a meter reading from

the sky and another from the foreground thrift.
The difference in light is around four stops.
| don't want to even out the light completely as
our eyes naturally perceive the sky to be brighter
than the land. Therefore, | attach a two-stop (0.6)
graduated Neutral Density filter to help me record
detail throughout the scene.

Perfect your composition With the correct

exposure achieved, itis time to focus on
composition. To place more emphasis on
foreground, and to create depth, a low, close

viewpoint is often best, together with a short focal

length. | do this, opting for the wide end of my
17-35mm zoom. The nearest flowers aren'tin
sharp focus, though, due to inaccurate focusing.

Calculate the hyperfocal distance

To ensure everything from nearby foreground
to the distant view is acceptably sharp, focus on
the hyperfocal distance. The chart tells me that,
with a focal length of 17mm and aperture of f/16,
the hyperfocal distance is just over 2ft. | manually
focus the lens to this distance and reshoot. This
time, | achieve front-to-back sharpness.
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Using small
apertures

How to use small apertures for
the sharpest landscapes

Lee Frost
- ‘ We've already explained that small
4 apertures give increased depth-of-

g field so you can record more of the
by scenein focus. Ideally, when
shooting landscapes you want to
record everything in focus, from the
immediate foreground to the distant
background. Stopping your wide-angle or
zoom lens down to its minimum aperture —
usually f/22 — and focusing on infinity is a rule
of thumb that many use to achieve this. More
often than not it works because wide-angle
lenses give so much depth-of-field at small
apertures. However, it's not best practice to
always use the minimum aperture, as it doesn't
always give you the sharpest results. The
purpose here is to show how you can get the
best from your apertures when shooting
landscapes, without necessarily always
resorting to the lens’s minimum aperture.

Focus on infinity The other optioniis to

focus the lens on infinity, which is a
technique that most photographers use when
shooting landscapes with a wide-angle lens. If
you do this and stop down to f/22 as in the
example above, the whole scene is in focus
because of the combination of an ultra-wide
focal length, minimum aperture and the
increased focusing distance.

Wide aperture This scene was shot using a

full-frame DSLR and ultra-wide-angle zoom
setat 17mm. The lens was focused manually on
the boulders nearest to the camera and the
aperture was set to f/4 — the widest aperture.
As you can see, the boulders in the foreground
are sharply focused, but by the time we reach
the middle distance, depth-of-field has run out
and the castle in the distance is out of focus.

Open up the aperture But do you really

need to stop down to f/22 when focused on
infinity? We shot this scene with the lens at
infinity and opened up the aperture a stop ata
time to see how wide open we could go with the
aperture before the foreground started to slip out
of focus. Actually, we couldn't open any wider
than f/22 in this case either, so focusing close to
the camera or far away is clearly not ideal.

Focus on foreground Stopping the lens

down to a smaller aperture willincrease
depth-of-field so that it extends further and
further into the scene. However, with the lens
still focused on the foreground, we need to stop
right down to the minimum aperture — f/22 —
before the castle in the distance is recorded in
focus. This is because depth-of-field is reduced
when the focusing distance is small, as it is here.

Focus a third in Depth-of-field extends

bothin front of and beyond the point you
actually focus on. That's why focusing on the
foreground or at infinity doesn't work so well;
you're wasting depth-of-field. So what about
using the old trick of focusing a third into the
scene? We tried that at f/22 and, as expected,
everything is sharply focused because
depth-of-field is being utilised more effectively.
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LANDSCAPE
LIGHTING

Daylightis the most accessible and versatile light source available to

photographers. We exploreitsmanyforms, look atthefactorsthatchange

itand tellyou how to make the most of it for successful landscapes

LIGHT IS THE single essential ingredient that
allows us to create a photographic image.
But light can take on many forms — it can be
hard or soft, strong or weak, warm or cold

— and each variation has a profound effect,
not only on the mood and character of the
landscape, but the success of every
photograph we take. Time of day and
weather conditions are the two main factors
that affect the quality of daylight. Throw in
seasonal variations and you have seemingly
endless permutations that change from one
minute to the next. This can be both a
blessing and a curse. When things are going
to plan, daylight is the most amazing light
source there is. But when you crawl out of
bed in the middle of the night, drive three
hours in darkness to reach a location for
sunrise, only to be greeted by thick cloud
and drizzle when you finally get there, it can
also be the most frustrating.

@ Be prepared

Planning your shoot puts the odds of
success in your favour and is easier than ever
these days, thanks to the internet. You can
check the weather forecast for the next few
days, establish sunrise and sunset times for
any day or location in the world, or check
tide times if you're heading to the coast. The
more information you gather beforehand,
the more likely you are to be in the right
place at the right time to take advantage of
fantastic light. And if things don't go
according to plan, you may end up taking
photos that are better than you had hoped
for — that's because unexpected changes in
the weather often produce spectacular
conditions that can't be planned for; and by
being on location, you can take advantage of
them. It's not down to luck that top
landscape photographers produce amazing
images on a regular basis — it'sdown to
being outin the field, chasing the light.

The ability and willingness to adapt to
unforeseen conditions will also help you to
make the most of light because different
forms of natural light suit different subjects.
The flat light of an overcast day may not suit
grand wide-angle views, for example, but it's
ideal for shooting details in the landscape.
Another option is to shoot with the intention
of converting images to black & white: in
which case, the quality of lightisn't so
important. You can also use photographic
techniques. No matter how drab the
weather is, if you're on the coast you can
produce amazing images using a ten-stop
ND filter to record motion in the sea and
contrast it with static elements, such as
rocks, groynes and jetties.

Essential filters

®ND grad: The Neutral Density (ND)
grad lets you balance the sky with the
foreground so the whole scene is
perfectly exposed. Without a grad, you'll
end up with a well-exposed sky and
underexposed foreground, or well-
exposed foreground and blown-out sky.
This is especially true at dawn or dusk,
when the contrast between sky and land
is atits highest. You'llneed a 0.9 density
(three-stop) ND grad, while a 0.6
(two-stop) is fine for the day.

@ Polariser: The second filter is the
polariser; in sunny conditions it can
make a massive difference to your
landscapes, deepening blue sky, cutting
through glare, eliminating reflections
and boosting both colours and contrast.
It's also brilliant for autumnal foliage
colour, even on dull days.

@ Therightdirection

The direction from which light strikes your
subject can make a big difference to the
mood and impact of your images. Frontal
light, where the sun is to your back, makes
the world look lovely but, photographically,
it's not very effective because shadows fall
away from the camera, making the
landscape look rather flat. Just after sunrise,
or just before sunset, when the sunis low in

the sky and bathes the landscape in golden
light, that lack of depth can be forgiven
because the light is fantastic, though you
may find that you struggle to keep your own
shadow out of the composition!
Side-lighting, with the sun at roughly 90°
to the camera, works better because you
can incorporate shadows, making them an
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The time of day

From the moment firstlight appears to the time when darkness takes
over, the quality of light undergoes a myriad of amazing changes and
makes a huge difference to your photographs

@ PREDAWN First light usually appears
30-40 minutes before sunrise. Ideally, arrive
an hour before sun-up to find a viewpoint,
set up your gear and start shooting as soon
as colour appears. Any light on the landscape
is reflected from the sky, soit's softand
shadowless, and tends to have a strong,
cool cast. This contrasts well with the warm
glow over the eastern horizon.

Water, wet sand and wet rocks pick up the
colour in the sky, so predawn is great to
shoot coastal or lake views. Ideally, there will
be some broken cloud adding colour to the
sky, but clear mornings can also be highly
productive. Light levels are low, so expect
long exposures. The contrast between the
sky and land is high due to the lack of direct
light, so use a 0.9ND graduate to retain detail
and colour in the sky.

8 <5 =SSN e
@ EARLY MORNING Once the sunis up, you

have minutes to capture the light at its peak
quality before it loses warmth. During the

summer, daylight is neutralin colour two hours

after sunrise and its colour temperature
remains constant for about 12 hours. During
spring and autumn, any warmth in the light will
have gone by 8am and the colour temperature
remains steady until 4pm. In winter, however,
the colour temperature hardly ever reaches
5500K, even at midday, because the angle
between the sun and earth is shallow all day.

The first two hours after sunrise are the best
for landscape photography as the intensity of
the light is reasonably low, and long shadows
add depth and modelling. A polariser is also
effective when the sunis low in the sky and at
90° to the camera.

@ SUNRISE By the time the sun peeps over
the horizon, any colour in the sky may have
gone. On clear mornings, the sun will be
dazzling once it rises, but you'll be able to
shoot into it for a few minutes as the sea and
wet sand reflects the light to keep contrast
manageable. Features such as piers, castles
and lighthouses can also be capturedin
silhouette. Inland, contrast will be too high
once the sunrises into a clear sky. At this
point, turn and capture the golden light on
the landscape. Ideally, let the sun side-light
the scene so you caninclude long, raking
shadows to add depth and reveal texture.

The lightis warm at sunrise because the
rays pass through the atmosphere at a
shallow angle and the light is scattered, with
many of the wavelengths at the blue end of
the spectrum filtered out.

@ THE MIDDLE HOURS Once the sun has
been up for two hours, the quality of the light
in clear, sunny weather begins to tail off. The
higher the sun climbs, the more harsh and
intense the light and the shorter and denser
the shadows. By 9am in summer, the sun is at
its 'zenith' - its highest point — and stays
there until at least 4pm. The landscape looks
flat, contrastis high and the lightisn't
attractive. The urban landscape is better
suited to strong light: shoot modern
architecture, using a polariser to deepen the
sky, and look for abstracts and colourful
details. In the countryside, capture trees
against the sky from a low angle and look for
reflections in water. Infrared photography
works in harsh light, especially in spring and
summer when there’s lush foliage around.

@ LATE AFTERNOON Once the sun begins
its slow descent and the light begins to
warm up, its intensity is reduced, and
shadows become longer and weaker. Shape
and character return to the landscape, and
the longer you wait, the better it gets. In the
morning, the light falls on a cold earth, butin
the afternoon, the earth is warm so shadows
appear neutral, not cool. The atmosphere is
also denser in the afternoon, so light can
appear redder than it did at the start of the
day. The hour before sunset is often referred
to as 'the golden hour' due to the richness of
the light. Long shadows reveal texture and
modelling to give your pictures depth, and
because the sun s sinking and notrising, it's
easier to predict how the light is going so
you can choose a suitable location.



® SUNSET When a sunset seems likely, get to
your location 45 minutes before so you can
choose the best viewpoint, get set up and take
a variety of pictures as the sun dips. Capture
the landscape bathed in golden light. If the
scenery is relatively flat, the light will perform
its magic literally until the moment the sun
sets, whereas in hilly regions, you may lose the
sun half an hour before. Shooting into the sun
will record anything between the sun and the
camerain silhouette: a good technique when
shooting water because the sun's glow and
colour in the sky will be reflected, creating a
backdrop to silhouettes of boats, islands, piers
and soon. [f flare is a problem, hide the sun
behind something in the scene or wait for it to
set. If you want to record detail in the
foreground, use a 0.9ND grad.

@ TWILIGHT Once the sun finally

disappears below the horizon, light levels
quickly fade and the light on the landscape is
again reflected from the sky. If you're lucky,
there will be a vivid afterglow in the sky
created by the sun as it under-lights the
clouds above the horizon, but even this will
fade quickly. You'll find that colours are
muted, the light s soft, shadows fade and light
levels fallaway. Head to the water's edge
where the pastel colours left in the sky look
stunning reflected in lakes and rivers. Or use
those colours as a background to silhouettes.
Long exposures record movement: the
swaying of trees in the breeze; the movement
of clouds across the sky; the motion of the sea
or water flowing in rivers and streams. Keep
shooting until those colours fade.

Everything's rosy

The colours and textures in
the sky can be spectacular,
especially if you pick the
moment as the sun rises above
or falls below the horizon.

® MOONLIGHT The moon can be a lovely
natural source of light. Winter scenes work
well because snow and frost reflect the
moonlight. Coastal views also work if you
capture the shimmering silver ribbon of light
from the moon on the sea. By increasing
exposure, you can create surreal shots that
look like they've been taken in daylight. They'll
look normal, but the light will have a strange
quality. You can even try recording star trails
in the sky created by the rotation of the earth
while the camera’s shutter is open. Obviously,
exposures will be longin low light, souse a
tripod, and keep the ISO low — 400 or less —
for high image quality. Whatever you shoot,
unless the moon is obscured by cloud, you
should keep it out of frame to avoid it
recording as an overexposed white smudge!
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Getup early for ‘'magic hour' lighting

Dawn is the best time of day for taking beautiful, atmospheric shots, says landscape expert Helen Dixon

WAKING A COUPLE of hours before sunrise, which
is often in the middle of the night, is not most
people’sidea of fun. But if you're prepared to make
the effort, you will reap the rewards. Planning is
essential. Check the weather forecast and the
sunrise times on the internet. And check the tide
times if you are travelling to the sea — a low tide is
usually the best time to visit. If the light fails to
materialise, you can always do beach close-ups.

I try to be on location at least half an hour before
the sunrises — if not earlier — because it's often
before the sun appears that the real magic
happens. This also gives me time to set up the
camera and to find the best viewpoint. Don't just
look for clear days, it's better to have cloud around
as this creates wonderful colours in the sky as the
cloud reflects the light of the sun. Try to pre-visit
and research your location before the day of the
shoot. | use Ordnance Survey maps for detailed
information on rights of way and parking. Look for
appealing places where there will be opportunities
for shots that include foreground interest.

Mist mainly develops during a cold night and it
only lingers for a short time during the morning or
until the heat of the sun burns it away. Something
to bear in mind is that, during misty conditions,
your camera’s metering system will often
underexpose the scene, resulting in a dull, lifeless
landscape. To compensate, alter the exposure by
+1/2 or +1 stop. Check the histogram on the
camera’s LCD monitor for overexposure.

The use of Neutral Density graduate filters is
pretty much standard in landscape photography.
They help to control the brightest part of the

Exposure: 0.5 seconds at f/22 (ISO 100)

| image, which is usually the sky. Early in the day,

there is a noticeable difference between the lightin
the sky and the light on the land.

Be aware of lens flare if the sun is included in the
frame. To help eliminate this, make sure that your
filters and lens optics are spotlessly clean. | rarely
use a warm-up filter as these filters normally make
any green foliage appear a yellow-brown colour.
Instead | set my camera’s White Balance to Cloudy
or Shade to help warm up the scene. Try to avoid
using the Auto White Balance (AWB) setting as you
are sure to cool down the light, unless, of course,
this is the effect you want. There are a number of
reasons why | personally prefer dawn light over
sunset. | like to capture atmosphere in my shots if
| can, and early morning is the best time to do this as
you are more likely to have a misty or frosty start to
the day. The light is often diffused and softer at this
time, but it's also more of a challenge to include the
sunin the picture, too, during the morning thanin
the evening, because at sunset the pollution levels
have risen throughout the day, which helps
to diffuse the brightness slightly. Another great
advantage of early morning is that it's so peaceful;

I rarely see another soul. The world belongs to me
— it's so satisfying to watch the day unfold and
witness the magical light of dawn.

Once the sun has risen and become too strong
to photograph, turn to the side or put your back to
the sun, being careful not to cast a shadow in the
foreground. Now start using the warm light that's
illuminating the land. Light is never static but
continually changes — it's the main ingredient that

| allows us to create something beautiful.

Kitwatch!

®Helen's magic-hour kit
When considering what
equipment you will need,
anecessity is a sturdy
tripod, as at this time of
the day you're working
with long exposures. |
use a Manfrotto MF4
carbon-fibre with
322RC2 head -
it's a lightweight but
stable supportand
| can hang my bag
from the centre post
for extra stability on
really windy days.

| always use aremote
release but if you don't
have one, use the
self-timer to stop any
vibrations and use
mirror lock-up if your
DSLR has this facility.

| find my ultra
wide-angle zoom and
my 70-200mm telezoom
particularly useful. These
cover most of my requirements.
| use the wide-angle zoom when
shooting foreground elements. And
the telephoto zoom is especially good
for compressing perspective and
creating layers on misty mornings.

TOPTIP

Mirror lock-up
Many digital SLRs have a
facility that allows the
mirror to be raised prior to
the exposure, to minimise
shake when the shutter is
fired. You'll most likely find
this is activated via a
Custom Function
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Stay out late and shoot stunning sunsets

The other ‘magic hour'is at sunset — be prepared and you'll be rewarded, reveals Mark Bauer

ALTHOUGH IT'S possible to take landscape
photographs at most times of the day, there are two
times when most landscapers agree the light will
give the best results — the firstand last hours of the
day. What makes these times of day special is that
the low sun casts long shadows and helps to pick
out the features of the landscape. If you're out
predawn or post-sunset, you can also see
spectacular skies as the clouds are lit from below.

The lightis quite similar at these times of day, and
your preference often depends on which direction
of light suits your subject. For example, the south
coast in winter looks best at the end of the day
rather than at the start. Having said that, the lightin
the final hour of the day tends to be warmer and, as
the sun sets, the landscape is often bathed in a
golden glow. Also, let's not forget, the nice thing
about sunset compared to sunrise is that you don't
have to force yourself out of bed at a ridiculous
hour to make the most of it. Let's be honest, not
everyone has the willpower and enthusiasm for
sunrises as Helen Dixon (see opposite)!

Almost any type of landscape looks good in the
magic hour, but some features really benefit, like
stone buildings or rocky cliffs. When the low sun
warms everything up and picks out the texture of
rock and stone, scenes that might look dull atany
other time of day can be lifted out of the ordinary.

Water is also an excellent subject at this time,
because if you have an interesting sky, you can
double the impact by using reflections. Moving
water can sparkle like diamonds or be made to blur
during long exposures. Again, the amount and type
of light falling on it determines the result.

IR :_-

Get your rocks off
The low sun picks out the details of the
rocky ledge and gives the cliffsa warm
glow. A 0.6ND grad, angled so as not to cut
into the cliff, helps retain details in the sky.

Exposure: 1/5sec at f/16 (ISO 100)

The direction of the light can have a strong
influence on the mood and success of pictures
taken at the beginning or end of the day. Front
lighting, for instance, can look flat as the direction of
the shadows doesn't help to pick out the details of
the landscape. With the sun to one side, however,
shadows help to create depth in the picture and
reveal form and texture. Side-lighting is best if you
want to use a polariser to saturate colours, too, as it
will have its strongest effect if the camera is 902 to
the sun. Backlighting can be very dramatic as well,
but exposure is difficult to control and you will have
to be careful to avoid lens flare as light falls directly
onto your filters or the front element of your lens.

With all this to consider and the weather is
notoriously unpredictable, how can you tell if the
magic hour will live up to your expectations?
Looking at weather forecasts is a good idea —
www.metoffice.gov.ukis reliable and you can geta
detailed forecast for specific regions. Remember
that the longer the range of the forecast, the less
reliable it will be. Checking the forecast the night
before a dawn shoot gives you the best guide.

If you drive to your location, listen to local radio
stations in the car, rather than national ones, and
keep an eye on what's happening in the sky. For
sunsets you'llneed to look to the west, as this is
where the sun will be at magic hour. Most of our
weather fronts come from the west, too, so by
keeping an eye in that direction, it's possible to see if
cloudis likely to break up or thicken. Being aware of
wind direction, the points of the compass and
weather patterns will help enormously and you'll
start to recognise the signs of a magic moment.

® Mark’s magic-hour kit

Wide-angle lenses are the most
popular for landscape work, but longer
lenses can also be useful for picking
out the kind of patterns and textures
that the magic hour reveals.

A polarising filter will help you make
the most of side-lighting by improving
overall saturation, but is especially
effective when used with blue skies.

A sturdy tripod is another essential.

If you're shooting in the period

after sunset, light levels will be low

and handholding will be out of the
question. But it's good practice to use a
tripod whatever the lighting conditions
— itwill slow you down, it makes you
think and it enables you to make small
but often vital changes to composition.

Neutral Density graduate filters are
also important, especially if clouds
are lit from below and there is no
direct light on the land. ND grads help
control contrast.

il
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TOPTIP
White Balance
The White Balance you set
has a major effect on the
final result. Avoid using the
AWB setting. If you shoot in
Raw, you can try out all the
settings later on your
computer and choose
your favourite
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Watch the weather

Changesin weather have an even greater influence on the quality
of lightthan the time of day, so if you want to take stunning shots
every time, you need to be prepared to take on the elements

“THERE'S NO SUCH thing as bad weather,
only inappropriate clothing,” so said
comedian Billy Connolly, and he was right. If
the sunisn't shining and the sky isn't blue,
we tend to refer to the weather as ‘bad’, but
photographically, ‘bad’ can be good
because it gives us variations in the quality of
light to work with, adds drama and creates
atmosphere. So-called ‘good’ weather is
actually not so good for photography
because the lightis bland and the landscape
looks picture-postcard perfect, which gets
boring after a while.

Clouds have a dramatic effect on the
quality of daylight because they soften and
spread it so intensity is reduced, contrast
falls and shadows become weaker. Clouds
also add interest to the sky, and the sky can
make or break a great landscape.

Days when the sky is a blanket of
monotonous grey cloud are probably the
least exciting for landscape photography as
colours appear dulland muted, and a lack of
shadows means scenery tends to look flat
and uninviting. However, overcast light is
ideal for capturing details in the landscape:
the patterns and textures in rocks; the
smooth shapes and soft colours in sea-
worn boulders and pebbles; the rich colours
of autumnal foliage or banks of spring
flowers. Strong colours look intense in
diffuse light because there's no glare to
dilute saturation. Dull days are also ideal for
slow shutter speed shots of waterfalls — just
keep the boring sky out of the shot and
you'll get some great results.

White clouds in their many shapes and
forms are highly photogenic against blue
sky, and you can make them stand out even
more by using a polariser to deepen the
blue. Keep the sun to your side for the
strongest effect. Watch out for cloud
patterns on the landscape, too — they can
add an extra element that makes a good
scene great, and are easiest to spot if you're
shooting from an elevated viewpoint.

Stormy weather creates the most

dramatic conditions for landscape
photography — angry, dark clouds rushing
across the sky, strong winds blowing and
momentary breaks that allow rays of
sunlight to flood through and illuminate the
scene below. You can't plan for such
conditions, but if you venture outdoorsin
stormy weather, there's always the chance
that you'll be in the right place to capture
them. And it will be a blessing if you do.

If the sun does break through during a
storm, the landscape ends up brighter than
the sky, which is a reversal of the norm.
What this means in practice is that you can
getaway without using an ND grad as the
sky won't overexpose. However, it's still
worth using a 0.6ND grad to make the sky
look even more dramatic than it really is.

Something else to watch out for in stormy
weather is a rainbow arching across the sky.
Rainbows are created when the sun shines
through falling rain, so if that happens while
you're out, turn your back to the sun and
check the sky ahead. To reveal the colours
of the bow at their best, try to catch it
against dark clouds and use a telezoom to
home in on part of the bow. Alternatively,
use a wide-angle zoom and include the
whole bow.

Mist and fog reduce the landscape to soft
shapes and hazy outlines. Three dimensions
become two and aerial perspective means
that tones become brighter with distance.
The light is diffuse, shadows don't exist and
fine detailis lost. Scenes are simplified and
your images should reflect that.

Telephoto lenses emphasise the effects of
mist and fog by magnifying the scene and
compressing perspective, so they're great for
shooting the overlapping forms of hills and
mountains, or picking out elements like a
single tree or church spire fading into the
gloom. If you want to relegate mist or fog to
the distance, then use a wide-angle lens —
visibility close to the camera will be much
better than farther away, so you can capture
plenty of foreground detail and let the rest of
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Check the web

If you're planning a landscape shoot,
whether it's to head out early in the
morning for sunrise or to go off into the
wilds for a week, use the internet to
gather information that will help you
make the most of the light. Here are
some websites worth bookmarking for
future reference:

® Weather forecast
www.metoffice.gov.uk
www.bbc.co.uk/weather
www.xcweather.co.uk
www.metcheck.com

®Sunrise & sunset times
www.timeanddate.com/astronomy/
®Tidetimes

www . tidetimes.org.uk/
http://easytide.ukho.gov.uk

@ Planning your shoot

A more sophisticated toolis the
Photographer's Ephemeris (www.
photoephemeris.com). This is available as
a free download for Mac and PC (plusasa
paid-for app for the iPhone) and allows
you to determine sunrise and sunset
times for anywhere in the world, any day
of theyear, as well as the angle of the
sunrise/sunset so you can check if the
sun’s orb will be blocked by hills, say.
Moonrise and set times are also provided.

Below left: Far from ruining the image, clouds
can add all-important interest to coastal views.
Below right: Simple scenes suit a misty outlook
and are given an ethereal twist.

Right: Rays of light shining through storm clouds
can have a really dramatic effect.

the scene fade away. Dense fog is heavy and
damp. It snuffs out colour and turns the world
to grey, so you may decide to convert your
foggy landscapes to black & white. Mist is
more delicate, so instead of destroying colour,
it tends to merge all colours together to
create very soft hues. Mist is also fine enough
to let the light through, so shoot contre-jour
at sunrise, when you're more likely to find mist
in woodland or over water, and capture
golden rays of light bleeding through. Such
conditions aren't all that common, but the
quality of light when you get mist and sunrise
coinciding is hard to beat.

LIONIJAQOH SSOY
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Stormy skies
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Expose correctly

@ Colour temperature and White Balance

The colour of light is referred to as colour temperature, which is measured
in Kelvin (K). The warmer the light is, the lower its colour temperature, and
the cooler the light is, the higher its temperature.

Our eyes adapt to changes in the colour temperature automatically, so
natural light always looks more or less white — this is known as chromatic
adaptation. The photographic equivalent is your camera’s Auto White
Balance (AWB) setting. If you use AWB, you will find that it produces pleasing
results in most daylight situations, but the White Balance does fluctuate so
you may not record the colour of the light as it really is. If you want to do
that, you should set White Balance to the Daylight preset, which is 5500K.
This is the colour temperature of ‘'mean noon daylight’, so in normal
daylight situations, your images will come out looking neutral. However, at -
sunrise and sunset the light is much warmer (lower colour temperature), so .
by using the Daylight White Balance preset, your camera will record that
warmth. Similarly, if the light is cool, as is often the case during predawn or
in bad weather, using the Daylight preset will record that coolness.

Remember, also, that if you shoot in Raw, you can adjust the colour
temperature of the image later. So if you don't like the cool cast, you
simply get rid of it, or if a warm image isn't warm enough, you can adjust
the colour temperature to make it warmer.

Conditions Colour temp (K) Colour cast
(Daylight WB)

Open shade under blue sky 10000K Very blue
Shade under part cloudy sky 7500K Blue
Overcast weather 6000K Slightly cool
Average noon daylight 5500K None
Morning/evening sunlight 3500K Warm

Sunrise/sunset 2000K Very warm
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Seasonal landseape light

Although seasonal changes have more of a physical effect on the landscape, the quality of daylight also
varies throughout the year. Here's our guide on how to handle landscapes in different seasons...

@®WINTER

The landscape lies dormant and bare during
winter. Trees stand skeletal against the sky,
while fields are brown and barren. Days are
also painfully short, with the sun rising well
after 8am and setting before 4pmin January.

Photographically, however, winteris a
fantastic season. There are few sights more
magnificent than a landscape covered in
freshly fallen snow and bathed in crisp
morning sunlight. But even if you're not
lucky enough to get that, ice and frost are a
certainty at some point as temperatures
drop well below freezing.

The short days are a benefit, too, because
you can shoot sunrise and sunset at civilised
times. Plus the sun never climbs more
than about 20° above the horizon, so the
quality of light remains high from dawn to
dusk, with long, weak shadows adding depth
— onaclear winter's day you can get eight
hours of good light.

Keep a close watch on the weather
forecast and if a clear night is predicted,
prepare for an early start the next day
because that usually means ice and frost
come the morning — and, if you're lucky,
freezing mist for the sun to slowly burn away.
Incredible pictures are guaranteed.
Woodland and water locations are your best
bet. As well as shooting wide-angle views,
look for winter details: cobwebs covered in

icy beads; the patterns inice over ponds and
puddles; frosty leaves on the ground; and so
on. Dawn on a freezing morning can be
magical, with the sky full of pastel colours
and the sunrising like a giant orange ball. Its
intensity is often reduced by mist or haze, so
you can include it in your shots without any
risk of flare. Use a long lens to make it nice
and big in your shots.

Snow is best photographed when it has
just fallen soit's pristine and fresh, and ideally
in sunny weather — a glistening snowy
landscape under a blue sky is hard to beat.
And you needn’t head to magnificent
countryside to take great snow shots — a visit
toyour local park can be just as productive if
you concentrate on simple scenes, like a
single tree standing in the middle of a
snow-filled field.

NOXIANITIH

Winter Q&A

Q What should | consider when
shooting snow scenes?

A Exposure! All that whiteness in the
sceneis likely to fool your camera’s
metering system into underexposure, so
take a shot then check the preview image
and the histogram. You will almost
certainly need to dial in extra exposure
using the exposure compensation facility
— dothatin 1/3-stop increments until the
highlight warnings on your preview image
start to flash to indicate the image is
overexposed. Delete that shot — the

one before it should be perfect.

Qs it okay to use a polarising filter
during winter?

A Definitely, but carefully. Blue sky is
bluer in winter and because more of itis
polarised, the effect of a polarising filter is
more obvious than at any other time of
the year. In extreme cases, the sky can go
almost black if you fully polarise, so you
may need to wind back the effect a little.

Q Willmy camera work okay in
freezing winter weather?

A Yes, but batteries drain faster so make
sure yours is fully charged and ideally
carry a spare. Also, avoid breathing on
your lens or any filters you're using as
they will mist up and take ages to clear.

1SO¥4 331
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@®SPRING
This season marks the dawn of new life as
the landscape awakens from the dormant
months of winter. Barren trees burst with
buds and blossom, woodland floors,
hedgerows and riverbanks are carpeted with
colourful wild flowers, while desolate fields
turn into beautiful patchwork quilts of green.

Scenes that looked grey and drab during
winter are transformed within a few short
weeks — especially if the weather turns and is
mild towards the end of winter. Spring is also
time for tulips, daffodils, buttercups and
bluebells, turning gardens and meadows
into dazzling displays of colour.

The weather during spring is changeable
and unpredictable — but this has its

HELEN DIXON

advantages for the photographer. Brief
showers cleanse the atmosphere and create
rainbows arching across the countryside,
shafts of sunlight burst through stormy skies
toilluminate the landscape below, and light
mists hang over rivers and lakes or in valley
bottoms at dawn.

As the weeks pass, the days also grow
longer. The sun rises at around 6am during
the early days of spring and sets at 8pm, but
by mid-June, sunrise can be as early as
4.15am and sunset after 10.30pm in the
north of Scotland. To make the most of
spring conditions, rise early and stay out late.
Dawn on a perfect spring morning is hard to
beat, with a chorus of birdsong permeating
the cool air and the first rays of sunlight
slowly burning away the mist. The
opportunity foramazing images is one that
shouldn't be missed, and nothing quite beats
that feeling of getting in touch with nature.

The intensity of colour in the spring
landscape can be improved by using a
polarising filter to cut through atmospheric
haze and glare on the foliage. If you want to
capture carpets of spring flowers, ideally wait
for a bright but overcast day when contrast is
low and shadows weak. This makes it easier
to record the delicate colours and fine
details of the blooms, especially when taking
pictures in woodland where the light is
patchy during sunny spells.
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Spring Q&A

QHow do | shoot spring mist?

A Mist often occurs when a mild day with
rain is followed by a clear night and cold
temperatures. If that's predicted in the
weather forecast, set your alarm early and
head out before sunrise. Mist is common
near water and wetlands, and in
woodland. Get to a decent location ready
for sunrise: if you're lucky, the light from
the rising sun will burst through the mist,
creating warm rays of light that radiate
from behind trees and buildings. A straight
exposure should capture this effect
perfectly, but, if necessary, increase the
exposure in increments up to one stop.

Q What's the best shutter speed to use
when shooting waterfalls?

A A shutter speed around one second is
usually slow enough to blur the water, but
also record some texture — though you
can experiment with slower speeds. What
you don't want to do is overexpose the
water so it comes out white.

QHow do | get backlit shots of flowers?
A You need to shoot when the sun is low
in the sky, so during early morning or late
afternoon; morning is often more
atmospheric. Get down low, use a
telezoom to isolate a group of flowers and
try to capture them against a dark
background so the colours glow.

NOXIONIT3H
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®SUMMER
Summer is the least favourite season for
landscape photographers as the light tends
to be harsh and bland. Yes, the countryside
does look resplendent in its lush coat of
foliage, gardens and meadows are alive with
colour and the days last much longer. But
when the sun does shine, it can be very
intense and unflattering, with a high colour
temperature that makes images look cool,
while heat haze tends to turn blue sky into
an ugly washed-out tone. Consequently,
the number of effective hours available for
landscape photography are no more than
ona clear winter's day.

Between 10am and 4pm in summer, the

sun is overhead and the light harsh and
characterless, while shadows are short and
dense. For conventional landscape
photography, thisisn't great, but if you find
scenes containing lots of colour — oilseed
rape, poppy fields, sunflowers — ona sunny,
blue-sky day, it's still possible to produce
striking images. Use a polariser to boost
contrast and clarity, and keep your
composition simple.

Summer storms are also quite common,
with high temperatures leading to thunder
and heavy rain. This can produce amazing
landscape light, but you risk a soaking to
catch itl Once the rain subsides, crisp, clean
light will often bathe the landscape and
rainbows can appear.

The lightis atits best at the extreme of the
day, so get to your location very early or be
prepared to stay out late. The days do get
shorter as summer progresses, but 3am
starts and 11pm finishes are not uncommon.
You can always grab a sleep in the afternoon
when the light's no good!

Wild landscapes can still look dramatic
during the summer, and by early September
start to turn quite autumnal, so scout out the
locations nearest you that will be full of
colour. Rocky, barren coastline also
changes little during the summer and can
be the source of great shots — especially at
dawn and dusk when the light is warm.

Summer Q&A

Q Can | do anything about hazy skies?

A Not really. Hazy skies and overcast grey
skies lack texture or drama — they're justa
blanket, boring tone. Using an ND grad
merely darkens that tone, but rarely
makes it more interesting. Exclude the sky
from your compositions; maybe use a
telezoom to shoot selective landscapes or
concentrate on smaller details.

Qs the summer a good time to use my
infrared modified camera?

A Definitely. There's plenty of foliage to
show the ghostly infrared effect, and it
doesn't matter how harsh the lightis
because infrared photography suits it. Use
your IR camera in parks, gardens and
woodland, as well as the countryside. For
those without an IR-modified camera, try
using an infrared filter like the Hoya R72.

Q My summer landscapes often have an
unsightly blue cast. What causes it?

A High colour temperature — on a sunny
blue-sky day, the colour temperature can
hit 10000K. If you use Daylight White
Balance, set for 5500K, your camera will
record the coolness in the light. Setting
White Balance to Shade will get rid of the
cast — even Auto White Balance (AWB)
may work. Or, if you shoot in Raw, you can
correct the cast during image processing.

NOXIAN3TIH
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®AUTUMN

Colour - that's what autumn is all about.

As days shorten and temperatures fall,
deciduous foliage turns a myriad of
wonderful rustic colours. Hillsides covered in
heather and bracken turn to gold and the
landscape battens down the hatches ready
for winter. Whether autumniis a hit or a flop
colourwise depends on temperatures and
rainfall during spring and summer: the first
week in November is traditionally a time
when colours peak, but the prime period can
occur earlier or later.

Clear, sunny days provide the best
conditions to capture autumn’s beauty,
especially during early morning and late
afternoon when the sunlight is naturally
warm and the sky a deep, velvety blue. Wild
landscape looks amazing in autumn — head
to regions like Rannoch Moor in Scotland or
the Lake District and you can't go wrong.

If you intend to shoot deep inside
woodland, ideally choose an overcast day
when the light is soft and shadows weak,
otherwise high contrast will be a problem.
Such conditions reveal the woodland
colours at their most intense, especially
when enhanced by a polarising filter, which
cuts through haze on the damp foliage.

Head for rivers and lakes where you can
capture the autumnal colours reflecting in
calm water, and as well as shooting wide-

angle views, also look for details like the
vibrant patterns of fallen autumnal leaves.

Autumn is also good to capture the
landscape being brought to life by dramatic,
stormy light, with patches of sunlight
breaking through the dark, brooding sky. Or
why not rise early and make the most of
early-morning mist around water or in
woodland and valleys? If you're lucky, you
may capture the first golden rays of sunlight
burning though to create stunning images.

At the start of autumn, the sun rises
around 7am and sets at 7pm, so the days are
fairly long, but the quality of light remains
high throughout. By day one of winter, the
sun doesn't rise untilgone 8am and it won't
set much before 4pm.

NOXIN33H
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LEE FROST

Autumn Q&A

Q What causes foliage to change
colour inautumn?
A Deciduous trees drop their leaves in
readiness for winter when there's too little
light for photosynthesis to occur, and they
live off sugar reserves stored through the
summer. Chlorophyll, which gives leaves
their green colour, is necessary for
photosynthesis to take place, but as the
days grow shorter and the hours of
darkness increase, the production of
chlorophyll slows down and that's when
the colour changes start to occur.
Autumnal colours reach their peak
when all the chlorophyll has been
destroyed and other chemicals in the
leaves are revealed, such as carotenoids
and anthocyanins.

Q Canyou recommend some top
autumn locations in the UK?

Alf the colours are good, you can take
great autumn shots literally anywhere you
find deciduous foliage, but check out
Westonbirt Arboretum in Gloucestershire,
Glen Affric in Scotland, Stourhead
Gardens in Wiltshire, The New Forest in
Hampshire, Grasmere and Rydal Water

in the Lake District, Gwydyr Forestin
North Wales and Kielder Forest,
Northumberland.
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RAW & LANDSCAPES

ALTHOUGH YOU PROBABLY don't realise it yet, producing
top-notch images is easier now than at any stage in the entire
history of photography, thanks to digital technology. Chances are
many of you will have come into photography during the digital
era, in which case you'll have little or no experience of what life
was like pre-pixels. Well take it from us — shooting pictures using
digitalis a walk in the park compared to taking them with film.
Being able to see your shots seconds after capture is the fast
track to success because you can learn as you go, correcting
mistakes and making changes so that you need never miss a great
shot. Thisimmediacy, and the fact that every press of the camera'’s
shutter button doesn’t cost money, also encourages you to take

creative risks, which is by far the best way to master new
techniques and fine-tune your skills as a landscape photographer.

Of course, tripping the shutter is just the first stage in the
creative process as, once home, your images are then
downloaded to a computer where you can turn those millions of
coloured dots into amazing works of art with the aid of the latest
editing software. Successful digital imaging therefore requires a
combination of solid camera work and sympathetic processing.

For many creative photographers, there's only one way to
achieve both: shooting in Raw. If you've favoured JPEG until now,
and can't see how switching to Raw would benefit you, read on as
we explain the many benefits you'll gain going Raw.
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An introduetion to Raw

If maximum detail and controlis what you need, then shootingin
Raw is the answer. We cover the basics you need to get started

THE MAIN DIFFERENCE between a Raw file and
aJPEG s that when you shoot in Raw format,
the images recorded on your camera’s memory
card consist of the raw data from the sensor.
Nothing is added, taken away or changed. If you
shoot in JPEG, the camera records all the raw
data then develops the file in-camera; applying
preset parameters to White Balance, sharpening
and custom camera styles etc, deleting any
unnecessary information and then erasing any
remaining raw data as well.

In film terms, a Raw file is a bit like a negative,
whereas a JPEG s similar to a colour slide. Slides
are convenient because they come back from
the processing lab finished and ready to view.
The same can be said for JPEGs, which are
supposedly ready to print straight from the
camera. However, this convenience means that
you need to get everything right in-camera, so
there’s less room for error. Negatives are more
time-consuming than slides as you need to
develop them how you see fitin the darkroom,
but are much more versatile with more latitude
for error. Raw files are the same. They always
require processing using suitable software
before they're considered finished, but this
allows you to make changes to enhance the
images and correct in-camera mistakes.

The key parameters you can controlin Raw are:
® Colour temperature can be adjusted to get rid
of unwanted casts or to change the mood of an
image. This can be done with JPEGs in
Photoshop, but not with the same precision.

@ Exposure can be corrected — or adjusted for
creative reasons — without compromising
image quality. Whereas if you make a JPEG
lighter or darker, image quality will be affected.
You can also optimise image quality by
overexposing Raw files in-camera to just before
the highlights become blown, as shadow detail
isincreased and the effects of noise reduced.
The exposure can then be ‘pulled back’ while
processing the Raw file. This is only possible
because the Raw file contains more data than
you need, whereas a JPEG is already
compressed, so residual data has been deleted.
@ [f you do accidentally overexpose a Raw file so
the highlights 'blow out’, you can recover detail
during processing. This isn't possible with JPEGs,
so blown highlights appear white and if you try

to darken them they simply go grey.
® Sharpening can be applied using the
sharpening tools in Raw file processing software
or via third-party applications. JPEGs, however,
are already sharpened so extra work must be
done carefully to avoid spoiling the images.
Any changes you make to a Raw file are
nondestructive, because whenit's converted to,
ideally, a TIFF file, the original Raw image
remains unchanged. This means you can return
to the same Raw file in the future to process it
again. Raw files also contain so much data they
can be processed several times then combined
either to address exposure and contrast
problems, or used as the basis for creative
techniques such as HDR (High Dynamic Range),
which we'll show you how to do later.
Ultimately, if optimum image quality is what
you want, your best chance is to shoot Raw.
Raw files support 16-bits of data per colour
channel, whereas JPEGs support 8-bits. The
difference inimage quality won't be obvious
initially, but heavy editing reduces quality and
8-bit files will show this more readily than 16-bit.
Many photographers are put off shooting Raw
as they assume it's complicated. But using Raw
processing software is very intuitive (see panel)
and any changes you make can easily be
reversed or cancelled. A JPEG, on the other
hand, while seen as the more convenient format
for beginners, actually leaves more room for
mistakes, which beginners will surely make.
What are the downsides to shooting in Raw?
Well, aside from spending more time at your
computer processing files, there aren't many.
And if you get as much right in-camera as you
can, a Raw file can be processed in a matter of
seconds. Raw files are around four times bigger
in terms of megabytes than JPEGs, so take up
more storage space. However, memory cards
and external hard drives are cheap these days, so
if you've spent a fortune on your camera, it's
false economy to choose an image format
simply to save on storage space. Biggerimage
files also mean your camera'’s buffer will fillup
faster if you shoot in Raw. While this might prove
frustrating when shooting subjects such as
sports and wildlife, where lots of shots are taken
in quick succession, itisn't a real concern for the
landscape photographer.

Troubleshooting

QI can'topen the Raw files from my new DSLR?

AYou're having a problem opening Raw files on your new DSLR
because camera manufacturers keep changing Raw file formats as
they launch new cameras. Adobe releases regular upgrades for
Adobe Camera Raw (ACR) for new cameras. Go to www.adobe.
com and see if the latest upgrade includes your camera.

QI processed some Raw files and saved them as TIFFs, but the
files are really small. What happened to them and what can | do?
Alfyou're using ACR, open a Raw file and below the file number for
the preview image you'll see a line of text. Clickonitand a
Workflow Options window opens. To avoid the files being too
small, choose Adobe RGB (1998) for Space, 16 Bits/Channel for
Depth, 300 pixels/inch for Resolution and, for Size, choose the

closest size that matches your camera’s maximum pixel resolution.
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Shoot & process Raw

Setting your camera to shootin Raw is
easy: simply select the Image Quality
setting via the LCD menu screen and
choose NEF (Raw), or NEF+JPEG. In terms
of how you use your camera and its
controls, that remains pretty much the
same. The only difference is that when
shooting Raw, you give the image as much
exposure as you can without clipping or
overexposing the highlights. By doing this
you'll record as much shadow detail as
possible and betterimage quality as a result.
It does mean that the images in their raw
state appear overexposed, but this is easily
resolved during Raw file processing, which
you'll find a step-by-step tutorial for later in
this guide. You'll also note that the number
of shots you can fit on your card drops
dramatically, so carry spares!

Image quality

=

NEF (RAW)
JPEG fine
JPEG normal
JPEG basic

Raw processing software

You need special software to process

Raw files. Your Nikon digital SLR comes
supplied with a CD-ROM containing Nikon
View NX2 processing software (Nikon also
offers a more powerful suite, Capture NX2,
for £135). However, the majority of
photographers prefer to use a third-party
Raw processor. By far the most popular is
Adobe Camera Raw, found in all versions of
Adobe Photoshop from CS2 onwards,
Photoshop Elements since version 3.0

and all versions of Adobe Lightroom.
Apple Aperture also has its own Raw
converter, while Capture One from

Phase One is popular with some
photographers. SilkyPix is lesser known
but worth trying the free trial download.
®Adobe Camera Raw
www.adobe.com/products/photoshop/family/
@ Apple Aperture

www.apple.com/uk

@ Capture One

www.phaseone.com/4/

@ SilkyPix

www.isl.cojp/SILKYPIX/english/




TOPTIP
Shoot Raw and JPEG
If you're initially uneasy about
shooting Raw, why not set
your camera to record every
image in both Raw and JPEG?

That way, while you get used
to processing Raw files, you
know you've also got JPEGs
of the same images, for
reassurance

NOLYNG Wvav
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Thc toolbar

Atthe top-left corner of the interface are various symbols, each with a use to edit your pictures. CS5 has a few new
additions to the CS4 arsenal, which we outline below, but the main tools you'lluse for everyday Raw editing are the
Zoom, Hand, Rotate and White Balance tools. Others, such as Color Sampler, Crop, Straighten and Retouch tools,
work well, but unless you're editing solely in Raw, are best left to Photoshop once the Raw file is processed. Red-eye
removalis handy if you need it, but you're unlikely to process many portraits shotin Raw that suffer from red-eye!

R D

11) Targeted Adjustment Tool:
Instead of using the sliders,
drag this tool on the image to
make edits (CS5).

12) Adjustment Brush: Use this
tool to make localised edits to
theimage (CS5).

13) Graduated Filter: Draw a line
across your image to recreate the
effect of a Graduated Filter. You
can then adjust the Exposure,
Brightness, Contrast, Saturation,
Clarity, Sharpness and Color of the
filter to suit your picture (CS5).

1) Zoom Tool: Magnify the image
to seeitin more detail.

6) Straighten Tool: Correcta
wonky horizon or rotate.

7) Retouch Tool: Gets rid of
sensor spots and other
unwanted blemishes.

8) Red-Eye Removal Tool: Click
on the eye to remove red-eye.

9) Preferences: Click here
to access the Camera Raw
Preferences dialogue box.

10) Rotate counterclockwise &
Rotate clockwise tools: Rotate
| anti-clockwise or clockwise by 90°.

2) Hand Tool: Navigate around
the magnified image.

3) White Balance Tool: Allows

you to correct and set a custom
White Balance by clicking on
neutral areas in the preview image,
such as white.

4) Color Sampler Tool: Allows
you to select a colour to adjust by
clicking on that area of the image.

5) Crop Tool: Use to crop images.

Opcn objcct

Onceyou've doneall
your necessary Raw
editing, press shift to
turn the Open button
to Open Object to
process your Raw
filein Photoshop as
a Smart Object. The
benefit of a Smart
Objectis that you can
double-click on the
layer in Photoshop
to reopen the Raw
file and continue any
Raw edits in ACR.
Alternatively, hold
downalttoturn

the Open button to
Open Copy (so you
don'twork on the
original Raw filein
Photoshop) and the
Cancel button to
Reset to revert your
image back toits
original state.
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Understand your Raw eonverter

Togo froman original Raw file to a finalimage, ‘process’ it using a Raw converter like Adobe Camera Raw

ANY TECHNICAL process seems complicated
and daunting when you try it for the first time.
Remember taking your first digital photograph
or ‘Photoshopping’ your firstimage? Chances
are you didn't have a clue what you were
doing, but through trial and error and making
lots of mistakes, you got there inthe end. It's
the same with processing your Raw files in
software like Adobe Camera Raw.

The main reason why photographers stick
to shooting in JPEG is because it's quick, easy

and safe: the camera does the complicated
stuff and all you're left with are a few tweaks in
Photoshop or Lightroom to finish the job off.

Shooting in Raw, on the other hand,
involves another steep learning curve
because every shot you take needs to be
worked on. It's the digital equivalent of going
from taking your films to a high-street lab for
processing and printing, to setting up a
darkroom and doing the job yourself. Do you
think it's really worth all the hassle?

Inaword, yes! To realise your full potential
as a photographer, you need to take control
of your photography and the only way to
really do this is to shoot and process Raw files.
Over the next few pages, we'llgive you a
rundown of the main controls and tools
available in Photoshop’s Raw converter
— Adobe Camera Raw — with an explanation
of what they do and how to use them, starting
with the Basics tab which features everything
you need for a simple conversion.

The basic tools for

Raw conversion —
, . Temperature 5000 @ Exposure: Found at the top of the Basics
Most of Adobe's Raw controls are adjusted - - tab, under White Balance, the Exposure slider

via sliders, making them fast and easy to use. - : ; .
Here are the key ?eatures located un)éer the Tint 2 2 adjusts the overall brightness of the image,
Basics tab: CF with greater focus on the highlights. The
values are inincrements equivalent to

f/stops. For many photographers, this toolis
their saving grace as it allows them to correct
their in-camera exposure. Watch out for noise
and artefacts creeping in when you push the
exposure too far. Use in conjunction with
Recovery to reduce the highlight values.

Y

White Balance: |As Shot ] oo 900

) i]h@“l‘liihmlml“ﬁl =
® Adjustment panels: The main controls
you're going to use when processing Raw files

are to be found on the right side of the Raw
Interface, between the histogram and the

® White Balance: Shooting in Raw means that
you can control the White Balance in
post-production, rather than having to select
the right White Balance preset in-camera.
Under the Basics tab, you have all the in-
camera WB presets available in a drop-down
menu to pick from (eg Auto, Daylight, Cloudy

E

f 2 . tc). You can also use the Temperature and i
control sliders. There are eight icons covering Etc). Brightness = +50
the following set of options (from left to right): Xll?;frigie\/il;oyc&ejaégzau& S%Vm ecvl\j;tii_:r‘%\:{fh ce e
Basic, Tone Curve, Detail, HSL/Grayscale, ' Contrast +25

Tool, found in the toolbar.

Split Toning, Lens Corrections, Camera
Calibrations and Presets.

. Fill Light 0 @ Brightness/Contrast: Brightness works in
Vibrance 0 (&, a similar way to Exposure. However, instead
— S of clipping the highlights and shadows, it
s o " e F'l.l Light: Fill Light attempts to recover comgfessges and%xp%nds the information.
Saturation 0 details from shadows without brightening Set the overall tonal range first using the
<> any blacks. Similar to using fill-in flash, this

Exposure, Recovery and Blacks sliders, then
adjust Brightness. The Contrast slider mainly
affects mid-tones, causing them to brighten
or darken to increase contrast.

tool will cast some light into your foreground.
Use it alongside the Blacks slider to add more
punch, but be really careful not to overdo it
for unnatural results.

@ Vibrance and Saturation:

This toolis an alternative to the Saturation slider,
which adjusts all the colours in an image equally.
The Vibrance Tool, on the other hand, affects
colours that need boosting, having less effect on
the colours already high in saturation.

Recovery 0
Clarity 0 o

r

@ Recovery: This is an image saver for anyone
who has slightly overexposed their highlights.
This nifty tool should obviously not be

relied upon, but is definitely one of the most
invaluable features in ACR as it can recover
mid-tone detail from clipped highlights. It's
not a miracle worker, though: the detail has to
be there to begin with.

Blacks 5 @ Clarity: Adds depth to an image by

=& increasing local contrast, with the greatest
effect on the mid-tones. It works similar to
a large radius Unsharp Mask in Photoshop.
Zoom into the image 100% to see the effects
and stop when you start to see halos appear
near the edges in the image.

®Blacks: This slider shifts the left part of the
histogram even more to the left, making the
blacks in the image a lot more dominant, andis a
useful way of increasing the overall contrast.

Raw interface

When you open a Raw file in
Adobe Camera Raw, you're
presented with this interface.
The preview image shows the
Raw image in its original state.

14) Zoom: You can vary the size of
the preview image and also zoom
into it using the tabs in the bottom
left-hand corner of the interface.

15) Workflow Option: At the
bottom of the screen is the

Workflow Option. If you click on
this, a dialogue box opens, giving
you various options. For Space
(colour space), Adobe RGB (1998)
is most widely used. For Depth,
choose 16 Bits/Channel. For Size,
go for the one that matches the
pixel resolution of your camera (no
point paying for those megapixels
then not using them!). And for
Resolution, enter 300 pixels/inch.

16) Histogram: In the top
right-hand corner is the image's
histogram, which shows the

distribution of tones in the Red,
Green and Blue channels. Where
you see Cyan, itindicates a
crossover between the green

and blue channels, Yellow is the
crossover between the red and
green channels, and Magenta

isa cross between red and blue
channels. White shows where all
three channels cross over. Use the
histogram to judge the exposure as
you adjust the sliders.

17) Clipping warning: The two
triangular tabs in the top leftand

right of the histogram tell you if
there has been any clipping of

the highlights or shadows. If the
triangles are black, no clipping

has occurred. If the tabs change
colour, the colour tells you that a
colour channel or a combination of
channels have been clipped. If the
triangle is white, all three channels
are clipped. If you click on the tabs,
areas in the preview images will be
highlighted to show where clipping
has occurred — clipped shadows
show as flashing blue and clipped
highlights as flashing red.
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How to proecss a Rawfile

Get the most from every image by processing in Adobe Camera Raw

Luke Marsh

M 77 0adws0

Open the file The first thing we do when we open our Raw file is to see

how the histogram looks with the default Camera Raw settings. We can
see here that contrast is fairly low with the bulk of the information for this
image sitting in the middle. The image looks quite muted and would benefit
from extra contrast to add colour and detail.

|IRe sr7vawsrsa mono

Rescue the highlights You can recover this highlight information using

the Recovery slider, but this would be at the expense of highlights
elsewhere, which would effectively reduce contrast. The small amount of
clipped information isn't that important, so we decide to leave things be.
Exposure looks spot on so we don't need to adjust this slider either.

Mo /Y04 ss/08 800

The best thing about shooting in Raw is that you can process the file to give a far
better result than if you had captured the scene as a JPEG. The preview of a Raw
file on your camera’s LCD monitor may look identical to a JPEG as all the
additional information is hidden within the file, and it's impossible to display on
your camera’s screen. It's only when you open the Raw file on your computer that
you ll see the wonders retained in this purest of image file formats. Our guide shows how
processing Raw files in Photoshop’s Adobe Camera Raw allows you to extract an amazing
amount of information, leading to a far superior result than if it had been captured in JPEG.

Watch for clipping You'd normally look to avoid clipping any highlights or
shadows, but sometimes it's necessary in order to strengthen the dark
tones and improve contrast. For instance, here we wouldn't expect to see
detail in the rock face cracks. We also set Contrast to +60 to boost contrast
further without clipping too much more shadow detail.

Raw file

Assess the highlights First check if there's any highlight detail that

might be clipped by clicking on the triangle on the top right of the
histogram to turn on the highlight clipping display. When active, any clipped
areas flash red. The whites of the distant lighthouse here are clipped, which
means we might potentially lose some highlight detail.

MO /YRadns/0 w0

Boost the blacks The image probably looks a little flat straight from the

camera, like this one does. Adjust the blacks until the histogram spreads
towards the far left side by holding down alt/option and moving the Blacks
slider until areas show up black on the white background. You've now created
the pure blacks in your image, but be careful not to overdo it.

LoV a4ad'es0 @O0

Boost the colour Now adjust the Vibrance slider (here we set it to 30), or

the Saturation slider if your software doesn't feature Vibrance, to pump up
the colour a little. Press I to access the White Balance Tool and check that you
have got the correct White Balance by clicking on a neutral white or grey area
— the lighthouse is good here.



Adjust the White Balance If you're not happy with the image’s colour tone
(White Balance), adjust the Temperature slider a little. You can strengthen
contrast further if you feel it's necessary by clicking from the Basic tab to the
Tone Curve tab. Select Point rather than Parametric and change the
drop-down menu from Medium to Strong Contrast.

Sharpen the image Next, negotiate the Detail tab and use the Zoom

buttons to zoom in 100%. Work with the Sharpness slider to get the image

looking crisp on screen. We settle on Amount 100, Radius 1.0 and Detail 30.
Sharpening too excessively can cause artefacts and noise to appear, which is
why it's important to take pictures at the lowest ISO rating possible.

Finalimage

It's clear to see the benefits of
shooting yourimages in Raw,
asit's possible to extract far
more detail than if you had
taken the shotas a JPEG.

Add impact To emphasise areas of colour in the image — in this case the

sky and sea — make selective Saturation and Luminance adjustment.
Choose the HSL/Grayscale tab, select Saturation first and tweak the relevant
sliders (we set Blues to +40). Then choose the Luminance and do the same
thing (we set Blues to +40 here, too) until you've reached your level of impact.

LY :é}‘ ‘_":'Ifllnk y

1 Save and open Once you're finished, you can either open the image
to continue enhancements in Photoshop or save it for later. By saving
theimage as a .TIFF or .PSD format you will leave yourself with a 16-bit file as
opposed to compressing the image to an 8-bit JPEG, which reduces the
amount of information and thus flexibility when editing in the future.
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Combining Raw filcs

Get the perfectimage by merging two shots for ultimate quality

Luke Marsh
Setting your camera to shoot in Raw means you're able to recover hidden detail from
areas of a scene that are over- or underexposed. The Raw converter in Photoshop
Elements, used here, works in much the same way as CS. You need to create two separate
images of different exposures from the same Raw file — one for the sky and the other for
'Y the foreground — then combine them for the perfect result. Not only will we show how to
adjust exposure post-capture, you'llalso find out how to use the High Pass filter for sharpening and
how to make colour adjustments. This technique is especially efficient as you are only working with
image data captured in a single exposure, so you can revisit any of your old Raw files to try it.

Open the file When you open a Raw file in Elements the image appears in Repeat Reopen the original Raw file, and again the Raw control

the Raw control window (above). As the foreground in the original Raw file window appears with the image. This time move the Exposure slider
is well exposed, little work is needed at this stage on the image. Simply click (circled) left to underexpose the image, pulling back the hidden detail from
Open, leaving the settings as they are, then go to File>Save As and create a the original Raw file's overexposed sky. When you're happy with the results,
Photoshop file (.PSD) as we are going to be working with layers. click Open to take the image into Elements.

Copy & paste You now have two files open. One contains the original Remove foreground With the two exposures in place, we now want to

exposure and the other is the new underexposed image. With the combine the correctly exposed foreground with the newly exposed sky.
underexposed file active, click Select>All then Edit>Copy, placing the image With the sky layer active and using the Rectangular Marquee Tool, select a
into the pasteboard memory. Now you can close this file and use Edit>Paste large area of foreground, just short of the horizon. Next, click Edit>Delete to
to place this image into a new layer on the original file. remove the area, noting the effect in the Layers palette preview (inset).

-
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Clean up Now it's time to tidy up the horizon, so with the Eraser Tool set Enhance The initial layer work is complete, so to save your work so far,

to a medium-sized, soft-edged brush and the Opacity set to around 55%, go to Layer>Flatten Image then File>Save As to create a new file. With
gradually erase areas of the newly exposed layer along the horizon, revealing both layers merged, it's time for some overall enhancement, so click on
the original foreground image. The slight feathering between the two layers Enhance>Adjust Lighting>Levels to lighten up the image and improve the

creates a misty effect that enhances the image’s mood. definition. Click OK to apply the changes.



Finalimage -
Stormy skies overhead! It's
clear to see the benefits of
shooting yourimages in Raw,
as it's possible to rescue more
detail than if you'd captured
the scene asa JPEG.
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High Pass The High Pass filter is a far more forgiving way to enhance detail

than sharpening. To use it, first go to Layer>Duplicate Layer to preserve
the originalimage. Then go to Filter>Other>High Pass, adjusting the Radius
to around 20 pixels before clicking OK. Now you need to change the Blend
Mode in the Layers palette to Soft Light.

Select sky The image is predominantly blue in hue and we'd quite like to

inject a different tone to the sky area. Using the Rectangular Marquee
Tool, select the area above the horizon and go Select>Feather, entering an
amount of 50 pixels to soften the selection, before clicking Edit>Copy then
Edit>Paste, placing the selection into a new layer.

Darken areas Use Layer>Flatten Image again, saving a copy if required.

Now, using the Burn Tool (inset) with a large soft-edged brush and the
Opacity set to approximately 25%, darken the exposure of specific areas,
which helps to improve the depth of the image. Focus on the edges of the
frame and gradually build the effect up.

1 Adjust colour Change the Blend Mode of the new layer to Soft Light,

and then go to Enhance>Adjust Colour>Adjust Hue/Saturation. In
the window, start by clicking the Colorize box and immediately see the
effectin the preview. Finally, adjust the Hue and Saturation sliders until you
are happy with the colour, and then click OK.
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‘Exposing totheright' withRaw

Understand how your camera records tonalinformation and how to read a Raw histogram

TO MAKE THE MOST of a Raw file, you need
to learn to use your camera’s histogram.
Using the preview image to judge exposure,
isn't the best reference. A histogram, on the
other hand, provides all the information you
need to create the ultimate Raw file. It shows
the distribution of tones in a digitalimage,
from the darkest shadows on the far left of the
histogram to the brightest highlights on the
far right. The general rule when exposing an
image is to make sure tones fall within the
extremes of the histogram to retain detail. If
too much information is to the far left, some
shadows lack detail, and if it's to the far right,
some highlights may blow out and record as
pure white. Making sure neither extremes are
clipped gives an acceptable Raw file. To
record maximum tonal detail, however, you
need to ‘expose to the right’. Why? Because
sensors record more tones in the highlights
than the shadows.

Most sensors record a brightness range of
five or six stops. Most histograms are divided
into five sections, which represent the five
stops in brightness it records. Rather than the
tonal values being divided equally across
those five stops, 50% of the total number are
recorded in the brightest stop, half this
number in the next, half as many again in the
next stop, and so on, meaning that the

Reveal the detail Various controls can be

used to tone down the image — Contrast,
Brightness, Exposure — but the Tone Curve
sliders are most effective. Here, the Dark tone
was moved to -39 and it looks better already.

brightest 20% of the histogram, on the far
right, contains 16 times more tonal values
than the darkest 20% on the far left. By
‘exposing to the right’, you're maximising the
information recorded. When you check the
preview screen, images exposed to the right
look overexposed, so your natural reaction is
to reduce the exposure and reshoot, but don't
— trust the histogram! You can then adjust the
exposure and contrast when processing your
shot, retaining the important tonal values and
giving a more detailed image with less noise.

Watch out for clipping The brightest
highlights in the water and sky have been
exposed to the point that they've started to lose
detail — indicated by the red highlights. The

image looks generally washed out.

Increasing the exposure

The easiest way to ‘expose to the right’is
to take a test frame and then assess the
histogram. If the graph is centred (ie well
exposed), or to the left, increase the
exposure by + 1/3 stop via exposure
compensation, take another shot and
check the histogram. Repeat until the
highlight warning starts to flash on the
preview image, indicating that the
highlights have been ‘clipped’ and that
you've taken the exposure too far. The
frame before, where you gave 1/3-stop
less exposure, is the file to work on.

A) This is what the histogram for an
underexposed image looks like: the tonal
graph is pushed over to the left where
there are fewer tonal values. If you took a
shot like this and tried to recover detail,
you'd have problems with noise.

B) There is nothing wrong technically with
this image or histogram: the tonal graph is
central and neither highlights or shadows
have been clipped. If you saw this shot on
the preview screen, you'd probably be
happy. However...

C) Exposing to the right will record far
more tonal values in the Raw files than
correctly exposing it. This is what the
preview image will look like if you do:
overexposed and washed out. But it's the
best Raw file of the three examples!

Recover highlights Although you should try

to avoid clipping the highlights, you can use
the Recovery slider to rescue them — but no
more than about 20% should be applied as it
tends to flatten the whole image.

O A

Adjust tonality The Highlight slider was moved to the right to a value of
+26 and the Lights slider to the left to a value of -14. You can see how
the Tone Curve has changed from a straight line to a shallow 'S’ shape.

1.

Improve the colours Clicking back on the Basic tab, the Blacks slider
is moved to the right to a value of 14 from its default setting of 5, while
Vibrance is set to +22 and Saturation to +8 to boost the colours in the image.



Finalimage
After saving the processedR
file as a 16-bit TIFF, a few fi
tweaks were made in Ph
and here's the finishe
rather more impressive
original Raw file it came
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FILTERS

Lee Frostreveals the importance of filters
for landscape photographers

IMAGINE YOU'RE ABOUT to be shipwrecked on a desert
island and the captain of the vessel has given strict
instructions that you can only take three filters overboard
with you. Okay, so it's a rather extreme scenario, but — hey

— worse things have happened at sea! The question is, which
three would you take?

As a child of the Cokin era, | managed to amass more filters
than your average camera shop. | had bits of plastic (okay,
okay, C39 resin) that could add fake rainbows to my images,
ruin a perfectly nice sky by turning it tobacco, reduce
attractive scenes to impressionistic smudges, turn bright
points of light into brilliant explosions of colour, and perform
all sorts of other weird and wonderful tricks. | never used the
things, of course, because most of the effects were horrible.
But you weren't a proper photographer unless you carried at
least a dozen of them everywhere, and if the worst came to
the worst, they were ideal for making a sow's ear from a silk
purse. I've got hundred of examples to prove it.

Fortunately, after numerous failed attempts | managed to
kick my Cokin addiction, so out went all the filters that
weren't essential — which actually left very few. Later still,

I jumped on the digital bandwagon, which meant | could
jettison even more (mainly the colour correction and
conversion filters that have been replaced by White Balance
and colour temperature adjustments).

Today I'm left with only three filter types: Neutral Density
(ND) grads, a polariser and solid Neutral Density (ND) filters.
For landscape and general photography, they're all you need,
and all three can be used individually or in combination to
help you get the most from a scene.

Some of you may be thinking, ‘Why bother with filters at all
when the effects can be added in Photoshop?’ Well, if you're
thinking that, chances are you've never used them, because
while the effects some filters have can be replicated in
Photoshop, others can’t. And anyway, even if they could all
be, surely it's better to get your photographs as close to
completionin-camera as possible, rather than spending ages
at your computer trying to sort them out in post-production?

Forinformation on filter systems, take a look at the panel
below, then read on to see the difference my three favourite
filters could make to your landscape images.

Which filter system?

@ SCREW-IN: These high-quality
filters screw directly onto the filter
thread of your lens, making them fast
and easy to use. You'll find numerous
polarisers and ND screw-in filters
(including B+W's ten-stop ND) but
virtually no ND grads. While offering
excellent optical quality, screw-in
filters have one big disadvantage: if
you have numerous lenses, you'll
most likely need to buy several sizes
of screw-in filters. Brands to consider
include B+W, Hoya and Tiffen.

@®SLOT-IN: Your best choice when
investing in a filter system is the slot-in
variety. You buy rings that screw on to
your lenses and a holder that slips on
to these rings — this way you only
need one filter. Polarisers, NDs and
ND grads are all available as slot-in
filters. Cokin (P or X-Pro) and Formatt
(Hitech) are good first systems, while
Lee Filters is the professionals’ choice.
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Another fine mist
Mystery, drama, atmosphere...
using filters in your photography
can make your good shots great.




THE NIKON GUIDE TO LANDSCAPE PHOTOGRAPHY Filters 61




62 | Filters

ND graduates

Make bland skies a thing of the
past by learninghowtousea
Neutral Density graduate filter

HOW MANY TIMES have you composed a
great shot with a dramatic sky only to
discover that when you check the picture
you've taken the landscape looks fine, but the
sky is overexposed and washed out?

Naive photographers shrug their shoulders
and think, ‘Oh, I'll rescue that later’ — which is
fine if there’'s something to rescue. But if the
sky’s so overexposed that no detail has been
recorded, there won't be. More experienced
shooters take two photographs of the scene
— one exposing for the sky, the other for the
landscape — then combine them in
Photoshop. This method works well, but
does mean more time in front of a computer
than a camera. The quickest and easiest
solution is to use an ND grad filter.

ND grads are grey on the top half — that's
the Neutral Density part — and clear on the
bottom half. The idea is that the grey part of
the grad tones down the brightness of the sky
so that when you expose for the landscape,
the sky is also correctly exposed, instead of
being completely blown out.

ND grads & exposure Choose the right density

Before multi-zone metering was To produce a convincing result you m
introduced, exposure readings had to be need to choose the right density of ND
taken with a lightmeter and set manually grad. Fortunately, making the right

on the camera before attachingan ND choice isn't difficult as there are only
grad to the lens in order to avoid getting an three main densities to choose from:
overexposed image. Metering systems 0.3,0.6 and 0.9, which reduce the
these days are much more intelligent; now brightness of the sky by one, two and
you can compose your shot, align the three stops respectively. Some

grad ready for use and meter with it on the manufacturers also produce a 1.2ND
lens. The reason for this is that a multi- grad, which tones down the sky by four
zone metering pattern takes a number of stops. The weakest, 0.3ND, is only of
exposure readings from different parts of use when you need a very subtle effect,
the image area, therefore the darkness of while the stronger 0.9ND is mainly used
the filter doesn'tinfluence the final atdawn and dusk when the sky's really
exposure in a negative way. In fact, it helps bright but there's no direct light on the
your camera obtain an accurate reading, landscape. That just leaves the 0.6ND
aswhenan ND grad s fitted, the Neutral grad, which is the best choice for
Density part of the filter darkens the sky general use. If in doubt, take a test shot
area so that the contrast between the sky with a 0.6ND grad, check the image on
and foreground is reduced. Hey presto: a your camera'’s preview screen, then
perfectly exposed landscape. switch to either a 0.3ND or, more likely,

a 0.9ND if the effectisn't right.
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Aligning an ND grad

The key to success with a grad is correct
alignment, so it does its job without leaving
telltale signs. Many photographers struggle
and assume there must be a magic formula,
but it's just a case of taking your time.

Slide the filter

Mount your
camera on a tripod and
compose the frame.
Next, place an ND grad
filter in the filter holder
on your lens, and while
peering through the
viewfinder, slowly
push the grad down
into the holder.

Watch carefully
Asyouslide the
grad down you should

see the top part of the
picture appear to get
darker. It won't be
obvious, evenif you're
using a strong ND grad,
so watch carefully and
when you think you've
gotthe ND grad in the
right position, stop
moving it down.
Don’tgo too far
A common mistake
is to push the grad too
farinto the holder. The
grad will then act like a
solid ND filter and
increase the exposure
butitwon't balance the %
differencein light -
between the sky and
foreground. You may
also see theline
of the grad.
Use LiveView
If you struggle to
align the grad using the
. viewfinder, try using
LiveView. You may find
Reaeh for the sky it simpler to do this as
Experienced landscape youreseeingthe
photographers consider an exact effect the filteris
ND graduate an essential item having on theimage,

and not an optional accessory. making it easier to
accurately aligniit.

Hard or soft grads?

There are two types of ND grad: hard and soft. This
refers to the way in which the Neutral Density (grey)
part of the filter graduates down to clear: with hard
grads the change is quite sudden; whereas with
soft grads it's gentle. Newcomers to ND grads
assume that soft grads are easier to use because if
you align them incorrectly it's less likely that you'll
see the line of the grad in your picture. However,
hard grads are also quite forgiving and give a more
defined effect, making them the best choice.

1SO¥4 331 'SIOVWITIV
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Polariser

Acircular polariser will be your
best friend, boosting colour
impactand reducing reflections

WHEN LIGHT STRIKES a surface, some of the
rays scatter in all directions thus becoming
polarised, causing reflections and glare that
reduce colour saturation — particularly on
shiny surfaces such as paintwork and foliage.
Polarising filters prevent this from happening
by only allowing light rays to enter your lens
that are travelling from one direction —
effectively blocking out polarised light. Doing
this offers three distinct advantages for
landscape photography.

The most obvious benefit is that the blue of
a sky is deepened because it contains a lot of
polarised light. Using a polariser allows you to
add visualimpact to images by providing a
strong, punchy blue backdrop. Another
benefitis that glare on non-metallic surfaces
is reduced, so the colours in a scene appear
richer and more saturated. The third
advantage to using polarisers is that
reflections are eliminated, so you can see
through windows and into rivers.

Using a polariser is easy because you can
see the effect it has simply by rotating it
slowly in its mount on your
lens while looking

Polarisers & exposure

When you use a polariser, it reduces the
light entering your lens by two stops. This
means if you have an exposure of
1/125sec at f/11 without a polarising filter
in place, the exposure would drop to
1/30sec at f/11 once you fitted it. Your
camera accounts for this light loss
automatically, so you don't need to
compensate, but you need to be aware of
it because the shutter speed can easily
become very slow when using a polariser
— evenin bright sunlight — so the risk of
camera shake is increased. That said, this
light loss can be a benefit when you want
to use a slower shutter speed, as the
polariser acts like a two-stop (0.6) ND
filter (covered overleaf). When shooting
waterfalls, for example, the polariser not
only gives you a slower shutter speed to
blur the water, but also removes
reflections from water and glare from wet
rocks and foliage, giving a better result.

through the camera’s viewfinder. Blue sky
goes darker and white clouds stand out,
reflections come and go, and glare
disappears. When you're happy with what
you see, simply stop rotating and fire.
To get the best possible results,
however, you should also bear in
mind certain factors.
Although polarisers
generally work best in bright,
sunny weather when there’s
more polarised light around,
they can be used in dull,
overcast conditions, too, in
order to remove glare and
reflections. Autumnal
woodland scenes usually look
much better if you shoot them
through a polariser, as glare is
reduced, so the rich colours of the
foliage really come through.
When using a polariser to deepen blue
sky, keep the sun atarightangle to the
camera so you're aiming towards the area of
sky where maximum polarisation occurs.
That way, you'll get the strongest effect. If the
sun is behind you, or you're shooting into the
sun, a polariser won't make much difference.
Polarisation in the sky also tends to be better
when the sunis low in the sky — so early
morning and evening give better results than
in the middle of the day.
Polarisation is uneven across the sky,
so take care when using ultra wide-angle
lenses or zooms with a focal length wider

With polariser

linear?

There are two types of polarising filters
available: linear and circular. Avoid

linear. You need to use a circular
polariser with your digital camera as
linear polarisers are used on certain
older manual focus film SLRs. Both types
do exactly the same job, but a circular
polariser is manufactured differently to
ensure correct exposure when used
with autofocus DSLRs and CSCs.

than 24mm (16mm on APS-C sensors) as the
sky in your images may record darker on one
side than the other: the effect can look very
odd. This can be corrected in Photoshop
later, but it's tricky. You should also note that
glare will only be removed from non-metallic
surfaces such as paintwork, foliage and
plastic. To remove reflections from surfaces
such as water and glass, the angle between
the reflective surface and the lens axis must
be around 30°. You can find this by making
slight adjustments to your position then
rotating the polariser to see what happens.

Finally, polarising filters can give your
pictures a slight blue colour cast when used
in bright, sunny weather. To remove this,
either adjust your camera'’s White Balance
setting or correct the cast when you process
the Raw file on your computer.

With polariser




Blue sky thinking

Beef up your blue sky and
add visual impact to scenics
by using a polarising filter.
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Neutral Density (ND) filters

Lengthening exposure times with a Neutral Density filter is one of the simplest
ways to be creative with your camera, producing great movementin images

ND FILTERS ARE specially made to reduce

the amount of light entering your lens without
changing the colour balance — hence the name
Neutral Density. They do a similar job to ND
grad filters, but instead of affecting just part of
theimage (usually the sky with ND grads), they
have a uniform effect on the whole image.

ND filters are mainly used to increase the
exposure required for animage, so you can use
a slower shutter speed to record motion. The
classic subject that they're used for is waterfalls,
recording the moving water as a graceful blur.
But they can be used to introduce or increase
motion in all kinds of subjects — crowds of
commuters pouring off a train, traffic moving
along busy roads, trees blowing in the wind,
waves washing over rocks and so on.

They're ideal for use in bright conditions
when the lowest ISO rating and smallest
aperture aren’'t enough to give you the slow
shutter speed that you desire.

Technique watch!

@DIFFERENT DENSITIES

The amount of exposure increase an ND
filter requires depends on its density. The
weakest ND worth bothering with is a 0.6ND
(4x), which requires a two-stop exposure
increase. A polariser also requires an
exposure increase of two stops so can be
used like a 0.6ND filter. Next upisa 0.9ND
(8x), which requires a three-stop exposure
increase, followed by a 1.2ND (16x) that
requires a four-stop increase. This is where
the density of conventional ND filters ends,
though you can combine two or more for a
cumulative effect —a 0.6ND and a 0.9ND
together will require a five-stop exposure
increase, for example.

The alternative is to use a more extreme ND
filter, with a density of 1.8 (six stops) or more.
These filters were originally designed for
photographing industrial processes that
involved extreme brightness butare now
popular with photographers as they allow
exposuresin daylight of several minutes. Turn
over for our favourite: the 3.0ND, which
requires an exposure increase of ten stops —
that's 1000x more than the unfiltered exposure!

Exposure chart

If you're using weaker ND filters, up to a 1.2 density,
your camera’s TTL metering will be able to give
accurate exposure readings with the filter on the
lens. Once density goes beyond 1.2, however, you
may find that underexposure occurs because the
filter density fools the camera’s metering.

To avoid exposure error, take a meter reading
without the ND filter on the lens, then calculate
the required exposure with itin place and set the
exposure on your camera manually. If you have
aniPhone, there's a useful app called ND Calc
that will do this for you.

Alternatively, refer to the table below. Once the
required exposure goes beyond 30 seconds you
will have to set your camera to its Bulb (B) mode
and time the exposure using the timer on the
camera or smartphone, a remote release, your
wristwatch or by counting elephants — you
decide! We'd recommend that you photocopy
and cut out the exposure chart below and keep it
along with your ND filter for easy reference.

Nofilter With0.6ND | With0.9ND | With1.2ND

1/500sec 1/125sec 1/60sec 1/30sec
1/250sec 1/60sec 1/30sec 1/15sec
1/125sec 1/30sec 1/15sec 1/8sec
1/60sec 1/15sec 1/8sec 1/4sec
1/30sec 1/8sec 1/4sec 1/2sec
1/15sec 1/4sec 1/2sec One second
1/8sec 1/2sec Onesecond  Two seconds
1/4sec Onesecond  Twoseconds Fourseconds
1/2sec Twoseconds Fourseconds Eightseconds
One second Fourseconds Eightseconds 16 seconds
Twoseconds  Eightseconds 16 seconds 32 seconds
Three seconds 16 seconds 32 seconds One minute

Fourseconds 32 seconds Oneminute  Two minutes

Nofilter




World in motion

Using an ND filter allows
you to use longer shutter
speeds in daylight: ideal
when shooting waterfalls.
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While ND filters should be neutral, once
you combine them for higher density
(and alonger exposure), you'll see that
colour casts appear. This is most
noticeable with ten-stop ND filters —

the B+W 3.0 adds a very warm colour
cast while the Lee Filters Big Stopper adds
a cool blue cast. These can enhance the
look of the image, but if you prefer, you
can adjust the colour temperature when
you process the Raw file.
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Ten-stop ND filters

Use aten-stop ND filter and you'll find you
can create striking colour and black & white
fine-artlandscapes with ease

THE FIRST THING YOU'LL notice when using a ten-stop ND
filteris thatit's so dense, you can't see throughiit. In bright
sunlight you might just make out a faintimage through the
viewfinder, but its brightness is 1000x less than if you didn't
have the ten-stop ND in place. To take a photograph you must
therefore mount your camera on a tripod, compose the scene,
set focus to manual (as AF won't work through it), align your
ND grad in its holder if you're using one, then finally position
the ten-stop ND. Most digital SLRs have LiveView that's
sensitive enough to see through a ten-stop ND, so if you need
to adjust the composition or move the camera and shoot from
a different spot, you may be able to do so without taking the
ten-stop ND filter off. For most of us, though, removing the
filter to see through the viewfinder is unavoidable. That's why a
slot-in filter like the Lee Filters Big Stopper or HiTech’s Pro Stop
is more versatile than the B+W screw-in filter — you can simply
remove it from its holder and leave everything else in place,
whereas the B+W has to be unscrewed from the lens.

The longest exposure you can achieve using your camera’s
programmed shutter speed range is 30 seconds. More often
than not, you'll be using exposures much longer than that with
the ten-stopper, so you'll need to set your camera to Bulb (B)
mode in order to keep the shutter open. Trying to keep
exposures under 30 seconds for convenience, by opening up
the aperture or increasing the ISO rating, is completely
defeating the object because you'll get the best effects by
using exposures of several minutes.

In terms of subject matter, any scene containing moving
elements isideal. The sky is an obvious candidate: on a windy
day, clouds are transformed into ghostly streaks as they drift
overhead, and you won't know quite how they're going to
record until the exposure ends and you can review the shot.
Trees and grass swaying in the breeze also take on a totally
different appearance when exposed for several minutes,
adding a strong sense of motion to animage.

Coastal scenes are perhaps the most effective subjects for
the ten-stop ND. The sea is constantly moving, so over the
course of a few minutes, any texture inits surface is lost and it
takes on a smooth, milky appearance that contrasts well with
static elements such as piers, lighthouses, headlands, jetties and
rocks. Clouds work well, too, rendering as streaks in the sky. Or
for something completely different, try shooting urban scenes
with a ten-stop ND. Anything moving through the scene while
the shutter is open — people and traffic mostly — won't record.
This means you can capture something that we never see with
the naked eye — busy streets completely deserted!

Wide-angle lenses are more effective than telephotos when
using a ten-stop ND because you can emphasise the sky and
the foreground, which is where most of the motion is
recorded. Move in close to a static feature in the foreground
and contrast it with moving water, or get down low with a wide
lens so you're looking up at the sky.

Bright sunshine gives the least effective light for ten-stop

THE NIKON GUIDE TO LANDSCAPE PHOTOGRAPHY

1/4sec with nofilter

shots as it's harsh and flat, plus the higher light levels mean you
won't be able to achieve really long exposures — even with
your lens stopped right down and the ISO rating at its minimum
setting. Dawn and dusk, on the other hand, are perfect for
creating atmospheric images, along with early morning and
evening when the sun'’s low in the sky and the light is warm.
The B+W 3.0 ten-stop ND has a warm colour cast, which is
ideal for enhancing shots taken at either end of the day. Stormy
weather can produce dramatic results, too, as there’'s more
movement in the sky and sea, while on overcast days the soft
lightand gentle tones result in simple, graphic images.
Although you'll be shooting in colour, ten-stop shots look
amazing in black & white — especially if you're not keen on the
filter'sinherent colour cast. To maximise the impact and drama,
when converting your picture to monochrome, treat the sky
and the rest of the scene as separate elements by adjusting
their tonality separately, using tools such as Levels and Curves.
The end result may look nothing like the original scene, but that
doesn’t matter because as soon as you put a ten-stop ND filter
onyour lens, you're taking a step back from reality anyway.

Exposure chart
The charton the right !

reveals the increase of
exposure times when using

. ) 1/500sec Two seconds
aten-stop NDfilter. It's a key
reason why you're 1/250sec Four seconds
recommended not to use 1/125sec Eight seconds
the Long Exposure Noise 1/60sec 16 seconds
Reduction system on your
camera, as this function 1/30sec 32 seconds
takes the same amount of 1/15sec One minute
time as the exposure. For '
. 1/8sec Two minutes
instance, when you shoot a
two-minute exposure, you'll  1/4sec Four minutes
need to wait another couple  1/2sec Eight minutes
of minutes for theimage to p— P ——
write and be viewable on
the LCD monitor. We'd Two seconds 32 minutes
suggest you switch Noise Three seconds 48 minutes
Reduction off and control

Four seconds One hour

noise in post-production.
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Set the mood

The ten-stop ND is the filter
of the moment. Don't

leave home without one.
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STAND AMAZED-WASDALE

Photographing people in the landscape on assignment for the National Trust,

| frequently work handheld with a Nikon D-700. Here | had to respond quickly in
fast-changing weather, aiming to capture the essence of the light as it transformed
the scene before us second by second. Shooting towards the sun necessitated a
LEE 0.9ND hard grad; this allowed me to keep the clouds predominantly mid-tone
while ensuring good quality noise-free detail in the landscape and on the young
people. No other approach would have worked here.

| have used LEE Filters for nearly twenty years now for one over-riding reason:
quality. The sharpness of my lenses are totally unaffected by the filters because of
their optical clarity and plane parallelism (flatness). And the neutrality of LEE's ND
filters (graduates and standards) is legendary. They are the best in the business,
which means less post-processing time spent correcting unwanted colour casts.
Finally, the filter holder is easy to use, flexible and a virtually indestructible design
classic. Of the two | carry on assignment, one is over fifteen years old.

Lk

Joe Cornish

www.joecornish.com

INSPIRING PROFESSIONALS
Tel: (01264) 338599 www.leefilters.com

| |

/
i

LEE 0.9 ND
hard grad filter

LEE Filter Holder

Nikon D-700,
24mm Lens,
1/320 sec @ /14
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UNDERSTANDING COLOUR

ALOT OF TIME, energy and thought has been devoted to
the study of colour, its practical applications and its
psychological effects. Often those applications and effects
are linked. It's not an accident that stop signs are red, cool
settings on air conditioning are blue or that the
environmental movement has adopted the colour green.
Much can be learned about the relationships between
colours, too. Colours work together in different ways, with
certain combinations creating energy and tension, while
others harmonise and create calm. When a colour appears
in nature with a greater than normal intensity, the stage is
set for great landscape photography. Learning their
relationship will reap rewards, helping you to achieve
stunning shots that you never before thought possible.

®Harmony and contrast
There are basically two types of relationship between
colours — harmony and contrast. Looking at a colour
wheel helps us to understand this. Colours that are next
to each other — for example, blue and green — are
harmonious, while those that are opposite — for
example, blue and yellow — contrast with each other.
Also, colours that are on the ‘'warm’ side of the wheel
harmonise with each other, while all those on the ‘cool’
side also harmonise. Harmonious colours are more
calming to look at, and blues and greens in particular
are very tranquil. Contrasting colours are more
dramatic and create a tension that can challenge the
eye — blue and yellow is a strong contrast.

THE COLOUR WHEEL
Contrasting colours, such as
yellow and blue or red and
green, create tension and
drama. Colours adjacent to
each other are calming.
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©®COLOURAND EMOTION

As well as having visual impact, colours can suggest different moods,
evoke various emotions and can have symbolic significance related to
our culture and background. Think about the effect a dominant colour
might have on your image. It might be appropriate to subdue a colour, or
emphasise it. Consider colour in the composition, the lighting and
through careful use of filtration.

RED is an intense colour, especially when contrasted against a dark

background. Itis a colour universally used for warning or danger and
is hard to ignore. Red is the most powerful and attention-grabbing colour
in photography, though it can prove distracting if included small within
the landscape, for instance, a distant car, boat or letterbox.

BLUE is a retiring colour, which can be employed to convey

restfulness, sadness or tranquility. In photography, it is commonly
used to convey coldness, which works especially well when combined
with water and wintry scenes. Blue is a very important colour for
landscape photographers as a saturated sky creates a flattering backdrop.

GREEN is often used to signify health and life. Obviously, green is the

predominant colour of vegetation and therefore it is dominantin
many scenic images. Green is easily overwhelmed by bright advancing
colours like red and, generally speaking, has less impact. However, when
isolated, green can still create strong, interesting images.

Y YELLOW is another bold, advancing colour, often used to represent
happiness or brightness. It willadd warmth to your image and works
particularly well when combined or contrasted with blue. Yellow, along
with similarly rich colours, like gold and orange, epitomise autumn. It can
prove a good background for still-life images.
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@USING ONLY ONECOLOUR

Single colours often give an image a particular mood
and it's possible to make successful compositions
using just one colour — or shades of one colour.

Certain lighting conditions can create this effect
and add atmosphere to a scene. Anintensely orange
or red sunset gives every neutral colour a strong bias,
bathing a scene in a fiery warmth.

Also, strong backlighting can desaturate colours,
creating an almost monochromatic effect; while at
pre-sunrise and post-sunset, there is no single
strong light source and the light is diffused and
reflected down from the sky.

The two images on the right are really good
examples of monochromatic images. Starting over
on the far right you can see how backlighting has
drained the colours from this scene, resulting in an
image that appears almost devoid of colour.

The predawn light bathing the lake and dead
wood in the near-right picture is diffused, falling on
the scene from virtually the whole sky. It has given
the scene a fairly cold cast, but the mood is tranquil.
It suits the cold stillness of a winter morning.

®COLOUR SATURATION

Okay, if we're going to be strictly technical about
this, the term saturation refers to how pure a colour
is. But over time, and in practical terms, saturation
has come to mean how intense or strong a colour
appears in an image. Producing saturated images
involves more than simply boosting colours in
Photoshop - although much can be done that way,
with great results, there are many options at the
picture-taking stage. Let's consider those first.

The time of day has an impact on colour
saturation. Early morning and late-evening light,
with the sun low in the sky and less glare, produces
more intense colours than at other times, as does
front lighting rather than side- or backlighting.

A polarising filter, by reducing reflections and
cutting down on glare, also improves saturation.

A polariser has the maximum effect when the
camerais at 90° to the sun. Polarisers are simple
to use as the effect is clearly visible through the
camera’s viewfinder — the most obvious one being
the increase in saturation of blue skies.

There are a couple of things to watch out for. It's
possible to over-polarise a scene, resulting in
near-black skies, and also, when using wide-angle
lenses (wider than 28mm on a full-frame DSLR or
17mm on an APS-C sensor), the degree of
polarisation can be uneven across the frame.

Of course, you won't always want strong, vibrant,
saturated colours. Muted pastel tones are more
subtle, but can be just as effective with the right
subject matter, creating an atmosphere of calm and
tranquility. Early morning mist drains colours and
gives a cold, bluish hue to a scene, which you can
enhance by tweaking the White Balance in-camera,
or later, if you're shooting Raw.

A lot can be done at the processing stage.
Experiment with White Balance settings to
fine-tune the overall atmosphere and cast. Over the
page, we'll show how varying the White Balance of
a Raw file can give dramatic results.

Types of polariser

There are two types of polariser: circular and
linear. This doesn't refer to the physical shape

— they're both actually circular — but the way the
light is polarised. Make sure you buy a circular
polariser for use with your DSLR as linear types
interfere with your camera’s metering, which
can'thandle linearly polarised light.

Predawn monochrome
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Backlit desaturation
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Using White Balance presets

Learn how to alter the tone of your landscape images by experimenting with
different White Balance presets for creative effect

gl Different light sources have different

colour temperatures that affect the
warmth and coolness of animage'’s
colours: forinstance, fluorescent light
produces a yellowish cast, while
tungsten light is slightly blue. Normally you
would set your digital SLR's White Balance to
match the lighting conditions in order to
eliminate any colour cast, usually most evidentin
the whites of an image. But while keeping to this
rule ensures the whites are actually white, using
different White Balance presets on certain types
of scenes can give your pictures a deliberate cast
that makes them look cooler or warmer for
creative effect. It's the digital equivalent of using
certain types of film or filters as a way of giving an
image more impact.

Auto White Balance (AWB) is the easiest way to
maintain a correct White Balance and generally
produces acceptable results. However, when you

Find your location Coastal sunsets or sunrises work well for this type of
technique due to their vivid colours. Try to arrive at the location at least

are capturing a particularly warm or cool scene,
such as at sunset or twilight, or if your scene is
dominated by one colour or hue, AWB can
overcompensate, rendering the colours
inaccurate and sometimes flat. You're better off
taking control over the WB and setting it to match
the lighting or setting the WB according to the
tone and feel of the shot you want. For instance,
setting Cloudy or Shade when the sun's setting or
rising can add extra warmth, boosting the oranges
and yellows in the sky, while setting Tungsten or
Fluorescent WB can make the colours cooler by
injecting some blues to the scene.

If you're shooting JPEG, you need to set the
White Balance you want to use before you take
the shot. For more options, though, we'd strongly
recommend shooting Raw + JPEG, setting the
correct White Balance and then experimenting
with the White Balance afterwards in post-
production. The following step-by-step guide
will show you how easy itis to do...

2”

For added flexibility, shoot your
images in Raw and adjust the
White Balance post-capturein
Adobe Camera Raw. Once the
image is opened, click onthe
drop-down menu at the top of
the Basic tab and scroll down to
select the White Balance preset
you'd like to apply to your
image. You can change the WB
as many times as you want until
you find the one you're happy
with and even adjust the
Temperature slider for more
control over a custom WB.

e s

As Shot
Temperatire 50

o

Tint Cloudy
—_—thece

Tungsten

t
Fash

B Averture-priority auto

F13

00 00
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Use Auto White Balance Once you've composed your scene, select
AWSB (see your camera’s manual if you're not sure where it is) and set

half an hour before the golden hour begins. Try out different compositions aperture-priority mode to at least f/13 to get adequate depth-of-field. If your
and look for foreground interest. If you have trouble finding anything, use autofocus struggles in the low light, switch to manual focus. If you struggle to
the wet sand or a rock pool to add a reflection in the scene. balance the exposure between the sky and foreground, use an ND grad filter.

Daylight Tungsten

Try out WB presets As you can see, AWB keeps the colours true to the

scene but lacks punch. To warm up colours, | take the same shot using
the Daylight, Shade and Cloudy WB presets. The lower the Kelvin (colour
temperature), the more saturated the oranges, yellows and reds. Cloudy is

Increase Kelvin As the sun falls just below the horizon, try increasing the

Kelvin by setting Tungsten and then Fluorescent WB to enhance the
blueness of twilight. To avoid colours looking too unnatural, opt fora WB
setting that enhances the blues in the scene but doesn't overpower the whole
the best WB as it boosts the sky's warmth without losing too much coolness. image. For this scene, Fluorescent is much better than Tungsten (see right).
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BLACK&WHITE
LANDSCAPES

Strip back a scene toits bare essentials by converting to black & white,
producing simple, dramatic images that are packed with atmosphere

WHAT'S YOUR OPINION on black & white photography? Do you see it as a fine-art medium that
offers endless scope for creative self-expression, or is it irrelevant and old-fashioned? For a long
time, the latter view tended to apply, especially once colour film became affordable back in the
"70s. Why take photographs in black & white when colour ones are far more realistic? The critics
had a point, but fans of the black & white image were quick to point out that it's the very fact
they're not realistic that gives them their appeal, and when you study the work of landscape greats
such as Michael Kenna, Ansel Adams and Josef Hoflehner, you'll soon see why.
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AS WONDERFUL as colour photography is, it
can also be too familiar. It shows us what
things look like and leaves us feeling reassured
and comfortable. Butin art, reality isn't always
the best solution because it doesn't
encourage us to look beyond familiarity and
appreciate animage for any reason other than
what it depicts. As soon as you remove colour
from animage, however, everything changes
as it no longer represents reality.

Black & white images are simpler, more
dramatic, more evocative and more
atmospheric than colour. Our emotional
response to a colour landscape image is often
rendered superficial by familiarity, but comes
from a much deeper place when we take that
colour away. Light, shade, texture and shape
take centre stage and what's actually in the
scene becomes almostirrelevant — it's the
impact and effect the image has on you that
counts much more.

Digital technology makes black & white
landscape photography easier than ever
before, mainly because the need for a
blacked-out room and smelly chemicals has

The basierules

Although you don't have to adhere to
specific rules when creating black & white
landscapes, there are a few worth
considering. For example:

® Use foreground interest to add a sense
of depth and scale when shooting with a
wide-angle lens.

@ Look for lines that can carry the eye into
the scene — walls, fences, rivers, streams,
paths, shadows and other natural or
man-made features can be used.

® Use hyperfocal focusing to maximise
depth-of-field so you can record the
scene with front-to-back focus without
having to stop your lens right down to its
minimum aperture.

@ Use the rule-of-thirds to position the
scene’s focal point — the top-right third is
usually the best place. You can also divide
the scene into thirds — two-thirds sky and
one-third foreground, or vice versa.

been removed from the equation without
compromising the quality of the final result -
now anyone with a digital camera can create
amazing black & white images. Putting
yourself into the right mind-set to ‘see’ the
landscape in black & white can be tricky, but
it's an obstacle that can easily be overcome.
By setting your camera to black & white mode
and using the LCD screenin LiveView, you
can view the scene in front of you in black &
white and quickly pick up on which scenes
and colours work best in monochrome.
Certain colours when rendered black & white
look similar grey tones, which can make your
shots look flat: learning what colours create

_
b
m
7
3
2
]

| Above: Misty, blurred water, dramatic looming

skies and gritty textures are all great ingredients
that add up to an impressive, almost other-
worldly, monochrome image.

Right: Don't be afraid to throw the rule book out
of the window and include lots of sky in your
black & white landscape images. Any interesting
cloud formations become the focal point.

contrasting tones will help you recognise
what scenes look good in black & white. You
can even shoot in both Raw and JPEG — the
image you see on your camera’s preview
screen will be black & white, but you'll also
have a colour Raw file on the memory card

| that you can work on later. The other option is

Filters for blaek & white

When you convert animage
to black & white, some colours
come out as similar grey tones.
The solution is to use filters to
change the way colours translate
to grey and also control contrast.
Film photographers did/do this by
placing optical filters on their lens
(yellow, orange, red or green for
landscapes). These filters work by
lightening colours close to them
and darkening colours opposite
them on the colour wheel, so a
red filter lightens reds and other
warm colours, but darkens blues
and greens, for example. As a digital
shooter you don't need to use these
optical filters on your lens because
you can add their effects when you
convertanimage to black & white
during post-production, using
Photoshop, Lightroom, Aperture
or plug-ins such as Nik Software’s
Silver Efex Pro 2.

An alternative optionis to

use the Monochrome Picture
Style in your camera to add filter
effects to animage as you take
it. Or you could set your camera
to Monochrome mode then use
opticalfilters on the lens, though
you'll produce better images by
shooting in Raw (colour) then
converting to black & white later.
Here's a quick rundown of the
effect that different black & white
filters will have on your image:
® Yellow: Lightens warm colours
and darkens cool colours. Also
gives a slightincrease in contrast,
but the effects are subtle.
® Orange: Lightens warm

colours and darkens cool colours,

enhances skies and gives a
significant boost to contrast.

® Red: The most dramatic filter of
all - blue sky goes almost black,
clouds stand out starkly and
contrast is significantly increased.
Darkens greens in the landscape

and lightens warm colours.
® Green: Lightens greens and
blues while darkening warmer
colours. Handy for landscapes as it
separates out shades of green.
® Blue: Not a good choice for
landscapes generally as greens and
blues go very light so it tends to
ruin dramatic skies.

There are certain filters that
you can use on your lens when
shooting images in colour to
convert to black & white later, and
they include a polariser, neutral
density (ND) grads and ND filters.

POLARISER Has a
similar effect on the sky
to ared filter, darkening

blue and making clouds
stand out, but it also improves
clarity and increases contrast,
and all of these effects will be
seenintheimage whenyou
convert it to black & white.

ND GRADS These are
used to reduce the
difference in brightness
between sky and land so
when you expose for the
landscape, the sky is also correct.
A 0.6ND grad is fine for general
use, buta darker 0.OND grad is
better when the sky is bright or for
dramatic effect.

ND FILTERS Allow you

toincrease the exposure

so you can record

movementin the
landscape. Traditional NDs such as
a0.6,0.9and 1.2 are handy for
blurring the water in waterfalls,
rivers and coastal views, butin
recent years, extreme NDs such as
the Lee Filters Big Stopper have
become popular as they allow you
to use exposures of a minute or
longer in daylight to capture
motion in the landscape.
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" TOPTIP
Black & White Mode

To switch your Nikon to
Monochrome mode, press
the Menu button and enter

the Shooting Menu. Go
down to Set Picture Control

and select Monochrome
before pressing OK.

R ' i
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simply to shoot as normal, in colour, then
decide later which images you want to
convert. Some will work, others won't, but
there's no reason why you won't end up with
some great pictures. The reality is, most of us
like to shoot both colour and black & white
rather than one or the other exclusively, and
we may chop and change between the two
while at the same location, or even decide
months later to convert a colour shot to black
& white. There's nothing wrong with doing
this — all that matters is the end result.

The great thing about mono landscape
photography is that it offers endless scope for
creative expression and experimentation.
You've stripped away reality by removing
colour, so after that it doesn't really matter
what you do. You can go dark and dramatic
even if the original scene wasn't, or soft and

gentle, and control the mood of the final
image. You can also use filter effects to
change the tonal relationship in the image
and boost contrast (see panel opposite).
Basically, you make your own rules.

Black & white suits all types of landscapes,
from grand, sweeping views to small details
and everything in between, so no matter
where you are you'll find mono inspiration. It's
also possible to produce stunning black &
white images in situations where colour
simply wouldn't work, such as on flat, grey
days, so it can offer a creative escape route
that you may not have thought of. The images
used in this feature should give you a good
idea of what we're talking about. Black &
white can take your landscape photography
toawhole new level - allyou have to do is
throw caution to the wind and give it a go.

Black & white landscapes | 79
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Black & white FAQs

QDoes it matter if | shoot in JPEG then
convert my images to black & white, or
should | ideally shoot in Raw?

A lt's always better to shoot in Raw as the
Raw file is like a black & white negative —
it contains all the information you need
but you can interpret that information in
different ways to control the mood of the
finalimage. With JPEGs, a lot of that
information has already been deleted
in-camera soit's a less versatile image
format. That said, you can still produce
great black & white images from JPEGs!

Q What's the best software for
converting images to black & white?

A The most popular is Nik Software's Silver
Efex Pro 2, part of the Nik Collection (see
page 89). It offers lots of presets that give
you great effects at the click of a mouse,
allows you to tone your images and add
the characteristics of specific black &
white films, but it also gives you a high
degree of control over the image so you
can adjust contrast and exposure in
localised areas. Photoshop, Lightroom
and Aperture are also excellent options.

Qlwantto buy a ten-stop ND filter.
Which one would you recommend for
black & white images?

A There are three main options: the Lee
Filters Big Stopper (£150); the B+W 110 3.0
(E125 for 77mm thread); or the Hitech Pro
Stop 10 (£75). Based on price, the Hitech is
the winner, but based on image quality,
the Lee Big Stopper is a better option. In
terms of versatility, the Lee and Hitech
options are better as the B+W is screwed
on and therefore tricky to use with other
filters such as ND grads (which you will
need to stop the sky from overexposing).
All things considered, we'd go for the Lee
Filters Big Stopper.

QI have aninfrared-modified DSLR. Can
you give me a few tips on using it for
black & white landscapes?

A Follow these steps for the best results:

® Shoot in full sun and include foliage or
grass, which really show off the infrared
effect well.

#|nclude plenty of sky and cloud
formations; they look amazing in infrared.
#®\Watch the exposures — you may need to
dial in exposure compensation to get
well-exposed images.

®\When editing images, create a duplicate
layer and add a little diffuse glow to it
(Filters>Distort>Diffuse Glow) to enhance
the infrared effect. Adjust the Opacity
slider until you're happy with the effect.

Hueless app

Whether you use it
purely to shoot b&w or
alongside your DSLR for
quick analysis of what a
scene looks like in b&w,
the Hueless iPhone app
is highly recommended.
It offers live exposure
controls, filters and
modes. Buy it at the
App Store for £1.49.
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@®WEATHERAND LIGHTING
Animmediate benefit of shooting landscapes
to convert to black & white is that the quality
of light becomes far less important than it
does when shooting in colour. You still need
good light to create great black & white
images, but that light may be found in
weather conditions that wouldn't suit colour
photography. For example, on a dull, overcast
day the landscape appears rather flatand
lifeless, colours are muted, and other than
shooting small details, your colour options
are limited. But the quality of light you geton
anovercast day is actually very high. The light
is softand contrast is low, so you don't have to
battle with deep shadows or shimmering
highlights, and it reveals a huge amount of
detail that might be lost with stronger light.
This makes it perfect for black & white
landscapes. The sky may be rather washed
out on overcast days, but you can beef it up
later if you like. In fact, the same applies to the
whole image. Just think of the original Raw
file like a digital negative — it contains all the
information and detail you need, but how you
interpretitis up toyou.

Black & white comes into its own in dark,
stormy weather. You really need the sun to
break through when shooting in colour, to
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Above: With so much dramain the cloud
formations, this shot calls for a black & white
treatment. Note the tonal differences in the
light across the landscape.

Right: A gritty feelis achieved with the use of an
ND grad, making the dark and brooding sky even
more moody. So many different tones mean the
overall effect works brilliantly in monochrome.

light up the landscape so it contrasts with the
sky. With black & white, though, you can
manage well without the sun and just
concentrate on bringing out the brooding
nature of the scene, perhaps using a strong
ND grad filter to intentionally darken the sky
more than it was in reality, or increasing
contrast during post-production. Black &
white landscape photography is about
creating a mood, not recording reality.
Sometimes the light is so monochromatic
that if you shoot in colour the images still
appear to be black & white. When that
happensit's a no-brainer as to what you
should do with the image. In dense fog or
heavy mist, for example, just about every drop
of colour is drained from the landscape.
Shooting into the sun can have the same
effect, especially if there’s water in the scene,
because you end up with silver patches of light
dancing on the water and any solid elements

HELEN DIXON
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in the scene are reduced to black silhouettes.

Of course, don't be misled into thinking that
you need grotty weather to produce good
black & white landscapes — strong, directional
light can work wonders when it comes to
bringing out the texture in a scene. For
example, if you shoot a beach on a dull day it
will appear flat, but when light from a low sun
rakes across the sand, you'll see every ripple.
This is equally important for black & white
photography as colour. In fact, in some ways
texture is even more important in black &
white images because you don't have colour
to fall back on. Therefore, it's still worth
venturing out early in the morning and staying
out late for sundown, so you can take
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Above: Snowy landscapes suit monochrome
photography really well, with stark, bare trees
almost silhouetted against bright white snow
and grey skies.

Lighting app

To find out when the
best natural light s
going to hityour
location, download
aneat little
augmented-reality
smartphone app
called Sun Seeker.

It uses your phone's
cameraand GPS to
show the projected
position of the sunat a
given date and time,
allowing you to return
to the location under optimum lighting
conditions. Sun Seeker is available from
the Apple App Store for £4.99 or the
Google Play store for £3.79.

66 B6W LANDSCAPE
PHOTOGRAPHY ISABOUT
CREATINGAMOOD, NOT
RECORDING REALITY 9

advantage of the low sun raking light and long,
weak shadows. Utilising the light from different
directions can also pay dividends — shoot with
the sun to one side of the camera so shadows
are cast across the scene or keep the sun to
your back so shadows act as lead-in lines that
carry the eye into the scene (taking care not to
include your own shadow). Contre-jour
photography — shooting into the light — also
suits black & white images. Leave the exposure
to your camera and any solid shapes will be
recorded as stark silhouettes. Alternatively,
dialin a couple of stops of exposure
compensation to blow out the background

Pro tip: Lee Frost

‘| love shooting in bad weather, capturing the raw power of the elements. This shot was taken
on Alnmouth Beach, close to my home on the Northumberland coast. Dry sand was being
whipped up by a strong wind and blown towards the sea. As the sun came out it was as
though the surface of the beach was alive — | could feel the sand hitting my legs as | walked. I'd
never tried photographing this phenomenon before, but decided to giveita go. |
experimented with different shutter speeds in an attempt to capture the ghostly effect of the
blowing sand and this one, shot at 1/6sec, proved to be the best. | love the contrast between
the light tone of the sand and the dark, angry sky, which | emphasised using an ND grad and
also by boosting contrast during post-production.”

Focal length: 24mm, tripod, 0.6ND hard grad filter, Exposure: 1/6sec at f/22 (ISO 50).

and create an atmospheric high-key effect.
When the light is colourful, your gut instinct
will be to shoot in colour. At sunrise and
sunset, for example, the warmth in the light
and the vivid colours in the sky are usually
what inspire you to pick up a camera. Butdon't
assume that the same image won't work in
black & white. Remove the colour and see
what you think. Golden light is fantastic, but it
can mask the real beauty of the scene and it’s
easy to get carried away by colour and ignore
the shapes and tones that lie behind it. If you
convert a colourfulimage to black & white,
no one will ever know it was colourful anyway,

but they will see it in a totally different light.

In a sense, there's a pattern emerging here
— namely, when the light's not good for
colour it's perfect for black & white, and vice
versa. For this reason, you don't have to
pigeonhole yourself as one or the other, but
simply be a creative photographer who
embraces both mediums and switches
between the two to make the most of
whatever conditions you encounter. Purists
may argue that by doing so you're
compromised on both counts, but itis
possible to embrace both mediums and
produce fantastic work.
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@®COASTLINES
For drama, beauty and mood, you can'tgo
wrong with shooting the coast in black &
white. It's a scene that constantly changes and
evolves thanks to the ebb and flow of the tide
and the physical effects of the weather — and
it's for that reason that it's earned itself the top
location for many a photographer. On first
encounter, you might not think to shoot the
coastin anything other than colour, but
shooting in black & white achieves an
atmosphere that colour can't rival. And if you
struggle to ‘see’in black & white (ie notice the
different tones in a scene that lend themselves
well to black & white conversion), the coast is
the ideal place to begin your monochrome
adventures. This is mainly because seascapes
are full of tones, contrast, texture and strong
shapes; the ideal ingredients for striking mono
images. Luckily, many of the thought
processes you go through for shooting in
colour also apply to shooting in black & white.
We'll start with finding your viewpoint.

When capturing the drama of a rocky
coastline, find a high view looking down on a
bay orinlet and use rocks or boulders in the

NOXIANITIH

| foreground to add depth and scale to your

compositions. The same rules can be applied
at sea level, too, where rock slabs extend
down to the water's edge and you can use
them to lead the eye into the scene, or fill the
foreground with sea without getting your feet
wet! By shooting in mono and removing the
distraction of colour, all emphasis is placed on
shape and form — meaning how you
compose your image is all-important. You'll
find simplicity is often your best bet.

How the sea records depends on how
rough itis and the shutter speed you use. If
you want to freeze a crashing sea, you'll need
to shoot at 1/1000sec or even 1/2000sec.
This approach works well if you're using a
telezoom lens to fill the frame with pounding
waves, or to capture them exploding against
the shore and sending spray high into the air.
To record motionin the sea, you'llneed a
slow shutter speed — the slower itis, the softer
the sea becomes. Use 1/4sec to one second
to record motion in the waves but still retain
texture, then gradually slow it down. Once
you get to 20 to 30 seconds, waves turn to

| mist and little texture on the surface of the sea
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Above left: Long exposures and ten-stop filters
create shots like this. The seaisreduced toa
misty blur that gives an air of intrigue.

Above: Rocky outcrops are fantastic for adding a
bit of interest. Set a fast shutter to freeze motion
inthe sea; try 1/1000sec to begin with.

Right: Patterns and ripplesin theseaarea
blessing for b&w images. Set a long exposure,
letting everything appear silhouetted.

is recorded. To take this idea to the extreme,
use a ten-stop ND filter so exposures run into
minutes rather than seconds, turning the sea
to milk — or wait until light levels are so low
that you can achieve exposures of several
minutes naturally. Include static elementsin
the scene to contrast with the soft sea —
jetties, rocks, groynes and posts all work well.
Converted to black & white, these
long-exposure images look sublime.

You can use ripples in the sand to lead the
eye, or rock pools reflecting the sky to fill the
foreground. Seaweed, driftwood,
barnacle-encrusted groynes, old lobster pots,
fishing nets, rocks and pebbles found on the
beach can also be used as foreground

Imageideastotry...
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® Receding waves

If you watch waves wash back
down to the sea, they often leave
streaks of bubbling foam that look
amazing in black & white. To
capture this effect, use a
wide-angle lens and a slow
shutter speed — around 1/2sec
should be fine. Time your shot to
catch the waves receding. A
high-contrast b&w conversion
willemphasise the effect.

® Shooting sand
Ripples in sand are best captured
early or late in the day with your
camera when the suniis low, or
when strong sunlight renders
them as silhouettes — use them as
lead-in lines in wide-angle shots
or fill the frame from close range.
Take a closer look in shallow
outflow streams, too, where
grains of sand are separated to
create eye-catching patterns.

.
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@®Rockart

and textures.

Rocks are never far away at the
coast and offer lots of potential.
Pebbles and boulders worn
smooth by the sea are ideal for
pattern shots, while rocks below
the high tide mark are often full of
graceful curves and contours. On
rock slabs, look for pebbles
jammed into cracks and crevices,
or move in close to reveal patterns

1S0O¥4 331
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@ Piers of therealm

Piers make great seaside subjects.
Use them as the focal pointin
wide-angle views, or as the main
element in long-exposure shots
that record motion in the sea and
sky. Standing under a pier and
looking out to sea will reveal the
complex pattern of legs, struts and
braces. Shoot them in silhouette
against the rising or setting sun, or
basking under moonlight.

1S0¥4331
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interest. Set your tripod low to make the most
of these elements, use an ND grad to tone
down the sky and set your lens to f/11 or f/16
so you have enough depth-of-field to
achieve front-to-back sharpness.

Coastal views often need a focal point to
round off the composition. This could be
anything: a castle or headland in the distance;
a person; a boat; a lighthouse or an offshore
island. And ideally place the focal point on the
top right third to help you achieve a more
balanced result for your image.

Afinal point about light and weather: they
have a massive influence on the mood of your
black & white coastalimages. The great thing
about shooting in b&w is that it doesn’t matter
how bad the weather gets, especially if you're
using a ten-stop ND filter. In fact, it's true to
say that the worse the weather is, the better
your monochrome images because you can
never have too much drama when you're
shooting the sea! Dawn is a great time for
atmospheric light. If the tide has been
receding through the night, you'll also have
the advantage of beaches being devoid of
footprints and delicate sand ripples will still be
fresh and wet. Standing water on the sand can
reveal beautiful reflections, too.

‘I love b&w photography. However,
‘seeing’ in b&w comes easier to some
than others and | must admit I'm not a
guy who naturally ‘sees’in mono. But
over time, I've taught myself what to look
for — and the coast is one of the best
places to do so. Simplicity is important.
Removing colour places emphasis on
shape and form, and composition and
light. Often an ‘active’ sky helps — one
with interesting cloud and drama. But
failing that, use bold features and
foreground interest — large, smooth
boulders, piers, lighthouses and
weathered groynes. Weather is key. Bad
weather suits b&w, as it conveys mood
and atmosphere. | also love the effect
created by using extreme ND filters.
Personally, | use a Lee Filters Big Stopper.
With the filter attached, exposures of a
minute or longer are possible, reducing
the sea to an ethereal blur.”

Filter: Lee Filters Big Stopper.
Exposure: 91 seconds at f/11 (ISO 200).

tip: Ross Hoddinott
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@®LANDSCAPES

Landscape photography has always been
perceived as an easy option — head into the
countryside, find an attractive scene, set up
your camera and fire away. Mother Nature's
done all the hard work, all you're doing is
recording it. Right?

If it were that easy we'd all be master
landscape photographers. Clearly there's
much more to it. Composition is the Holy
Grail of photography. A well-composed
landscape shot in average light will always
beat a badly composed landscape takenin
great light, especially when the finalimage is
monochrome. Why? Because without a
strong foundation, creativity crumbles — and
composition is the foundation of every
photograph we take.

Fortunately, composition isn't rocket
science. Common sense, consideration and
concentration, that's the crux of it. Allyou
have to do is decide which bits you want to
capture and how you're going to arrange it all
inyour camera'’s viewfinder.

Although telephoto and telezoom lenses
have their place in landscape photography,
wide-angle lenses win hands down for ‘wow’
factor. They give us a view of the world that
the naked eye simply can't match. They bend,
stretch and distort the truth, and the wider
you go, the better it gets. Slight changes of
viewpoint also make a huge difference to the
impact of elements, while the extensive
depth-of-field you get at small apertures such
as f/16 and /22 also guarantees
front-to-back sharpness in your shot.

Using a wide-angle lens to exploit
foreground interest also helps to make an
image look three-dimensional, because as
well as providing a logical entry point into the

Pro tip: Helen Dixon

“Some of my favourite monochrome
images are so simple; often justa lone
tree and big sky, like this one that |
spotted while driving in the country. |
walked around the field to find the best
view, looking to incorporate the fence to
add interest. The clouds added texture,
form and helped the tonal range. Usually
I'd opt for my wide-angle lens, but as the
field was inaccessible | had to use a
telephoto, which kept the shot
uncluttered. The Raw image was
processed in colour and then | applied a
Black & White adjustment layer in
Photoshop to adjust the tones. Finally,

| used Curves to bring out the contrast
and make it punchier.”

Exposure: 1/20sec at f/13 (ISO 200).

image, it also helps to add a sense of depth
and scale. If that rock filling the foreground
looks bigger than the cottage in the distance,
say, the cottage must be far away, hence
distance and depth are implied and a
three-dimensional feelis achieved.

To make the most of foreground interest,
get close and low. Shooting from eye level is
fine, of course, but when the camerais six
foot off the ground, interesting elements at
your feet lose impact. Kneel down and getin
close, however, and that humble mossy rock
becomes a giant boulder that dominates the
composition and you've bagged a dramatic
shot simply by bending your knees.

Lines are another powerful compositional
device. Paths, tracks, roads, railway lines,
fences, walls and avenues of trees all make
great man-made lines. Rivers and streams are
ideal natural lines. Diagonal lines work best if
they travel from the bottom left of the frame
to top right, because that's the natural way the
eye looks at a photo. Converging lines are
even better. Stand in the middle of a road and
look along it through a wide-angle lens. The

Above: Whenyou're presented with a scene, try
to think what it might be like converted to black
& white — if there are lots of different tones, as
with this shot, it should work particularly well.
Above right: Shadows and highlights are the
making of agood mono image, along with a
cracking composition. This is a perfect example
of how all three combine for a lovely b&w shot.

effect of the parallel sides converging into the
distance is dizzying and arresting. Including
the vanishing point, where those lines appear
to meet on the horizon, brings the
composition to a satisfying conclusion. Lines
don't have to be straight — the meander of a
stream as it travels away from the cameraiis
visually more interesting than a straight line.
Be aware of colours as you're composing
and how they might relate when converted to
grey tones — what looks great in colour may
look flat post-conversion. Conversely, a
scene that looks naff to the naked eye could
make a fantastic monochrome image.
Confidence has a lot to do with success
when it comes to taking cracking black &

| white landscapes. Digital photographers have

Shooting at high ISO

We constantly bang on about keeping your
ISO rating low when shooting landscapes to
minimise noise, but when it comes to black
& white, a bit of noise can be a benefit.
Noise on colourimages tends to look naff,
but once you convert thatimage to black &
white it looks much like film grain, and the
stark, gritty feel can look fantastic. Simple
images suit the treatment — mist and fog,
seascapes, shots taken on overcast days.
You need plain areas of tones to really see
the noise/grain, so avoid shooting cluttered
compositions at high ISO. How high you go
depends on how old your DSLR is. The
latest DSLRs handle noise so well that even
at ISO 3200 you'll get smooth images, and if
you want to really go for it you'll need to
shoot at ISO 6400 or beyond. With older

1S0443 N

models, you may see lots of noise at ISO
1600 or 3200. Just experiment. If you find
the image looks flat in black & white — high
ISO images often do — boost contrast by
adjusting Levels or Curves in Photoshop.

NOXIANIT13IH



LEE FROST

Right: Meandering lead-in lines are brilliant for
providing a fantastic composition, leading the eye
on ajourney through the image and treating the

viewer to a certain amount of intrigue.

Far right: Shooting in black & white requires you to
think differently about your picture-taking. Often
your image will be above you, so look up — here
the clouds form a frame for the church.

amortal fear of black & white because it's
usually an indicator of blocked shadows

and blown highlights. But you need true
blacks and whites in mono images, otherwise
all you're left with are various shades of grey

and that's just boring!

You have to be bold — don't be afraid to
boost contrast, to darken that sky, to make
localised adjustments to contrast and
exposure (just as they did in darkroom days)
by dodging and burning. Remember, you're
no longer dealing with reality, so the rule book

goes out of the window!

15044331
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® My home town
We tend to associate the
countryside with landscape
photography, but the urban
landscape is just as interesting —
and often far more accessible. Set
yourself a project to shoot a series
of black & white images of your
home town — not just big views,
but details that capture its
character. You may discover
places you didn't know existed.
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@ Sky high

When we shoot landscapes, the
sky usually plays second fiddle to
the foreground, butin some
situations the sky will be much
more interesting than the scene
itself. Don't be afraid to tilt your
camera up and make a feature of it
— dramatic cloud formations look
amazing when shot with a
wide-angle lens and very often will
create incredible pictures.
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® Minimalistimages
Black & white is a minimal medium
so use that to your advantage
when selecting scenes. Go for
simple, stark compositions such
as trees against the sky or
reflecting in calm water. The
winter landscape lends itself to
this treatment, especially when
covered in a blanket of snow. Dull
days do, too, as they provide a
plain, featureless backdrop.

1S0¥4 331
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® Moving water

Waterfalls, rivers and streams are a
favourite subject among
landscape photographers and
make great b&w subjects. They're
also best shot in dull weather,
when the light's soft, so if the
weather worsens, find yourself
some moving water. To achieve an
attractive blurry effect, experiment
with shutter speeds from 1/4sec
to several seconds.

15044331
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ConvertaRawfiletomono

Stripping a landscape image of colour can give picturesimpact and
mood. Learn how to create bold mono images from your Raw files

Jordan Butters

The origins of photography are
g rooted in black & white, but

: despite the arrival of colour film,
j;/ and after that the dawn of the

J ‘ digital age, black & white
photography still remains a firm favourite of
many photographers. Back in the days of
film, photographers would have to use
dedicated monochrome film combined
with colour filters to alter the tonal range of
specific colours. Thankfully, when dealing
with digital the process is a lot easier and the
colour filtration can be done at the
post-processing stage. While colour images
can use bold, vibrant hues to attract the
viewer's attention, black & white
photographs rely solely on the core aspects
of photography — composition, exposure,
lighting and perspective. Monochrome
images have an artistic elegance about
them, but not every image suits the

Original Raw

Open up your file First things first, open your

original Raw file in Adobe Camera Raw and
select the HSL/Grayscale tab on the right-hand
side of your screen. Converting your image to
mono is as easy as clicking on the Convert to
Grayscale tick box at the top, but a few more
steps will ensure you get the best possible result.

conversion. It works best with images that
have a good tonal range from dark to light
— images comprising a lot of mid-tones
will end up looking flat and dull when
converted to monochrome. You should
look to include textures, lead-in lines and
interesting shapes in your image. Moody
skies and looming clouds work greatin
black & white, too.

Converting to black & white in Adobe
Camera Raw is ideal as Raw files contain
more information than compressed JPEGs
or TIFFs. However, if you don't have access
to ACR oryourimage is saved as a
compressed file, you can get very similar
results using a Black & White adjustment
layer in Photoshop. While removing colour
is as simple as pressing a button, to get the
best from your black & white images, the
process is more involved. With a bit of time
and effort, however, you can produce truly
stunning monochrome images.

Reset yourimage To get the best out of your

black & white image, some adjustment to the
tones is required. ACR will automatically adjust
some of the settings to tone your image, but we
want to tone it ourselves, so click on the word
Default above the sliders which will reset
everything to zero.

Adjust your colour sliders We'll start by
adjusting the Blues slider, as blue was the
central tone in our image to begin with. Click
and hold on the Blues slider and drag it to the left
to darken the blue tones. Keep an eye on the
histogram at the top of the screen to make
sure no clipping occurs.



Target your adjustments As an alternative to

adjusting the sliders, you can target your
adjustments. Click and hold on the Targeted
Adjustment Tool button at the top and select
Grayscale Mix. Click and hold on any tone in
your image and drag up or down to lighten or

darken that tone and the surrounding tones, too.

Increase Grayscale Mix Some of the warmer

tones now look a bit lost, so increasing the
Grayscale Mix on the channels for Oranges and
Yellows brings out the detail in the rocks and
creates a strong contrast between them and the
sea. This can be done manually or by using the
Targeted Adjustment Tool again.

Finalimage

The strong lighting and
interesting textures make
this image the perfect
candidate for this black

& white Raw conversion.

Adjust Curves Finally, select the Tone Curve

button at the top and choose the Point tab.
Under the Curve tab, select Strong Contrast. If
necessary, you can adjust the curve below by
moving the individual points as required. This
final step just adds extra drama and oomph to
our monochrome image.
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Turning b&w:
apro’s process

Professional photographer
Lee Frostexplains his process
fortaking black & white images
from Photoshop to print

W Theday | captured this picture |
Wi was exploring the
Northumberland coast, looking
for scenes to suit the effect of a
ten-stop ND filter. When | saw this
old fisherman'’s hut, | knew a long exposure
would work well to record motionin the
drifting clouds and swaying grass, while the
hut stayed static in the middle of the frame.

The original Raw image looked pretty dull,
partly because the light was flat and also
because the B+W ten-stop ND filter added a
warm cast and some vignetting. However,
none of this mattered because | knew the
image would be cropped and converted to
black & white later.

Bringing out that drama and impact was
easy. I'm not one for spending ages working
on Raw files and, in this case, | didn't employ
any fancy software either — | only used
Photoshop CS3. First | boosted contrast by
adjusting the Tone Curve: moving the Darks
slider a little to the left and the Lights slider a
little to the right. | then opened the image in
Photoshop and cropped it to square format.
To get a basic monochrome image, | applied
a Black & White adjustment
(Image>Adjustments>Black & White). Then |
used the Polygonal Lasso Tool, with the
Feather set to 100px, to select the sky. To
improve the sky’'simpact, | then added a
Levels adjustment (Image>Adjustments>
Levels), using the Auto button to see if it gave
me the look | wanted. Since it did, | stuck
withit, butifit hadn't, I'd normally cancel the
adjustment and make more controlled

alterations using Levels or Curves. | then
inverted the selection (Select>Inverse), so
everything other than the sky was selected,
and reapplied the Levels Auto command,
which boosted contrast in the shed and
grass. The final stage was to bring out detail
and texture in the shed, so | selected it with
the Polygonal Lasso Tool, the Feather set to
30px, then adjusted Curves
(Image>Adjustments> Curves) to give the
image more ‘'oomph’!

When it comes to printing my black &
white landscapes, | always use the same
paper — Hahnemuhle Photorag 308. It'sa
heavy, flat white fine-art paper with a lovely
dull finish and brilliant archival qualities. | print
with an Epson Stylus Pro 7880 24in printer
using Epson K3 Ultrachrome inks. To print
black & white, | use the Advance B&W setting
on the printer, which uses three black inks to
produce pure mono images. | like to print big
(usually 20x20in on 24in paper) — then | have
the prints mounted in 32x32in window
mounts so there’s a 6in border on all sides
and framed in natural oak frames. The final
framed work is 34x34in, so it makes a big
statement when hanging on the wall - the
best place for black & white landscapes!

Choosing products

You can get fabulous results from at-home
printing by combining the right products.
We recommend trying matt fine-art papers
by Hahnemuhle, Iiford or Permajet, ideally
suitable for black & white images. Also
consider using a large-format Epson,
Canon or HP printer with only a set of black
inks, rather than colour, to optimise details
in the shadows and highlights.

Black & White adjustment layer Selectively adjusting black & white

While some photographers prefer the simplicity of a straightforward
black & white conversion, you can get great results using a Black &
White adjustment layer (Layer>New Adjustment Layer>Black &
White...). Not only does it allow you to use the colour channels to
adjust the tonality of your black & white image, similarly if you are using
colour filters in-camera, any adjustments you make are non-
destructive. At any point you can double-click on the Adjustment
Layer in the Layers palette and re-edit your conversion, if necessary.
It's a very flexible and effective way to edit your b&w images.

Often the monochrome images you get from a basic conversion can
be flat and grey. For this reason, make improving the contrast using an
Adjustment Layer your first priority: you could use Levels, Curves or
Brightness/Contrast for this. If some areas of your image are stillin
need of help, consider being selective with your adjustments. Either
use a selection tool toisolate the target area and apply a Levels
adjustment (like Lee Frost has) or duplicate the image layer (Layer>
Duplicate Layer) and use the Dodge and Burn Tools, set to Midtones
and a low Exposure, to reveal detail in shadows and highlights.
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Get speeifiewith Silver Efex Pro

Looking for a quick and effective way to convert your landscapes to
monochrome? Look no further than Nik Software’s Silver Efex Pro 2

Caroline Wilkinson

If you miss the grain quality you
got from your Kodak T-Max

| P3200, the smooth tones of

| Agfa’s APX Pro 100 or the deep
« XTI blacks and pearly whites from an
[iford XP2 Super 400 roll of film, you'lladore
Nik Software’s Silver Efex Pro 2, part of
Google's Nik Collection. Carefully selecting
film had a great deal to do with the art of
black & white photography, but that
enjoyment doesn't have to end with digital.

While there are a number of ways you can
develop a black & white image in Photoshop
CS, Elements and Lightroom for grand
results, Silver Efex Pro 2 allows you to get
more creative and elaborate with your
effects. Not only can you replicate the look of
your favourite film type with a few clicks, you
can also apply colour filters to adjust tonality
and pick from dozens of classic, vintage and
modern presets for instant results. You can
even make your usual selective adjustments
to contrast, noise and exposure, and then
finish off by picking a vignette, border and
toning style. You can make it as classic or as
creative as you want with very little effort, so
don't worry if you're new to this digital
editing malarkey — this software puts the
enjoyment back into editing.

As a plug-in, Silver Efex Pro 2 works in
conjunction with your main editing suite
and is accessible via its Filters menu. This
means you can continue to edit your image
in Photoshop before and after working on it
in Silver Efex Pro: it's one streamlined
solution. Personally, while you can yield
great results using the techniques we've
already shown you in Photoshop, for me,
nothing compares to the flexibility and ease
of Silver Efex Pro 2. For the time it takes you
to get one creative conversion in

SILVER EFEX PRO"

The World's Leads

ng Black an
for Photashog®, Lig d White Softwars

troom”, and Aperturg®

UPOINT

Photoshop, you could produce a number of
different looks using Silver Efex Pro — one
of which I'll explain to you here.

Before editing this example image with
Nik Software, | cropped the image in
Photoshop. It's good to do this first if you
plan to add a vignette or border to your
finished image to avoid cropping the edge
effects out afterwards. Before | made any
selective adjustments to the image, |
scrolled through the Preset Categories to
see which preset best suited the image.
Some, like Low Key, made the image look
too dark, while others like Pinhole and
Antique Plate Il looked unusual but were too
vintage for what | wanted.

| chose the basic High Contrast preset
then increased the Structure to sharpen and

"As with any creative
profession,
presentation is
everythingin
photography.
Beautifully composed,
technically brilliant
shots can be totally
undermined if poorly
printed or presented.
Naturally, paper
choice isimportant.
There is somuch
choice when
choosing paper, but
[lford’s Galerie Gold Fibre Silk is a favourite
of mine. The paper has great archival
properties and, arguably, is the closest
thing you can get to a darkroom print — it
looks, feels and even smells like traditional
darkroom paper! Cropping is an important
part of the compositional process and a
square format, in particular, really suits
black & white — enhancing its fine-art
look. A small border — in the region of
1-2cm - willalso help complete the look
of your mono masterpiece.”

boost contrast. To add noise for a grainy
high-1SO effect, | set the Grain per pixel
slider to 86. You can see the effect of the
settings on your image almost instantly
in the preview window. To finish off, |
added a grunge frame by selecting Type 8
under Image Borders. As soon as |
pressed OK, the effect was applied and
the image automatically opened in
Photoshop’s main suite as a separate
editable layer within the Layers palette. It
really is as simple as that.

You can try before you buy with the Nik
Software 15-day free trial, downloadable
from the Google Nik Collection website
— visit www.niksoftware.com. You can
also buy the plug-in as part of Google’s
Nik Complete Collection for $149.

Otherideastotry

@ Canvas & acrylics If a framed fine-art
printis a little too traditional for you, think
about getting a stretched canvas print or
your image printed on acrylic glass, or
even aluminium, for a more contemporary
style. Consider brands like White Wall,
Jessops, Point101 and Lucy Art.

@ Professional printers If investing in a
quality printer and inks is more money than
you're willing to spend for the occasional
b&w image, consider hiring a printing
company to do it for you. Theprintspace,
for instance, offers fine-art Giclees and
silver-based C-type prints that are sure to
bring out the best of your image for a
reasonable price. Look for companies that
offer archival-quality products to avoid the
colour fading over time.

@®Web If you want to add your image to
your online portfolio for a wider audience
to see, make sure you change the
Resolution (Image>Image Size) to 72,
resize your image and apply a little
sharpening before uploading to your site.
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“"Thereis something magical abeut falls — especially e

our cameras have the ability tomake them look even more_ :-"

beautiful. Our step-by-step guide showﬁ@ howtd'shoot them =
: . ; v i A > e
Ross Hoddinott photogeniejbmvﬁlatep‘am ~ e A g B
Camera: Nikon DSOOE UK — particularly Scotlafid, mid-Walés and £ oot o :
—~ the North of England — are Home to some,, : - s o A -3 - '
Lens: Nikon AF-S 24-70mm f/2.8G ED B | stunningly beautiful rapids and falls. The bigs o & > . 3 \
: WHY IS IT we find waterso questioniis, though, how do you capture T e P : - . 8
irresistible and mesmerising? | great waterfall photographs? S AT e AL ’ﬁ
I'll leave it to the more : _ Having located a suitable fall — mayb?" ( )ﬁ‘ﬂi Lt ""Q: .
\ - intellectual types to debate somewhere close to where you live or are ' Z o B Ry
e what it is that connects us so holidaying — consider the weather. Bright,
closely to water. All | know is that, like sunny days are best avoided, as strong,, ~ «
many photographers, whenever I'm faced directional light will create a high level €
with them, | just cant resist the urge to of contrast, makingit difficult to avoid =
photograph large bodies of reflective burnt-out highlights on the water.
water, crashing waves and meandering Bright, overcast days are better, as
rivers. Arguably, waterfalls are the most cloud cover acts as one giant diffuser.
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Also, itis often worthwhile visiting after
rainfall, as this will ensure water levels are
good and that there is a nice amount of
movement and interest. The time of year
can also be a big influence in your shots.
Many of the best waterfalls are found within
woodland, so in autumn, surrounding
seasonal colour can add extra interest to
your shots, while in spring, fresh foliage will
add vibrancy and a stark winter woodland
will be full of mood. At these times of year,
footpaths can be muddy, so wear your
wellies — they'll also allow you to wade into
the water slightly, giving you the opportunity
to capture more interesting viewpoints.

As always, kit choice is an important
consideration. A relatively wide focal length
—inthe region of 24-70mm - isa good
choice, as it gives you the option to capture
dynamic-looking compositions. A medium
telephoto can also be useful should you wish
to isolate your waterfall or for when you have
to shoot from further away. A tripod is a must
— particularly if you intend to employ slow
shutter speeds. A polariser and an ND filter
may also come in handy. Keep a lens cloth
close to hand as well; this will be invaluable

movement, with the

- et ]
Choose your location After a little online research, | decide to visit
Sgwd Ddwli Uchaf — one of Wales most impressive falls. | opt for

the versatility of my 24-70mm zoom and, using the long end, fill the

frame with the falls. However, by composing my shot so tightly, the

photograph lacks context and looks static and boring.

N

—_— = —— - N
Lengthen exposure As the water didn't look right frozen, | decide
to blur itinstead. | lower the ISO to 100 and set a smaller f/stop

of f/16 — this helps lengthen exposure time, and increases depth-

of-field too. The resulting one-second exposure creates a nice level
of subject blur — my tripod is essential to keep my image shake-free.

to quickly wipe away any water splashing up
onto your lens or camera.

The biggest decision you face when
photographing waterfalls is how you are
going to capture its motion — do you
freeze the water or blur it? This is a very
subjective thing. However, whatever
you decide, you must ensure it
looks intentional — if the water
isn't sharp or blurred enough,
it will just look messy and
as though you haven't
achieved what you set out
to do. Most photographers
favour blurring the water's

effect generally considered
more aesthetically pleasing.
Blurring motion s relatively
easy to do — simply employ
a slow shutter speed of 1/2sec or
longer. If you would prefer to freeze motion,
you will need a shutter speed exceeding
1/500sec. However, achieving such a fast
shutter speed is often difficult when you are
shooting in overcast light, unless you select
avery high ISO speed, together with a large
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aperture. Ideally, you don't want to do either
of these things, though, as a high ISO rating
will increase noise while a large aperture will
reduce depth-of-field. Therefore, unless
you really detest the milky-water effect,
your best bet is to blur the water’'s motion.
Lastly you need to consider
context and viewpoint.
Waterfalls can be
photographed in various
ways and from a multitude
of angles. Tightly cropped
shots can look very
effective, but usually wider
views — capturing the
waterfall in context with its
surroundings — will create
a far more striking image.
Whenever possible, try using
the water flowing away from
the fall as foreground interest or a
lead-in line. Using moss-covered boulders
or fallen leaves trapped by the water's edge
canalso help to give your waterfallimages
more interest, depth and colour. You'll find
a low viewpoint will often work well, but be
careful not to get wet feet!

HANDY HINT

Be careful!

Take care when shooting
photos by the water’s edge.
Rocks will be slippery and it is
easy to lose your balance
when you are carrying a heavy
backpack and tripod. Always
put your welfare — and that of
your valuable kit — above
taking photos.

Freeze the motion | zoom out to include more of the waterfall's

environment. | want to see what the water looks like if | freeze
its motion. To generate a shutter speed fast enough to do this, | raise
the ISO to 6400 and select a large aperture of f/5.6. This results in a
shutter speed of 1/500sec. However, the water looks messy.

Use a polariser | review my last image — the shot lacks colour

saturation. There is a lot of glare reflecting from parts of the
foliage and the river. Therefore, | attach a polariser and rotate the
filter in its mount until the reflections and glare disappear. The filter
absorbs up to two stops of light, so it blurs movement even further.



# # Finali lmage

I swﬂch to a vertical composition to.

## Mmake more of the foreground and create »
7 a stronger more balanced result. lalso *
5 attgch athrees=stop ND ﬂlter to lengthen

the exposure to, 20 seconds. The result is.*

"~ anethereal-looking w aterfall image.

° Exposure: 20 seconds atf/16 (1SO100)
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Shoot a misty morning seene

Ross Hoddinott reveals how early morning mist provides a wonderful
opportunity for you to shoot ethereal, magical scenes

Ross Hoddinott

=Y Misty mornings are one of the key
traits of spring. Mist can look
magical, filling valleys and hanging
- atmospherically above fields. By

. 8 reducing colour and contrast, mist
simplifies the look of objects, placing more
emphasis on shape instead. There are
different types of mist and fog, but the most
photogenic is ‘radiation fog’, which forms
during clear, still nights when the ground
loses heat by radiation and cools.

The ground chills nearby air to saturation
point and mist forms. It often stays confined
to low ground, forming a thin white layer at
the bottom of valleys. When looking at the
local weather forecast, watch for clear skies
and cool, still nights — perfect conditions for
mist. Also, look at the forecast for clarity. If
clarity is predicted to drop to average or poor
during the night, then there is a good chance
you will be greeted with mist in the morning.
Set your alarm early. Allow enough time to
get to your intended viewpoint before
sunrise, so that you can get set up and ready
in advance of the best conditions. If you are
driving, remember your journey will be

“’“"“'

2100 “B 4°C ENE 8 mph Very Good
0000 D 3°C ENE 7 mph Good
0300 2°C B 6 mph Very Poor
0600 FOG 2°C| ENE & mph Very Poor
0900 oz ] 4°C ENE | 4 mph Good
1200 <5 7°C| NE | 7mph very Good
1500 e 7eC| NE 8 mph Good

Planning | check the local weather forecast

daily and notice that a clear, still night is
predicted. Clarity also dropped during the night,
so | am optimistic that it will be misty in the
morning. | prepare my camera outfit, then set
my alarm for just before sunrise.

slower due to the conditions.

Ahigh viewpoint, from the top of a hillor
valley, is often best; allowing you to get above
the mist to shoot atmospheric vistas.

Often, objects are reduced to nothing
more than a simple silhouette in misty
weather. Therefore, look for strong, bold
objects to photograph within the landscape
— achurch steeple, castle ruin or tree, for
example. Longer focal lengths suit misty
scenes the most, foreshortening perspective
and allowing photographers to isolate points
of interest. Light scatters and is more diffused
in mist, adding to its mystical effect — often
the most dramatic results come from
shooting into the light. A medium telephoto
lens, in the region of 100mm, is often ideal.
Mist — like snow — has a habit of fooling a
camera's metering system. This is because it
is designed to assume that the subject is
mid-tone (18% grey). Subjects that are
significantly lighter or darker than mid-tone,
like a misty landscape, can be exposed
incorrectly. TTL metering has a tendency to
underexpose mist, rendering it too dark.
Consult the camera'’s histogram screen
regularly when shooting mist. If the graph is

Viewpoint Sure enough, the landscape is

shrouded in morning mist. | drive to a high
viewpoint, which offers good views over the
misty landscape and set up my kit. A telephoto is
a good lens choice for mist as it compresses
perspective, exaggerating the effect.

Weather sites & apps

Outdoor photographers
rely heavily on local
weather forecasts,
especially when waiting
for ideal conditions leading
to mist. While long-term
forecasts aren't always
reliable, 24- and 48-hour
forecasts are often
accurate. Therefore, keep
aregular eye on them.
Mobile phone apps are an
ideal source of information .
but you should also use websites such
as www.metoffice.gov.uk

biased to the left, this is an indication of
underexposure. Apply positive (+) exposure
compensation to make the image brighter,
and then reshoot. You may only need to
apply a +1/3 or +1/2 of compensation, but in
extreme instances, you might have to dialina
stop or more of compensation. Again, use
the histogram as your guide.

Having dragged yourself out of bed early
to shoot the morning mist, don't overlook
the picture potential of smaller, less obvious
subjects — for example, dew-laden cobwebs
glistening in the morning light.

Metering Mist helps to simplify the look of
the landscape, giving it a ‘layered’ effect.
| compose my shot, and release the shutter, but
the result is too dark. By looking at the
histogram, | can tell the exposure is biased to the
left, confirming the image is underexposed.

Exposure override The brightness of

mist can fool metering systems designed
to assume scenes are mid-tone. Using the
camera’s exposure compensation button, |
dialin one stop of positive (+) compensation
to lengthen the exposure time. The result is
far better, but the scene lacks a focal point.

Composition | scan the landscape for a

key point of interest to give my shot more
purpose and notice a church tower sticking
out above the mist. | recompose the picture
to make this my main point of interest and
also try a vertical composition. The resultis a
great springtime misty image.




Finalimage
| try various compositions
but this is my favourite. The
short telephoto setting
creates an atmospheric,
layered landscape image.

TOPTIP

If tiny water droplets are
condensing out of the air,
then they are also likely to

condense on the surface of

your lens and filters. Keep
an eye out for moisture on
optics and wipe away
with a clean microfibre
lens cloth
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Shootascene atdawn

Ross Hoddinott says you can't beat a sunrise for adding extraordinary colour to your landscapes...

Ross Hoddinott

THE NIKON GUIDE TO LANDSCAPE PHOTOGRAPHY

& THE PHOTOCGRAPHER'S EPFHEMERIS

Camera: Nikon D700 g

Lens: NIKKOR AF-S 17-35 mm f/2.8D IF-ED

AS ATEENAGER, | never thought | would
say this, but... dawn is the best time of the
4 day. The lightis pure, skies are beautifuland
‘:“,’ you often have the world to yourself. | love
3 ﬁ‘- my bed, but once up, the excitement of
what you might photograph is unrivalled.

The best dawn shots are rarely the result of chance,
so plan ahead. Calculate the time and direction of
sunrise for the time of year, and select your location
accordingly. The weather forecast is also important:
if you're hoping for light and colour, but blanket cloud
is forecast, you'll be disappointed. Colour can begin
forming in the sky up to an hour before sunrise, so
arrive in plenty of time. Check your kit bag the night
before, ensuring everything s in the right place and
batteries are fully charged. Pack a torch, too. Finally,
start shooting straight away, even in extremely low
light; exposure times will be long, but this can
generate interesting cloud or water movement.

Overexposed sky With colour already beginning to form,

| compose my shot. To guarantee front-to-back sharpness,
| selected a small aperture of f/16 and focused on the hyperfocal
distance. In the low light, a tripod is essential to ensure sharp results.
Using multi-zone metering, | took my first frame. The foreground is

correctly exposed, but the brighter sky is blown out.

Predawn glow Predawn light is soft and shadowless, which

contrasts well with a colourful sky. Opt for a viewpoint facing
east for the best colours. Around 20 minutes before sunrise, the
colours are at their best. Water scenes work well, reflecting the sky's
colour and light. With the sky's intensity changing quickly, the look
and feel of your images can change from one frame to the next.

-

Be prepared Plan your shoot carefully

to maximise your chances of
success. Study the sun's position as this
will dictate suitable dawn viewpoints.
You should also know the time of
sunrise and tide times if you're heading
to the coast. Check the weather
forecast beforehand, too. A number
of good websites and phone apps can
help (one of the best is
www.photoephemeris.com).

Travel Having chosen a location,

plan to be ready to shoot at least 30
minutes before sunrise. Allow time for
driving, walking to your viewpoint and
setting up. The best dawn colours and
glow often appear long in advance of
sunrise itself. Alow too much time,
rather than too little; you dont want to
be driving to your location as colour
begins appearing in the sky as you've
probably missed half your shoot.

Graduated ND At dawn, there is usually a large contrast in light

between the sky and land. To produce correctly exposed results
in-camera, you could take two frames — one exposed for the land
and one for the sky — and blend them during post-processing, or
attach an ND grad filter. | aligned the filter, using a three-stop grad

to lower contrast to within the camera'’s dynamic range.

Sunrise Just minutes later, the sky's intensity grows too strong to

control as the sun appears above the horizon. The best of the
colour has gone and the highlights are burnt out. However, due to
the sun'’s low position, the light is warm and good, so don't pack up
and go home just yet; instead find a different viewpoint — pointing
farther away from the sun’s position — and keep shooting.



Exposure: 1/4sec at f/16 (ISO 200)
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Capturethebestfromacoastal sunsetscene

For beauty, nothing beats a sunset over the sea. Ross Hoddinott shows you how to make the most of it

Ross Hoddinott

B There aren't many photographers
’ who can resist a good sunset.

==10 Fairly ordinary scenes can be

t‘"" transformed by the extraordinary

M 8 colourand glow, and one of the
best places to be at that time is by the sea.
Water reflects light and the sky's warmth,
while the movement of incoming waves adds
motion and interest to wide-angle shots.

Shooting coastal sunsets is far from easy. In
reality, most sunsets are hugely disappointing,
barely materialising at all. Perfect conditions
are those that don't have too much or too
little cloud in the sky — just enough to radiate
the sunset’s warmth, but not so much that it
obscures the sun. Predicting themis almost
impossible, too. Great colour can be brief and
unexpected. In practice, the only way to
guarantee good sunsetimages is to head out
with your camera at every opportunity —
sooner or later, your persistence will be
rewarded with an amazing sky to photograph.

Winter is a great time of year to try out this
technique. Sunset s early, meaning you don't
have to be out late, and beaches are quieter,
resulting in fewer footprints in the sand. If you
are visiting a location for the first time, arrive
two hours before sunset to allow time to
explore and identify suitable compositions.
Look for viewpoints where you will not only
be able to shoot in the sunset’s direction, but
also include interesting foreground — rocky
outcrops, sand patterns, a weathered groyne
or reflective pool, for example. Also check the
tide time — not only is thisimportant from a
safety aspect, but the tide's height greatly
dictates where you can shoot from.

Interms of kit, a tripod is essential, as are ND
grads — unless you prefer exposure blending.
When there is great colour, you normally want
to go wide and include lots of sky, so a short
focal lengthin the region of 17-35mmiis a
good lens choice. In terms of set-up,
aperture-priority mode is best for scenics,
giving you full control over depth-of-field,
and selecting an aperture of f/11to f/16
provides good front-to-back sharpness. So
with your camera bag all packed, it's time to
head to the coast, with fingers tightly crossed
fora cracking sunset...

Use an ND grad filter Even when the sunis

low and its intensity reduced, the sky will still
be considerably brighter than the foreground. As
aresult, your camera will either correctly meter
for the sky, resulting in foreground that is too
dark, or it will meter for the foreground, resulting
in an overexposed sky. Unless you fancy
Photoshop work afterwards, the only in-camera
solution is using graduated ND filters. One with a
two- or three-stop density is most useful.

b TR A i

Do your research Before you visit, check tide

times for the area (www.tidetimes.org.uk) and
also plot the sun'’s position using a sun/moon
calculator like The Photographer’s Ephemeris.
Check the time of sunset and arrive at least an
hour beforehand to locate the best viewpoints.
If you have a smartphone, | recommend
downloading the Sun Scout app to plot where
the sun will set once on location, enabling you to
select your viewpoint accordingly.

Align your filter In this instance, | use a

three-stop ND hard grad filter, attaching it to
my camera via a Lee Filters filter holder. An ND
grad with a hard transition is often best for
coastal sunsets, as the horizon is usually fairly
even. When using ND grad filters, carefully align
the transitional zone with the horizon for
seamless results. The image here is much
improved, but looks on the cool side, rather than
showing off the warmth of the sunset.

Scout the area Look for a good viewpoint

where you can shoot towards the setting
sun. Rocks, sand patterns and pools are great
compositional aids for coastal sunsets. Unless
diffused by cloud, the sun’s intensity is normally
too great to take photos long before the sun
disappears below the horizon. Therefore, you
need to be patient. If you try to take pictures too
soon, your images will suffer from flare and
skies will be overexposed and blown out.

—

Adjust the White Balance When shooting

sunsets, don't overlook the usefulness of
White Balance. Although your camera’s Auto
White Balance usually does a great job, it can
be worth switching to the Cloudy or Shade
preset to give sunsets a boost — particularly if
capturing JPEGs. Doing so will warm up and
enhance your sunsets. If you are shooting in
Raw, you can always adjust colour temperature
during post-processing.



Final image

Don't pack up and head home too soon,
the best colour and conditions often
don’t appear until after sunset. Beautiful
shades of red, orange and pink can form
in the sky and you don't want to be
walking back to the car if this happens.
Exposure times naturally grow longer in
the low light, so a tripod is essential.
Shutter speeds exceeding ten seconds
are not uncommon, rendering water
movement as an ethereal blur.
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Exploit the beauty of bluebells

Plan to take a day off in spring and head to a bluebell wood to try out
one of several creative techniques to capture striking images

Ross Hoddinott

@ The UKisthe best placeinthe
world to photograph common
bluebells - itis estimated that
around 70% of their entire

% populationis found here. So,

whereveryou live in the UK, you will not be
far from a bluebell wood. They flower
between mid-Apriland the end of May, but
the time when they are at their peak can vary
slightly from year to year. Typically, they are
most photogenic at the start of May, but itis
worthwhile making an early visit just to
assess what stage they are at — doing so
ensures you time your visit correctly and
don't miss them at their best.

Weather and timing are key
considerations. There is no bad weather for
photographing bluebells, but a bright
overcast day can oftenyield superb results.
As the lightis low in contrast, it makes it easier
to achieve the correct exposure. The quality
of light is soft and muted, and the colours of
woodland flowers and fresh green foliage
look naturally more saturated. Early morning
and late evening can produce magical light
for woodland photography, too. The light is
warmer and the long shadows add depth to
your shots. In bright overhead sunshine, the
sun-dappled woodland floor can look
attractive to the eye, but the level of contrast
can often exceed the capabilities of your
sensor's dynamic range. With so much
contrast, achieving a good exposure can be
difficult, if notimpossible — so itis often
better to avoid shooting in midday sun. Itis
also agood idea to visit on a still day, when
bluebells remain still during exposure.

Identifying 'the shot'in woodland with
large swathes of bluebells can prove tricky as

@®STEP-BY-STEP TO BLUEBELL MAGIC
Bluebells are unquestionably beautiful, but
thatis not to say they are easy to
photograph. Being such a popular,
well-photographed subject makes it even
harder to produce original, creative images.
Ross Hoddinott provides inspiration by
visiting his local woodland in order to see
what variety of bluebell picture he could
shoot. His expert advice will help you know
what to look for, techniques to try, and what
to avoid when shooting bluebells.

Avoid clutter and distraction When | took

this image, | was seduced by the vibrancy and
colour of the bluebells and overlooked the fallen
branches and cluttered woodland floor. Keep
compositions clean and simple.

your choice of composition is almost limitless.
To ensure you take greatimages, a creative
eye s vital. Keep composition simple. Avoid
clutter, like fallen branches, and look for
interesting woodland detail that you can make
a feature of, like a mossy stump or large ferns.
Narrow paths winding into the distance can
be used to draw the viewer's eye into shot.
Lens choice isimportant so take a range of
focal lengths with you. Wide-angles are great
for capturing vast carpets of flowers, but often
amid-telephoto — in the region of 50-100mm
— is best suited to photographing bluebells. A
short telephoto will shorten perspective,
creating the impression that the carpet of
flowersis denser thanitis. This type of focal
length is also good if you wish to focus
attention on a particularly photogenic group
of trees. Amacro lens, or the longend of a
telezoom, is ideal to isolate individual flowers.
In overcast light, achieving the right
exposure is relatively straightforward. Your
camera’s multi-zone meter shouldn't have
any problems. In early morning or late evening
light, it is often preferable to shoot in the
direction of the sun, so that it ‘bleeds’ through
foliage. However, when shooting towards the
light, metering can be deceived and results
underexposed. Keep an eye on the histogram
and apply exposure compensation if required.
Shutter speeds are often slow in the shade
of woodland, so a tripod is essential. For
sweeping, wide-angled images of woodland
interiors, opt for a small aperture, like f/13. This
creates a large depth-of-field which will
render everything in focus. However, a
shallow depth-of-field will suit some scenes
better. For example, isolate a single plantand
select a wide aperture like f/4 or f/5.6 to render
background flowers as an attractive blue haze.

Look for compositional aids A winding path

or mossy stump can make for a strong
lead-in line. This will give your images a
three-dimensional feel. Without this, images
may sometimes lack depth and interest.

Search online for woods in your area.
Below are a few, just to get you started.
® Micheldever Wood, nr Winchester
OS Grid Reference: SU530363

Visit: www.forestry.gov.uk

®West Woods, nr Marlborough

OS Grid Reference: SU163667

Visit: www.forestry.gov.uk

®Yoxall Lodge, nr Burton upon Trent
OS Grid Reference: SK1521

Visit: www.bluebellwoodsofyoxall.co.uk
For furtherinformation on bluebell
woods, visit: www.woodlandtrust.org.uk

Otherwoodland flowers

®Wood anemone:
Widespread and locally
common woodland

’ ‘4 perennial, often growing
; in large clumps. Its white
flowers are beautiful and

delicate. Best shot individually in
close-up or in context with its woodland
surroundings using a wide-angle.

@®Ramsons: Often
growing among or near
bluebells. They smell
strongly of garlicand can
grow in vast numbers in

s, damp woodland. Very
attractive backlit or in frame-filling close-
up. Attach a polarising filter to saturate
the colour of the leaves.

onwards. Using a macro

®Herb Robert: Common
and widespread, its
1 photogenic pink flowers
’\ appear from April

lens or close-up filter will
reveal its delicate beauty. A smallsilver/
white reflector bounces natural light and
relieves harsh shadows.

Experiment with depth-of-field Shallow

focus can work well when photographing
woodland subjects. Select a wide aperture to
diffuse background detail. This will place
emphasis on your point of focus.
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TOPTIP
Always place the welfare
of your subject first. Keep to
paths and never tread or
trample on flowers for the sake
of a better composition. Don't
pick flowers either.
Photographers are getting a bad
press for their disregard to wild
flowers — don't add weight
to the argument

l.
:
Rix
|
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Be creative Set a shutter speed of one Try azoom burst This is another easy, Use a polarising filter A polariser will reduce
second and move the camera up and down creative technique. Compose your shot using the glare and reflections from foliage and
during the exposure to artistically blur the trees. either the zoom's shortest or longest end. Then, flowers. The filter helps restore natural colour
Itis a hit-and-miss technique and may take during exposure, smoothly adjust the zoom ring saturation and gives woodland images added
many attempts to get a result that you like. to the opposite end of the lens’s range. impact. Note it will lengthen your exposure.
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Blurring motionin water

Professional photographer Ross Hoddinott demonstrates how to
render moving water as atmospheric, ethereal mist for creative effect

Ross Hoddinott

Blurry water — you either love it
or loathe it. | love it. To render
moving water milky, the right
exposure time is essential; too

* fast and the water can look
messy. A good rule of thumbis to selecta
shutter speed of around one second or
longer. This should create an attractive
level of blur. Lengthier exposures create
even more atmospheric results.

To generate the longest exposure time
for the available light, select your DSLR's
lowest ISO together with the lens's
smallest aperture (eg f/22 or f/32). In low
light, achieving a lengthy exposure is
relatively easy, with exposure times
naturally longer. But when the light is
good, itis not often possible to select a
shutter speed sufficiently slow without
overexposing the image. The solution is to
use an ND filter. The stronger the density
of the ND filter, the more light it absorbs,
the longer the exposure and the greater
the level of blur. For extreme effects, a Lee
Filters Big Stopper (ten stops) can
generate exposure times of several
minutes, requiring the use of your
camera’s Bulb setting and a remote
release. When shooting water movement
using long exposures, every image will be
different. Take a sequence of images and

Compose your shot It is evening and the tide

is high. To blur the water as it washes over the

rocky outcrops and pebbly shore, | carefully
arrange my composition, using a tripod to keep
my images shake-free. With the camera set to
program mode it automatically sets a shutter
speed of 1/80sec at f/8 based on the available
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Select mode To blur the water movement,

take control from the camera by selecting
either shutter-priority mode and the slowest
shutter speed available, or aperture-priority mode
and opt for the smallest aperture. Either method
sets the longest exposure obtainable in the given
light. Also, select your camera’s lowest ISO rating;

decide later which one is best. light — not slow enough to blur water. typically ISO 100 on the majority of DSLRs.

Add an ND filter For the blur | want, | have to

add an ND filter. | leave the polariser in place
and attach a three-stop ND filter. The camera’s
TTL metering automatically adjusts for the filter,
but it also darkens the viewfinder so you will
need to compose and lock the focus for the
shot before attaching the filter to your DSLR.

Lengthen the exposure Having selected ISO

100 and aperture-priority mode, | set the
minimum aperture of f/22 and wait for a large
wave to wash around the foreground rocks. The
exposure of 1/8sec at f/22 is longer, but as the
water still isn't rendering milky, | add a polarising
filter to help lengthen the exposure.

Use a polariser A polariser has a filter factor of

two stops, so can be used as a makeshift ND
filter by extending the exposure — ideal if you
don'town an ND. It also helps remove glare, in
this case from the rocks. The result is better, butin
this instance, the exposure of 1/2sec at f/22 is still
not long enough for the ethereal result | am after.



y

TOPTIP

Using long exposures to
blur water motion is a
technique that relieson a
sturdy tripod, otherwise
camera shake will ruin
the results. Quite simply,
a tripod is essential, not
optional

@ Final image
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Shoot ssilhoucttcs

Backlight your subjects to create stunning
silhouetted images — this guide shows you how

Ross Hoddinott
As photographers, we are always striving for the
‘correct’ exposure, aren’'t we? However, it could be
argued that there is no such thing, as it greatly depends
™ on the subject, the situation and the effect the

W photographer wants to achieve. For example, a
silhouette can create a truly eye-catching image even though,
technically speaking, itis the result of a poor exposure.

Asilhouette is when the subject is recorded as a black outline,
without colour or detail, against a lighter background — in other
words, the subject s grossly underexposed. It is the most extreme
form of backlighting but, when combined with the right scene or
subject, the results can be stunning — particularly when the subject is
contrasted against an interesting or colourful sky. Despite the lack of
detail and colour, silhouettes can convey much about the subject and
they prove that there really is no such thing as a ‘correct exposure'.

One of the great things about shooting silhouettes is that they are
easily achieved and you need very little in terms of kit to get a good
result. | visited Dartmoor’s windswept landscape to show you how
to shoot perfect silhouettes...

-
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Get your tripod low When shooting silhouettes, a low viewpoint often

works best — helping you to set your subject starkly against a bright sky.
Therefore, don't be afraid to get your knees damp and dirty to select a low
angle. In this instance, | splay the legs on my tripod wide open, enabling
me to shoot from a low perspective.

Crop into your subject Trees create a graphic, simple outline — perfect

for silhouettes. Itis easiest to take silhouettes in mornings and evenings,
when the sun is lower in the sky, so having arrived early, | spot these two
trees that | think will work well. Using the long end of a standard zoom, |
crop in tightly to them, but the camera’s multi-zone meter attempts to
record them as a mid-tone, resulting in a disappointing, washed-out shot.
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Your camera’s Matrix
multi-zone meter is designed
to render the subjectasa
mid-tone. While this is perfect
for the vast majority of
situations, it will rarely
produce the results you are
looking for when shooting
subjects that are considerably
lighter or darker in tone. A
silhouetted subject can
create problems for metering
systems. Although highly
sophisticated, the camera’s
exposure system cannot
predict the effect you are
trying to achieve. Therefore, if
the scene is dominated by a
black silhouetted subject, the
camera will attempt to render
itas a mid-tone by selecting a
longer exposure — resulting in
overexposure. Alternatively, if
the scene is dominated by sky
and is very light, the camera is
likely to underexpose the
frame. Thankfully, avoiding
this type of exposure problem
is simple by switching to your ——
camera’s spot-metering

mode. This metering mode is

selected eitherviaa

dedicated button or through

the camera’s menu system.

It calculates the overall

exposure from justa small

portion of the frame — usually

acentral circle. Point the
spot-metering circle ata
bright area of the frame and
press the shutter release
button halfway to take a
reading. These are the
exposure settings you want
to employ to take your
silhouette. Pressing the
auto-exposure lock (AE-L)
button, ‘lock’ the settings,
compose yourimage and
release the shutter. The
result should be that your
subject becomes
underexposed and appears
as a pure black silhouette.

TOPTIP

In silhouettes, we strive
for the main subject to be
devoid of detail or colour;

so select subjects with a
strong, recognisable
outline. People, buildings,
animals and trees make
good choices

Use spot metering To ensure that the lovely colours of the sunrise are

recorded faithfully, and that the trees are thrown into pure silhouette,
| switch the camera’s metering mode to spot (this is oftenillustrated by a
dot, as seen in the picture above). If you are unsure how to select spot
metering, check your camera’s instruction manual. If your camera lacks a
spot mode, use partial metering instead.
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Lock your settings | remove the camera from the tripod via the
quick-release plate, and point the spot-metering circle at a bright area of
the sky. | press the shutter release button halfway to take my meter reading,
and then lock these settings by using the auto-exposure lock (AE-L) button.
| replace the camera on the tripod and check that the composition hasn't
changed. Then, using the new locked settings, | take another picture.
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Finalimage

By zooming in a little from the last frame, | feel
that I've struck the right balance in terms of
composition. Placing the trees right-of-
centre creates a stronger image than it would
have if they had been central. Spot-metering
has enabled me to capture the right exposure
in-camera — all | had to do post-capture was
intensify the sky’s colour very slightly by
clicking Image>Adjustments>Hue/Saturation
and adjusting the saturation slider to +10.

s

Review composition Although the exposure is now correct, | am feeling

less happy with the composition. It looks a little cramped and | wonder
whether I've cropped in too close. The joy of using a zoom lens is being able
to quickly change composition without having to move. | zoom out to leave
more space around the trees, allowing me to capture more of the sunrise.
However, have | now gone too far towards the opposite extreme?
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Create abstractimages

Ross Hoddinott reveals how intentional camera movement canyield
amazing results if you learn how to get the technique right

Ross Hoddinott
Camera: Nikon D800
Lens: NIKKOR AF-S 70-200mm /2.8

1 HOW OFTEN DO you hear of the
importance of image sharpness,
or that you should always use a
sturdy tripod, remote release and

“% mirror lock-up when shooting
landscapes? Well, there are always
exceptions to every rule, and when capturing
images using a technique called ‘intentional
camera movement’ — or ICM — the rulebook
gets thrown firmly out the window.

ICMis a Marmite technique — you either
love it or hate it. As the name suggests, the
idea is to move the camera during the
exposure to creatively blur a static subject.
This might sound like a recipe for disaster,
butit’s actually easy to achieve very artistic
results with a little trial and error. Images can
look painterly and convey a sense of mood
or movement. Any focal length can work,
but, generally speaking, a standard to
medium telephoto length is the best option
— inthe region of 50mm to 135mm.

In order to capture ICM images, a slowish
shutter speed is required — aim to use
speeds around 1/4sec to one second.
However, you could opt for a longer or
shorter length depending on how fast you
move the camera and the effect you desire.
There are a couple of different ways to
generate a speed of this length. You could
select a combination of low ISO rating and
small aperture of f/22 or f/32 — you don't
need to worry about diffraction as results
won't be sharp anyway. Alternatively, you
could just shoot in low or overcast light. If
you still struggle to achieve a slow enough
shutter speed, try filtration — a three- or
four-stop solid ND filter should do the job
nicely, while a polarising filter will absorb
two stops of light, so can also be used to
artificially lengthen exposure. A polariser
also has the added advantage of boosting
colour saturation and reducing glare.

Originalscene
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All types of subjects suit ICM, but woodland
and beach scenes are particularly popular
and well-suited to the technique. Opt for
subjects that have strong shapes, which will
remain recognisable even when creatively
blurred. Also, areas of strong colour, lines and
contrast suit ICM well. What you need to
remember is that the finalimage will not
closely resemble the subject itself, but instead
will be an abstract representation of it.

So with your subject and exposure sorted,
now comes the fun part. Trigger the shutter
and move the camera during exposure. You
can do this handheld or with a tripod, using a
panning action to blur your subject. For
smooth results, begin moving the camera
before opening the shutter and continue
panning until it closes. Often movement
only needs to be relatively small — too much
and your shot will be one big blur and your
subject’s definition will be lost.

Different types of motion yield varying
results. Vertical and horizontal movement is
most popular, but moving the camera back
and forth, diagonal panning and rotation can
also create striking ICM images. Moving the
camera parallel to lines and edges that
already exist in your composition will
emphasise them — for example, vertical
panning typically suits tall trunks best.

No two results will ever look the same.
This is a real hit-and-miss technique — you
might find you get the effect you want after
one frame, or it might take you 40 or 50
attempts! You can never be sure what you
are going to capture with ICM, which is one
of the reasons why it is such a fun technique!

B SET UP: If you are new to using intentional
camera movement, woodland is a great
place to begin. The strong, vertical lines and
repetition/pattern of tree trunks is ideally
suited to the technique. Normally, it is best to
avoid strong or harsh sunlight. Overcast,
diffused or early morning/late evening light is
normally best. In this instance, | visited a local
conifer woodland just after sunrise.

Set a slow shutter Selecting a slow shutter

speed is integral to the technique. Try to use
an exposure length of between 1/4sec to one
second. Begin by selecting your DSLR's lowest
ISO (typically ISO 100) and a small aperture. If
this doesn't suffice, try filtration. A solid ND filter
is designed to absorb light. However, in this
instance, | attach a polarising filter, which has a
factor filter of up to two stops — doing so helps
me achieve an exposure of one second at f/22.



Pan your camera Roughly compose your

image and focus. To ensure a smooth
panning action, begin moving your camera just
before you trigger the shutter and continue to
pan the camera smoothly throughout exposure.
Itis fine to do this handheld, but if your tripod
head is a three-way pan/tilt design, you will
probably find it easier using its controls.
Experiment with different shutter speeds and

the speed with which you move the camera.

Try various techniques Different types of

ICM produce very different results. Try
moving the camera back and forth diagonally,
or — if you are using a lens with a tripod collar —
why not create radial blur by rotating the camera
during ther exposure? Often, you don't know
what will work, and what won't, untilyou try it.
Keep movement smooth and deliberate.
Generally speaking, it is best to avoid too much
sky in shot, as it has a tendency to overexpose.

| Finalimage
|There is no right or wrong result —
. itallcomes down to whichever
image you're happy with.

Exposure: 0.6 seconds at f/22 (ISO 50)

|

Change settings and movement To a great

extent, ICM relies on trial and error. Every
image will be different from the one previous,
and you just have to persist until you get the right
combination of shutter length and camera
movement. Vertical panning suited these tree
trunks best and a smooth top-to-bottom
motion, using a shutter speed of 0.6 seconds,
produced just the level of blur and artistic
abstraction that | wanted.
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Shootasolitary tree

Blessed with a sunny day? Make the most of the fine weather and head out into the countryside to shoota
vibrantruralimage. Helen Dixon shares her expert advice to help you bag a cracking shot of a lone tree...

Camera: Nikon DS8OOE

Lens: Carl Zeiss Distagon 21mm

SOLITARY TREES HAVE long been
aloved subject for photographers.
There's something alluring about a
minimalist landscape containing a
lone structure, standing tall
amongst its surroundings. The resulting
images are simple yet striking and are
relatively easy to create.

In terms of your choice of subject, look
for a tree that sits near the crest of a hill.
Shooting uphill removes distractions from
the horizon, isolating the lush, green foliage
of the tree against the vibrant blue of the sky.
The key to a successful composition is to
keep it simple — if your sky contains
interesting cloud formations then don't be
afraid to compose the shot to include a big
sky. Alternatively, you could try positioning
the tree to sit centrally in the frame. When all
else fails, the rule-of-thirds is a pretty
sure-fire route to success. If composing the
shot in portrait format, place the tree
centrally on either the upper third or lower

third dividing line; if composing in landscape
format, consider placing the tree on an
intersecting third for maximum impact.

Once you've found your ideal subject, a bit
of planning will ensure that you capture a
successfulimage. Visit on a sunny day to
capture the tree set against a brilliant blue
sky, and time your visit so that the sun is
behind you, otherwise the foliage will be cast
in shade. Once on location, look for
interesting cloud formations, or clouds with
interesting shapes that you can includein
your composition — these can be used to
create balance between foreground and sky.

Kit-wise, there are very few essentials,
other than your camera, that you'll need to
be able to successfully pull off this
technique, although a circular polarising
filter (see panel, right) will help make the
most of the colours in your scene and a
sturdy tripod will make composing and
getting a sharp shot easier.

Once you've photographed your tree
during the summer months, why not return
to the same spot during different seasons to
document the change? The results can be
arranged together as a series of images.

Polarising filter

Polarising filters allow you
to cut down the amount
of reflected lightina
scene — boosting
contrast, making
foliage greener and
the sky clearer and
more vibrant. They
are available in alarge
range of thread sizes
to suit a variety of
lenses and can be
rotated to alter the
polarising effect. Best of
all, you can look through
your viewfinder to assess the exact
effect that the filter is having on your
image. Unlike many other types of
filter, too, the effect of a good
polariser is very difficult to mimicin
digital software, making ita must-
have piece of kit.

Find the right angle Once you've identified the ideal candidate for your

solitary tree, have a good walk around to assess the best angle to shoot
from. This tree is ideal, being in the middle of a grassy field — however,
from this angle it doesn't stand out from the background.

Dialin the settings Select aperture-priority mode and choose a
mid-aperture. I'm using Matrix metering, but if this doesn't work, try
spot-metering from grass or foliage for a good exposure. Take a test shot
and check the histogram — dial in exposure compensation if required.

» _-??.‘»‘-‘:E_. . ‘Jx A 5
Use a polarising filter Attach a polariser to add contrast and saturation
to the scene. Rotate the polariser, assessing the results through the

viewfinder until you are pleased with the effect. Be mindful of dark areas in

the sky caused by overpolarisation if using an ultra wide-angle lens.

Compose the shot Moving down the hill towards the lake offers much

better shooting options, with relatively few distractions on the horizon.
Set up your camera on a tripod and try a variety of compositions. | first try a
landscape-formatimage, positioning the tree using the rule-of-thirds.




Final image

| change my composition for a
portraitimage in my final shot, and
position the tree to make the most of
the cloud formations and blue sky.

Exposure: 1/30sec at f/13 (ISO 100)

i
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Normal exposure

Crcating motion blur
using multiple exposure

Want to capture dynamic movement in clouds or water but lacking an
ND filter? Ross Hoddinott shows you the ropes...

Ross Hoddinott
Camera: Nikon D800
Lens: NIKKOR AF-S 16-35mm f/4

LOVE IT OR hate it, creatively
blurring subject motionis a
popular technique among
photographers. It's hard to deny
thatitimplies motion and adds
energy, depth and mood to photographs.
The most popular subject to ‘blur'is water,
but moving clouds, foliage and even people
can also suit the technique.

The question is, how do you create the
effect? The simple answer is to employ a
slow shutter speed, typically of 1/4sec or
longer. By doing so, any movement during
the time the shutter is open will appear
blurred. To generate an exposure of around
this length, you could shoot in low light,
when shutter speeds will be extended.
Alternatively, photographers can attach a
Neutral Density (ND) filter, which absorbs
light, in order to artificially lengthen
exposure time. However, what do you do if
the slowest shutter speed possible is too fast
to create blur and you don't have an ND to
hand? Allis not lost...

Although less regularly discussed, a
DSLR's multiple exposure facility can be
employed to generate a very similar effect
to that of an ND filter. Basically, instead of
taking a single long exposure, you make
multiple exposures of a normal length.

Establish a good exposure

| compose my image
so that water cascading
over boulders forms my
foreground, while a Welsh
mountain creates a dramatic
backdrop. At ISO 100, using an
aperture of f/11, the resulting
shutter speed is 1/20sec —
not long enough to creatively
blur the water's motion.

PR s
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Try a multiple exposure

I dont want to select a
smaller aperture due to the risk
of diffraction and don't have an
ND to hand. However, using
multiple exposures, | know
| can still create the effect
I want. | switch the facility on
and take a sequence of six shots.
However, Auto gain is off,
resulting in overexposure.

When combined, the result looks almost
identical to what you would have achieved
using a solid ND. For example, if you
captured and combined ten images taken
at 1/20sec, the result of the completed
multi-exposure would effectively appear as
if it had been shot using a single 1/2sec
exposure. By using the technique, you can
blur water ripples, cascading waterfalls and
fast-moving clouds.

Multiple exposure modes allow you to
take a predefined number of frames before
combining them. Not all digital SLRs offer
this feature, though many Nikon models do,
from entry-level right up to pro. Quickly
check your camera’s user manual to find out
if your camera has the facility or not. On my
Nikon D800, the multiple exposure facility is
found within the Shooting Menu.

Having selected this function, lam
presented with three options: Multiple
exposure mode On/Off; Number of shots;
and Auto gain On/Off. Most cameras will
offer the same or similar options. Typically,
itis best to keep Auto gain switched onto
prevent overexposure. It is normally best
to select a number of shots between six
and ten to generate an intentional-looking
level of blur, although the amount of
frames required will vary depending on
shutter length and subject speed. After the
lastimage is captured, the camera
combines them automatically in-camera
to createasinglefile.

Turn Auto gainon | quickly

realise my mistake and
switch Auto gain on — the
camera now allows for the
accumulation of exposures and
creates a single correctly
exposed result instead. | take
another multiple exposure set of
siximages. The result looks
good, but | still want a slightly
greater level of motion.

Useatripod When using your camera’s

multiple exposure facility to create a long
exposure, itis important to employ a good,
sturdy tripod and a remote release. This will
not only maximise image sharpness, but
also ensures each frame is identical.

Increase number of exposures

I increase the number of
shots in the multiple exposure
sequence to ten. | then trigger
the shutter ten times. This
effectively creates an overall
exposure of 1/2sec, enough to
hopefully give the degree of
motion | want and all without
having to attach an ND filter or
shootin low light.



TOPTIP

If your camera doesn't
have a multiple exposure
mode, you can achieve
the same effectin
post-processing by
stacking photos together
and adjusting the opacity
of each layer to suit.

o

o !

‘o ". -
‘Finalimage
 Ten exposures combine
. automatically into one by
~  thecamera’s multiple y
o exposure facility, giving me
the perfect amount c‘>f blur.

¥
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Moonlit landscapes

The brightness of the moon can create other-worldly landscape
scenes — use it to your best advantage for shots full of mood

JUST BECAUSE THE SUN has gone down
doesn't mean you can't capture beautiful
landscapes. Using moonlight is in fact simpler
than photographing at dusk as the light is less
variable. Shooting moonlit landscapes is not
that different from shooting in daylight, buta
lot easier than shooting at sunset, because
moonlightis a lot stronger than the last light
of the day. That said, you need to pay similar
attention to the angle and position of the
moon, as you would the sun. A high moon
casts strong downward shadows, while a low
moon creates long shadows and much softer
lighting. It's the optimum light for landscapes
and occurs shortly after sunset, just as the
moon begins torise.

Exposure is a photographer's main
challenge when it comes to moonlight, as it's
several thousand times weaker than sunlight.
A further complication for anyone taking
pictures at nightis the fact that the moon
moves fairly quickly, so exposures that are
more than a couple of minutes long can
render it a streak in the sky. One solution is to
keep the moon out of frame and simply shoot
alandscape exposed by its light. Landscapes
illuminated exclusively by a full moving moon
that softens shadows can make eerie,
ethereal pictures. Use too long an exposure,
though, and the light becomes flat. If you
want the moon in the picture, but the
exposure is too long, take the correct
exposure for the foreground, immediately
followed by a shorter exposure for the sky,
and then merge the two in post-production.

The length of an exposure depends on the
intensity of the moon: a fullmoon on a clear
nightis great for illuminating landscapes
where you want extensive depth-of-field. But
if the moon isn't as strong or prominent, you'll
find you may need to compromise on
depth-of-field by using a wide aperture to
reduce exposure times. Remember, though,
if you use a wide aperture, accurate focusing

is critical. The best times to shoot are when
there’s a fullmoon or during the two days
before and after the full moon, when it wanes
into and out of its full phase. Note also that
layers of cloud affect the exposure, just like it
does during the day.

For extra visual interest in your
photographs, try shooting with ariver, lake
or sea in the foreground, so you can capture
the light beams glistening off the surface
— you'll find that the reflected light also
brightens the whole scene. You could also
introduce flash or a torch into your shoot,
using it to paint the foreground.

When setting up your camera, apply the
same techniques already explained in this
guide: use Bulb or manual mode, work out
the exposure, focus manually if possible
and fire the shutter using a remote release.
When working out the exposure for a moonlit
scene, multi-zone metering works well.
Then follow this technique: take a test shot
in aperture-priority mode at your highest
ISO rating and widest aperture to give
yourself a base shutter speed, then use
reciprocity failure to work out the exposure
for a decent aperture and low ISO rating.
Alternatively, switch to spot metering and
meter off the brightest part in the scene,
then add two stops of extra exposure
because the metering system will otherwise
render your highlights as a mid-tone.

Once you've mastered star trails and
moonlit landscapes, try shooting auroras,
meteor showers or even have a go at
deep-space photography — you'llopenup a
whole world of photo opportunities!

Right: For every exposure of this scene, the
f/stop and ISO had to be adjusted to keep the
shutter speed between 15 and 30 seconds in
order to freeze the moon'’s motion.

Below: This shot of Swaledale comprises a
four-minute exposure for the foreground and a
30-second exposure for the sky.
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Reciprocity law

With low-light photography, it'simportant to
remind yourself about the interchangeable
relationship between shutter speeds and
apertures so that you can work out the
required exposure. It takes a bit of
brainpower, but you can now download
apps to your smartphone that can help you
calculate equivalent exposures. Basically,
every time you stop down your aperture,
you need to increase your shutter speed to
double the exposure time, so if you go from
f/4 1o f/5.6, the shutter speed needs to
double from, say, two seconds to four
seconds. Reciprocity law failure is when the
camera fails to accurately meter a scenein
low light and fails to meter a sufficient
exposure time for the length of shutter
speed. It's much less common with digital
cameras than film, but you may find you
need to add an extra stop or two of exposure
to ward off underexposure when shooting
moonlit shots like the ones on these pages.



For those of us who don't have the resources for
deep-space photography of the Milky Way
galaxy, the nearest thing we have to the
mysticism of space is the moon. You don't need
any special equipment to photograph the moon,
only what you'd normally use for most night
photography, but a decent telephoto zoom
would be an asset — in particular, those extending
toat least 300mm. If you don't have a suitable
lens, you could invest in a teleconverter to extend
the reach. Remember that an APS-C camera has
a crop factor of 1.5x, so the equivalent focal
length of a 200mm lens is 300mm.

It's easy to underestimate the moon'’s
brightness, which is why getting the exposure
correct can be quite tricky. Most first attempts at
lunar photographs result in an overexposed
circle where the moon should be. The first step
to avoiding this is to pick a spot where there is no
ambient light from traffic or streetlights, ona
clear night, with no cloud. There is a little trial
and error needed to get the perfect exposure as

Ny,
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it changes depending on the shooting
conditions, but set your camera to manual
mode and use 1/250sec at f/8 (ISO 100) as a
starting point. Take a series of bracketed
exposures (in one-stop increments) around this
setting and review them on the LCD monitor.

We'd recommend you change the shutter
speed rather than the aperture. Depending on
the phase of the moon, its brightness, your
location and the atmospheric conditions, you
may find you need to lengthen or shorten the
exposure to capture enough tonal detail on
the lunar surface.

Position your focus point over the moon,
lock on to it using autofocus and then switch
to manual focus to stop it hunting. Use a
remote release or the self-timer to minimise
the risk of shake blurring the result.

You're likely to have to crop the image in
Photoshop and do a little work on the tonality
by adjusting the Levels to draw out more
detail on the moon'’s surface.
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Original

Incrcasc contrast using
Adjustmcnt Laycrs

Are yourimages in need of a contrast boost? Find out how to add extra
punch to colours using Adjustment Layers and Blend Modes

Jordan Butters

Mist and fog add a wonderful
atmosphere to images. Nothing
quite conveys the mood of a
. chilly autumn or winter morning
y like the early morning sun
piercing through a beautiful heavy haze.
More often than not, though, misty
landscapes are hindered by a lack of
contrast. But not to worry, as with the
addition of an Adjustment Layer and some
experimentation with Blend Modes, you can
apply the punch to your misty landscape
images. While this tutorial has been done in
Elements 10, the same features and
methods can be applied to images being
worked on in Photoshop CS as well.
Similarly, some CS tutorials in this guide can
be done in Elements, too.

Adjustmcnt Laycrs

We would usually advise duplicating
your originalimage layer before you
start editing your photograph, justin
case you make any mistakes. However,
a major benefit of Adjustment Layers is
that they are nondestructive, meaning
that any changes you make using them
do not affect the originalimage data.
What's more, the parameters and
values of an Adjustment Layer can be
tweaked in the Adjustment palette at
any time throughout the editing
process, or if you're not entirely happy
with the effect, you can simply delete
that Adjustment Layer and start afresh.

Add an Adjustment Layer You'll need the

Layers and Adjustment palettes visible,
so first go to the Window menu and make
sure that both Adjustments and Layers are
ticked. Then click on the Create new fill or
adjustment layer button at the bottom of the
Layers palette and, in the drop-down menu
that appears, select Levels.

Try the Auto feature In the Adjustment
palette, first try using the Auto button to
allow the software to decide which adjustments

are made to yourimage. This works better on
some images more than others. The Auto levels
tool adjusts each of the Red, Green and Blue
channels independently so you may now notice
a colour cast appear in your image.

Correct the colour To correct the colour

cast, make sure that the Levels layer in the
Layers palette is selected and, using the Blend
Mode menu at the top, change the Blend Mode
of the layer to Luminosity. This will remove the
image’s colour cast by ensuring that the
Adjustment Layer only affects the contrast in the
image below it and not the colours.



Try amanual adjustment If you aren't happy

with the effect from using Auto levels, delete
your Adjustment Layer by clicking on itin the
Layers palette and dragging it to the Delete layer
icon at the bottom; this reverts the image back to
its original state. Add another Adjustment Layer
by clicking on the Create new fill or adjustment
layer button and selecting Levels.

Manually set Levels This time, rather than

using the Auto adjustment, click and drag on
the black, grey and white point sliders in the
Adjustment palette to tweak the contrast of your
image. Be careful how far you push the black
and white points so you don't clip the shadows
and highlights and lose detail. You can be more
liberal with the grey slider for the mid-tones.

Finalimage

The contrastincrease
has cut through the haze
and boosted saturation.

Experiment with Blend Modes Back in the

Layers palette, experiment with the different
Blend Modes to alter the effect. Overlay, Soft
Light and Hard Light will all offer slightly different
effects. You can also use the Opacity slider at the
top of the Layers palette to weaken the effect or
you can revisit the Adjustment palette at any
time to tweak the parameters.
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Lcarn how to eontrol eolour

No one wants dull and washed-out images, but oversaturation can be
justas bad. Here's how to take careful control of your colour

Original

Jordan Butters

Autumn, especially, is a beautiful
time of year for capturing
colourful landscapes. Deep blue
skies, rustic reds, lush green grass
i and golden oranges. When
shooting to capture colour like this, it's only
right to assume that we want to do these
fantastic colours justice with accurate
reproduction. Failure to replicate the hues
we seeinasceneisn’talways down to the
photographer — digital cameras are still

nowhere near as advanced as the human
eye. But there are steps that you can take to
ensure good colour reproduction in-
camera, such as ensuring that you have the
correct White Balance set and shooting
under the best lighting conditions.

Most of us want to capture maximum
detailin ourimages, which is why we advise
you expose to the right when shooting in
Raw format (meaning that you should
overexpose your image slightly, but not to the
extent that the highlights become clipped).

Vibrance & Saturation

There's often confusion between the
Vibrance and Saturation slidersin
Adobe Camera Raw. At first glance
they appear to do much the same
thing, but there are clear differences.
The main one is that the Vibrance slider
doesn't affect colours that are already
sufficiently saturated; useful for
applying a universal adjustment
without oversaturating colours which
are already nice and bright. It will also
not affect hues similar to those found
in skin tones, which makes it useful for
increasing saturation in portrait shots
without turning your subject’s skin a
strange shade of orange. This
comparison shows the difference an
adjustment of +75 on each slider
makes to the originalimage.

Saturation +75

Vibrance +75 | -

Doing this, though, does sacrifice colour
saturation — the brighter the original colour,
the worse the image appears bleached.
Thankfully, this can be addressed with
Photoshop's Adobe Camera Raw, as there
are a number of controls that allow you to
adjust colours universally and individual hues.
On the surface, many of the controls, such
as Luminance and Saturation, seem to have
similar effects but there are subtle
differences. For the best results, learn what
each slider does — which we show you here.

Open the image This image has been

exposed to the right without losing any
highlight detail, but the colours are washed out as
aresult. Open your Raw file in ACR and first make
any changes to Exposure and Contrast as these
parameters will affect the colours in your image.

Decrease luminance selectively Select the

HSL/Grayscale tab and choose the
Luminance tab within to target the brightness of
the individual colour channels. Reduce the
luminance of the Blues channel to darken the sky.
Monitor the image preview to assess the changes.

Adjust surrounding channels Quite often

you'll find that you need to adjust more than
one channel to make the changes look natural.
By making subtle adjustments to the
neighbouring Aquas channel, the transition in
colour between sky and clouds is improved.
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Increase saturation manually The Saturation

sliders control the intensity of each colour.
Click on the Saturation tab and drag the Green
slider to adjust the channel. Make any changes
gradually, as oversaturation can look as bad, if
not worse, than undersaturation.

Adjust the surrounding channels As before,

neighbouring channels may benefit from
some slight adjustment. In this case, the green
grass looked more natural when a small increase
was made to the saturation of the Yellows
channel as well.
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Finalimage

The vibrant, punchy colours
thatwere present on the day
have been restored, creating
eye-catching image.

Adjust the Hue To change the colour of an
area — like these orange hills — select the
Hue tab. Next move the Orange slider until
you are happy with the result. You may find
only small changes are needed to alter the hue
- but be watchful that it doesn't look unnatural.
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Breathe life into flat photos

Wantto create an HDR effect but don't have Raw files or a set of
bracketed exposures? Don't despair! Use Shadows & Highlights...

Luke Marsh

We all have images that didn't quite render the scene
how you remember it. Maybe the sky's not as moody
’ . | orthegroundistoo dark, or maybe the overall
5 appearance of the image lacks contrast or is badly
{ exposed. Well, Shadows & Highlights can resurrect
these images. This nifty adjustment is a fantastic photographic
tool, which is often overlooked by users since dedicated HDR
software like Photomatix and Photoshop actions became
available from third-party companies. In the simplest terms,
the adjustments allow you to recover detail from over- or
underexposed areas by adjusting the Highlights or Shadows
controls respectively, or you can improve the overall tonal range
using the Midtone Contrast slider. It's really very simple.
The key to success with Shadows & Highlights is subtlety.
As with any process that plays with tonal range, Shadows &
Highlights can produce photographic Frankensteins if used too
eagerly. So why not give it a go? The controls may seem daunting
atfirst, but after a little experimentation and a better
understanding, you may find you'll be using this feature regularly.

Duplicate original Our chosen image is a bit

lifeless, yet clearly has potential texture in the
sky and detail in the foreground that could be
pulled out using Shadows & Highlights. First,
create a duplicate layer from the original by
going to Layer>Duplicate Layer..., naming the
layer accordingly for reference later.

Add a gradient Click on the Layer Mask

Shadows & Highlights On the duplicate layer
go to Image>Adjustments>Shadows

& Highlights... As the image is generally flat,
concentrate on the Shadows and Midtone
Contrast, with only minor adjustments to the
Highlight field. At this stage you want to be
focusing more on getting the foreground right.

Create a stormy sky With the mask in place,

Original

@Alttoreset
When workingin
Shadows &
Highlights, hold
downaltto
change the Cancel
button to a Reset
buttonin case you
want to take the
filter back to its
default settings.
You canalso
uncheck Preview
to toggle between
the blurred and
originalimage.

Duplicate adjusted layer Now duplicate this

edited layer with Layer>Duplicate Layer...
Then add a Layer Mask by going to Layer>Layer
Mask>Reveal All or by clicking on the Add Layer
Mask icon at the bottom of the Layers palette
(circled). The purpose of the Layer Mask is so that
the next edit only affects the sky area of this layer.

Reduce the saturation One final tweak is to

thumbnail and select the Gradient Tool,
ensuring the Foreground and Background Color
are set to the default Black and White. With the
shift key held down to ensure a straight line, click
near the horizon and drag, letting go at the top of
the image. This adds a gradient to the mask.

any work done will only affect the sky area.
Open Shadows & Highlights as instructed in step
two, but this time work mainly on the Highlights
and Midtones Contrast to pull all the detail back
into the sky. You may want to increase the Black
Clip to improve the overall contrast.

remove some of the colour to enhance the
storm-like appearance of the image. With the top
layer still active, go to Layer>New Adjustment
Layer>Hue/Saturation... and reduce the
Saturation slider by around 20%, then click OK.
Now save as a PSD, to preserve all the layers.



Final image

From flat to fantastic:
Shadows & Highlights has
pulled out lots of detail that
laid hidden in the JPEG.
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Behind the mask

Combining Adjustment Layers and Layer Masks opens up a world of
options for selectively tweaking and perfecting your shots

Without a doubt, one of the most powerful
features of Adobe Photoshop CSiis the ability to
selectively edit yourimages in a nondestructive

3 manner using Adjustment Layers
A ong Layer Masks.
Adjustment Layers offer a series of
effects and adjustments, each with
adjustable parameters to suit your
images. Furthermore, they can be
applied to the entire image at once,
clipped to just a single layer or
applied selectively using a Layer Mask.
Layer Masks, as the name suggests,
mask the layers that they are applied to,

allowing you to edit or affect only selected parts of your
image at a time. If you've been using Photoshop but haven't
yet delved into the world of Layer Masks and Adjustment
Layers, you're missing out on myriad options forimproving

TOPTIP

To apply an adjustment
to asingle layer rather
than the whole image,
select the Clip to layer
button () in
the Adjustments
palette.

Layer Masks can be
applied toimage layers
as well as Adjustment
Layers. Forimages with
two or more layers
present, select the
layer you wish to mask
and check Add vector
mask in the Layers
palette. Then use the
Brush Tool to brush
over and mask your
image. Remember

— White reveals the
layer, Black masksiit.

yourimages and it's time to harness the full power of CS.

Show the Layers palette With your image
loaded in Photoshop, make sure the Layers
palette is visible by going to Window>Layers.
In the Layers palette you will only see a
Background layer at present. Duplicate this
layer by going to Layer>Duplicate Layer, or
by pressing Cmd+J if you're on a Mac or Ctrl+J
if you're using a Windows-based PC.

Add another adjustment To bring out detail

in the foreground, click on the Create new
fill or adjustment layer button again to create a
new adjustment and this time select Levels. In
the Adjustments palette, adjust the sliders until
you are happy with the effect. These changes
will be applied to just the foreground in the next
step, so don't worry about the sky for now.

Add a Quick Mask | want to retain the warm

tones in the sky but add a neutral tone to the
foreground. Press the Q key to enable Quick
Mask mode, select the Brush Tool and use the
top menu to customise the brush to suit. Brush
over the area you wish to remain unaffected by
any changes. If you make a mistake, press the X
key and brush back over to remove the mask.

Apply a gradient mask Click and hold on the
Paint Bucket Tool to select the Gradient Tool
and press the D key to make sure that your
colour palette is reset. In the top menu, make
sure that the Mode is set to Normal. Click and
drag on yourimage in the direction of
foreground to background to apply the mask.
The longer the line, the softer the gradient.

Brightmess [Contrast
Levels.
Curves.
Exposure..

Vibsrance.

e/ Saturanon.
Color Balance
Black & White...
Photo Filter
Channed Mixer

nvert
Posterize.
Theeshola.
Cradient Map.
" Selective Color

Add an adjustment With your area masked
off, press the Q key again to turn this mask
into a selection and, in the Layers palette, click
on the Create new fill or adjustment layer
button and select Photo Filter from the
drop-down menu. In the Adjustments palette,
select one of the three preset Cooling Filters
and adjust the Density slider to alter its effect.

Tweak the mask Don't worry if you don't get
the gradient right first time, you can click and
drag as many times as you need to get the right
transition. The gradient cuts through the final
wooden post in my image and doesn't look
natural. Select the Brush Tool and, with White
set as your Foreground Color, paint in the post.
If you go too far, press X to paint back over.
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Create a misty morning =3

The Gradient Tool is ideal for adding an eerie wintry feel to your images.
Afew other little tricks are necessary to pull it off, though

Luke Marsh
Mistis one of those elusive elements that rarely Hot Key

appears when you want it to but when it does it
can transform the atmosphere of your landscapes. @Flip between the
Now this step-by-step is no substitute for the real

NOLYNE Wvavy

- 1 ; Foreground and
48 thing, butit can be used to improve your current Background Color
landscape images or to occasionally relieve you having to When using Layer
wake early on a winter morning to search for natural mist. Masks or the Gradient

Deep valleys and rolling hills make beautiful scenes for
misty landscapes, as do frost-bitten fields. Refer to some
example images before you try this technique just to see how
mist naturally acts in different situations. Mist tends to look
gradually heavier the further it is away from you, which is why
you'll notice we handle the image treatment in sections —
background, middle-distance and foreground — with each
having a different intensity of mist.

Tool, use the X key to
change between the
Foreground and
Background Color,
whichiis set to Black
and White as default.

LrAepe@onpssnariin? Bl

B

Add a gradient Use Layer>New Layer... Reveal the tree In reality, the mist would be Focus on the middle-distance To add fog to

to create a layer above the original. Select behind the tree. To give it this appearance, add the middle-distance, create another new
the Gradient Tool and ensure it's set to Linear a Layer Mask by clicking the icon in the Layers layer via Layer>News>Layer... Use the Gradient
gradient in the options bar, and that the palette (circled). Next, select the Brush Tool, setto  Tool with the same settings, and draw a line from
Foreground Color is set to White and the Black and an appropriate Size, and begin towork  the top to the bottom of the image and release to
background to Black. Click and hold, then drag over the tree, removing the mist. If you gotoofar,  create an even gradient across the frame. Reduce
from the top of the image to just under the you can change the Foreground Color to White the Opacity by changing the amount to 50% in
horizon to create the background layer of mist. and paint over the area to bring back detail. the Layers palette (circled).

Add foreground mist To create eerie Adjust perspective To add perspective, go Tweak colour & contrast Create two

foreground mist, again add a new layer to Edit>Free Transform>Scale and reduce adjustment layers by selecting the icon at the
(Layer>New Layer...), then go to Filter> down to the foreground area by dragging the bottom of the Layers palette (circled). First, create
Render>Clouds to fill the layer with a textured top-centre tab. Before applying, change the a Hue/Saturation adjustment layer, and use the
cloud effect. Use Image>Adjustments>Levels... Transform to Perspective and drag one of the Saturation slider to desaturate the colours slightly,
and the black and white sliders to boost the bottom corner tabs outside the pasteboard until and, finally, create a Brightness/Contrast
contrast on the image. Finally, change the layer's  you're happy. You may need to zoom out to adjustment layer to boost the contrast sufficiently

Blend Mode to Screen to make the layersinteract. ~ move the tabs out far enough, as shown here. to enhance the appearance of diffused misty light.



®Final image

Afew simple steps
areallittakestoadd a
touch of mist to your
landscape images.
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Add a colour graduatcd filter

Learn how to control Photoshop's gradients to create a colour graduated
filter effectand transform ordinary skies into something glorious

Jordan Butters m
Inanidealworld, landscape

photographers would always have
anarray of ND grad filters close to
hand; one for every situation and
A effect that you want to create. But
thisisn'talways practical. Thankfully there area
range of effects in Photoshop that simulate the
results of using filters. This technique is great
for emphasising existing colours in the sky or
completely changing the mood of yourimage
by emulating a different time of day to when
image was taken.

L ; J
Add the gradient Before we begin, press the D Adjust the gradient In the dialogue box, click
key on your keyboard to reset your colour on the Reverse box to place the gradient at the
palette to default. Click on the Add new fill or top of the image as opposed to the bottom and
adjustment layer button in the Layers palette and then click OK. Back in the Layers palette, change
select Gradient from the drop-down menu. the Blend Mode of the Gradient layer to Multiply.

\ L

Open the Gradient Editor Double-click on the Change the colour Click on Black Color Stop

thumbnail on the Gradient layer in the Layers in the bottom-left corner of the gradient. Then
palette to open the Gradient Fill menu again and click on the Color thumbnail below to open the
click on the Gradient thumbnail at the top to open Color Picker window. Select your colour — | chose
the Gradient Editor palette. pink to emulate the sky at dusk. Click OK.

......

ltiple filters

You could always try adding more than
one colour filter to your image. Simply
duplicate your Gradient layer by
selecting itin the Layers palette and
going to Layer>Duplicate Layer and

A ¢ . N o - AP e change the gradient colour as was
Alter the opacity The two Color Stops above Add a Photo Filter In the Layers palette, click dong insteps thrlee through tofive. Try
the gradient scale control the gradient opacity. on the Add new fill or adjustment layer button placing the gradients at differentangles

Move the White Color Stop in the top-right corner  again and this time select Photo Filter. Select one using theAngle dialin the Gradient Fill
to control the depth and hardness of the gradient of the Warming Filters and click OK — this will menu for different effects.

to suit yourimage. Once done, click OK. warm the entire image to suit the dusk colours.
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Finalimage

Caught out without your
filters? No fear — whenyou can
create stunning sunsets like
this in Photoshop, you've
always got a back-up plan!

Multiplefilters Warming Filter CoolingFilter Green Filter
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Bland to bcautiful: learn
how to replace a sky

Improve your landscape images ten-fold with this simple technique
where you can swap an uninspiring sky for one with more drama

Jordan Butters

The British weather is well known
for not doing quite what you want
itto and rarely do all of the
elements play ball when it comes
to landscape photography. You
can be perched above a beautiful vista,
camera ready on a tripod and remote in
hand, but the one thing you can'tdo much
aboutis a bland sky. Allis not lost, though:ina
few simple Photoshop steps you can replace
the sky and transform your landscapes from
drab to dramatic. You'llneed to find a
replacement sky to swap in, of course, and
it's worth keeping a small library of skiesina
folder on your computer for such occasions.
Try to shoot a range of different skies
from different times of the day: it makesita
lot easier when the sky you are replacing is of
a similar colour and time of the day to the
replacement. Trial and error is the key to
finding the right sky for your scene.

TR O

e FEAE LA

Select the sky Open your image, choose the

Quick Selection Tool and begin painting
across the sky. If your image contains objects on
the horizon, as ours does, you will need to zoom
in and adjust your brush Size in the Options
toolbar to make a more accurate selection. If
you select an area by mistake, simply hold down
the alt key and erase the selection. Once happy
with your selection, go to Select>Inverse.

b —

Bring in the new sky Open your
replacement sky image in a new window
and, using the Rectangular Marquee Tool, select

the sky only. Copy your selection by going to
Edit>Copy and close your sky image without
saving. Head back to your original image and
paste the sky in by going to Edit>Paste. It's very
unlikely that your new sky will fit your image
straight away, so don't worry if this is the case.

OLOHdXD0LSI

Refine the selection Go to Select>Refine

Edge to bring up the Options window. Click
Default and the sky will appear white. Using the
Contract/Expand slider, adjust the selection so
that it closely follows the lines of the horizon. You
can alter the preview that you see by selecting
one of the preview options at the bottom. Once
done, click OK. Then go to Select>Inverse again
and press the backspace key to remove the sky.

Adjust the proportions Go to Edit> Create a gradient Click on the Add Vector

Transform>Scale and, holding down the Mask button in the Layers palette. Select the
Shift key, drag the corners of the sky image out Gradient Tool and, at the top of the screen, make
or in to match the width of your landscape. sure that the Black/White gradient is selected. On
Once happy, click on the tick at the top, or press the image, click and drag the line from just below
the enter key. Use the Move Tool to line the sky the horizon towards the top of the sky, then
up so that it completely covers the white area of release the button. This part involves some trial
the image. Don't worry about any overlap onto and error, but you can repeat as many times as
the horizon at this point. you need to until you are happy with the effect.



TOPTIP

The sky typically gets
brighter the closer to the
horizon itis. Bear this in
mind when applying your
gradient — if the gradient
is too low or too hard,
then the effect will
lack realism

Finalimage

We thinkyou'll agree
thatthe new sky
adds some much
needed drama to the
originalimage.

Quick selection

The Quick Selection "=
Tool was released with W
the launch of Photoshop | =+,
CS3and Elements 6,
and has featured in all w
versions since. It works

by detecting contrast
differences, and makes

OLOHd XD01SI
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a selection based on

Tidy up the horizon Some of your new sky Adjust the contrast In the Layers palette, this; ideal for separating

will still overlap onto the landscape, so to tidy click on the Create new adjustment layer skies from horizons. S
this up, select the Brush Tool, lower the Opacity button and select Levels from the menu. First Just be aware of ﬁ
to 25% and set the brush’s Hardness to 25% inthe  make sure that the adjustment is clipped to the eremswith lovweeud 4
Brush Options toolbar. Select Black as your layer below only by clicking the button at the -
Foreground Color and brush over the horizon, bottom of the Adjustments palette. Then adjust ormist cover, as the tool f
building up areas that you wish to reveal. If you the contrast of your sky to match the rest of the may struggle to separate LAY
go too far or make a mistake, simply select White  image using the middle (mid-tones) level slider. themaccurately. _

as your Foreground Color and brush back over. Once done, save your image using File>Save As.
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Maketheyearablurwithafour-seasons special

Give your seasonal landscapes a creative twist with this simple but striking motion-blur technique

Caroline Wilkinson

Every season offers new
possibilities to photograph
striking colour-filled landscapes,
_ whether it be ruby-red poppies,
sun-kissed oilseed rape, blankets

‘.\l

of burnt orange leaves or black & white
scenes in winter — you're never short of
opportunities. While there are a million and
one ways to photograph these classic
scenes, each as beautiful as the other, it's
good to find a technique that gives these
seasonal scenes a fresh, artistic appeal.

You may have come across motionscapes
before where you pan the camera across a
coastal horizon to create streaks of colour.
This technique is very similar but applies
vertical streaks instead, using Photoshop. You
can do a similar technique in-camera using a
three-way pan & tilt tripod head to pan the
camera up and down in a fluid movement,
butit will blur the entire image, whereas here

| only want to blur half of it. Plus, while the
purists may be cursing, the effectis much
easier to control, with better results, using the
Motion Blur filter in Photoshop instead.

After some trialand error, it was clear that
to get the best results for the seasonal
quadtych (series of fourimages), I'd need
images where there was as much interest in
the top of the frame as the bottom,
otherwise you wouldn't be able to tell what
was blurred or in focus. | found that the best
scenes were forests or landscapes where
trees fill the height of the frame, so with this
in mind the Digital SLR Photography team
rummaged through their hard drives for
suitable images to illustrate spring, summer,
autumn and winter.
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Create a duplicate layer Open your first picture and duplicate the image

by clicking on the Background layer in the Layers palette and going to
Layer>Duplicate Layer, or by dragging it down to the Create a new layer
icon at the bottom of the Layers palette. From now on you'll only be
working on this duplicate layer. Leave the original image untouched.

Toomuch

Better

Increase the strength Adjust the Distance slider to increase the strength

of the blur effect. The bottom of the image needs to be heavily blurred
but not to the point that the subjects become unrecognisable. It will be
different for every image (we used 409 pixels). When you're happy, click OK.

Apply motion blur Click on Filter>Blur>Motion Blur to open the
filter's dialogue box. As you want to apply a vertical blur, set the
Angle to 90° by either typing the amount in or moving the angle finder.
You'll notice that by clicking and dragging on the angle finder the

direction of the blur will change in the preview screen.
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Apply a Layer Mask To add a Layer Mask to the blurred image,

click on the Add Layer Mask icon at the bottom of the Layers palette.
You'll notice this adds a white box next to your image in the Layers palette.
Then select the Gradient Tool from the toolbar or press G.

ann _BHRE472 jo @ 157X Bl kg aurd iy, Lawws Mavt K) *
[ ¥ o~ o

Mask off the blur With the Gradient Tool and the Layer Mask

selected (black lines appear around the mask's corners when it's
activated), click at the top of the image and drag the cursor down to
the point where you want the blur to start.



THE NIKON GUIDE TO LANDSCAPE PHOTOGRAPHY Photoshop tcchniqucs | 133

®Final image

Print the pictures
out and frame them
for the wall or why
not try having them
made into canvas
prints or acrylics for
adifferent look?

Repeat What you've done is create a gradient in your Layer Mask that Apply the technique to all seasons Repeat steps one to six with the
allows the blur to graduate through your image. You can change the other three images of your choice. We've picked a colourful autumn
graduation by repeating step five. You'll find the images look better if the woodland scene, bright sunshine passing through trees for summer and a

blur is heavier at the bottom of the picture than the top. black & white picture of a snowy forest.
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Crcatcatcn-stop ND cffect

ND filters require dedication to get great results. Here's a technique for
those of youwho don't have the time to attempt the real thing

Luke Marsh

For any of you who aren't already aware, the ten-stop
ND filter is amazing! By significantly lengthening a
camera’s exposure, the filter allows the camera to
capture motion so clouds are rendered as streaks and
water becomes a fine mist — it's truly magnificent, but
it takes skilland patience to perfect. As great as this in-camera
technique is, often the key to its success is the location, and as
exposure times can often run into tens of minutes it demands
extreme dedication and time — if you're anything like me, those
are two things | can't always spare in my hectic schedule.

There is, however, a shortcut to getting a very similar effect
using Photoshop's Blur filters, and while it may not be one for
the photo-purist, it can produce a very convincing comparison
when combined with the right kind of image. Feel free to
experiment on any image, but it's usually coastal scenes that
produce the most dramatic results. For further inspiration of
whatimages might work, it's worth looking at contributor
Lee Frost's Motion Studies (www.leefrost.co.uk), taken with

<

an actual ten-stop ND filter.

Create duplicate layers First, create a

duplicate layer from the Background layer
by going to Layer>Duplicate Layer..., naming the
layer accordingly — here, it's called "Water Blur'.
Then click on the Add layer mask icon at the
bottom of the Layers palette to add a Layer
Mask. Repeat this process to create an additional
duplicate layer — this one was named 'Sky Blur'.

Layer Mask

ALayer Mask allows
you to hide detail
from the layer it's
applied to, revealing
the image beneath
without erasing it.
When the Layer
Mask is selected,
simply add Black

to the mask to hide
image detailand
change to White to
restore the detail.
Use the Xkey to
quickly switch

the colours.

Apply Radial Blur On the sky layer, ensure the

image thumbnail is selected (circled), then go
to Filter>Blur>Radlal Blur... In the Radial Blur
window, make sure that the Blur Method is Zoom
and Quality is set to Best. Next, enter a large
Amount — no less than 50 — and move the Blur
Center to an area where the horizon would
roughly be positioned on the image, and click OK.

THE NIKON GUIDE TO LANDSCAPE PHOTOGRAPHY

Original

Hide foreground blur The Radial Blur should

only affect the sky portion of this layer, so
click on the Layer Mask thumbnailin the Layers
palette (circled) and, with the Brush Tool set to a
large soft-edged brush and Black colour, paint
across the foreground area to hide the blur
across the water and jetty. Switch to a smaller
brush when working near the horizon.

Blur the water Switch to the water layer by

clicking on it. Add a Radial Blur zoom blur,
with all the settings as in step two, but reducing
the Amount down by half, just to make the cloud
reflections more realistic. Then go to Filter>Blur>
Gaussian Blur..., setting the amount to no more
than 15 pixels. This adds a hazy sheen to water,
common with many long-exposure images.

Reveal the jetty Now edit the Layer Mask to

reveal the jetty. First, click on the Layer Mask
thumbnail (circled), then select the Polygonal
Lasso Tool and draw a selection around the edge
of the jetty. Once complete, go to Select>Modify>
Feather... and add a value of 1 pixel to avoid a harsh
edge to the selection. Now take the Brush Tool,
still set to Black, and paint over the selection.

Convert to mono To turn the image mono, go

to Image>Adjustments>Black & White... and
click OK to use the default settings. Conversions
from colour to mono often leave an image looking
a little flat, so use Image>Adjustments>Levels...
to add contrast. Use the black point and white
point sliders (circled) to boost the blacks and whites
respectively, taking care not to burn out any detail.



Finalimage
With just a few steps, you
could add this beautiful
atmospheric effect to
your landscape images.
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KIT FOR LANDSCAPES

®Waterproof cover:
Protects your kit if you get
caughtinasudden
downpour. They're
inexpensive and available
from most camping shops.
@ Mini groundsheet:
Asquare of polythene or a
bin liner. Make that two —

so you can keep your knees
and bag dry when they're
placed on wet ground.

® Microfibre cloths: Pack
several cloths to keep lenses
and filters clean. Put them

in plastic bags to keep them
free of debris that could
scratch delicate surfaces.
®Maps and compass: Handy
tools for knowing your
location and establishing
where the sun will rise and/or
set. You can also buy apps for
your smartphone.

@ Spirit level: Helps keep
the camera level when it's
mounted on a tripod, so you
don't geta wonky horizonin
your shots. Some cameras
offer an electronic level.
®Snacks & drinks: Pack
high-energy snacks (energy
bars, peanuts and chocolate
areideal) and drinks to keep
you going. Please don't litter
the countryside!
@Airblower: Use it to

remove sensor dust if
necessary. Visible Dust,
Giotto's and GreenClean

are all specialists with arange
of products.

®Bug spray: Heading to
Scotland between May and
September? Take spray to
keep midges at bay. You'll
find bug spray at Boots and
other pharmacies.

® Camera straps: Upgrade to

i
aneoprene strap for added
comfort. Our favourites are
by Op/Tech, but several
brands offer a choice of

colours and styles.

THE NIKON GUIDE TO LANDSCAPE PHOTOGRAPHY

Landscape photographers are a dedicated bunch ready to battle
the elements for greatimages. If you're heading into the great
outdoors, our guide ensures you've packed all the key essentials

LANDSCAPE PHOTOGRAPHY is easy, right? You just sling a camera over your shoulder, head into
the countryside and greatimages will be staring you in the face. If only it were that simple! The
reality is ridiculously early starts to catch the first light of the day, late finishes to shoot the sunset,
routinely being battered by bad weather and tackling long walks shouldering heavy packs with
the gnawing knowledge that it may all be for nothing if the light doesn't play ball.

But despite the setbacks, landscapes continue to be one of the most popular subjects to
photograph, simply because when things do go to plan, you could be moments away from
taking the best photographs of your life. To do that, though, you do need the right gear — and
we've got brilliant suggestions right here, whether you're a novice, enthusiast or semi-pro/pro.

Enthusiast p138

Semi-pro p140

Arctic Butterfly Hahnel Manfrotto Slik
www.visibledust.com www.hahnel.ie www.manfrotto.co.uk www.intro2020.co.uk
B+W Heliopan Nikon Tamrac
www.bpluswfilters.com www.teamworkphoto.com www.nikon.co.uk www.intro2020.co.uk
Cokin Hitech Paramo Tamron
www.intro2020.co.uk www.formatt.co.uk WWW.paramo.co.uk www.intro2020.co.uk
Depssi Hoodman Really Right Stuff ThinkTank
www.bluepondimages.com www.teamworkphoto.com www.reallyrightstuff.com www.snapperstuff.com
Gitzo Hoya SanDisk Tokina
www.gitzo.co.uk www.intro2020.co.uk www.sandisk.com www.daymen.co.uk
Giottos Lowepro Sprayway Vanguard
www.giottos-tripods.com www.lowepro.com WWW.Sprayway.com www.vanguardworld.co.uk
Hama Lee Filters Sigma Velbon
www.hama.co.uk www.leefilters.com www.sigma-imaging-uk.com www.intro2020.co.uk
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Filter system

In terms of value, the Cokin P System
is the best there is. Thefilters are
84mm wide so the holder is big
enough to avoid vignetting on

lenses as wide as 14mm on DSLRs
with APS-C sized sensors (21mmon
full-frame) and there are adaptor rings
available for lenses with threads up

to 82mm. The holder costs around

£5 and adaptor rings are £11 each.
Whichever brand you buy, make sure
you investin a circular polariser and a
set of ND grads. Cokin's P164 Circular
Polariser costs £90, while its ND grads
costaround £22 each.

Superzoom

Focal lengths from moderate wide

to telephoto will cater for all your
landscape needs, and if you want to
have an easy life and compact kit, this
can be covered inasingle 18-200mm
or 18-270mm zoom (equivalent to
27-300/405mm in full-frame format).
Nikon's £585 AF-S 18-200mm
f/3.5-5.6G VR Ilis worth checking

out, but don't write off independents
such as the £320 Sigma 18-250mm
/3.5-6.3 DC OS HSM or highly rated
£330 Tamron 18-270mm f/3.6-6.3 Di
I1VC PZD.

Backpack

You'll be working with a fairly small
kit so there’s no need toinvestina
giant backpack. A “Zoomster' case
foryour SLR and lens like the £43
Think Tank Photo Digital Holster
20 may be okay but a backpack

is better. Models like the £145
Lowepro Flipside Sport are ideal
as they hold your kit, plus have

a section for snacks and spare
clothes, plus a laptop pocket.
Also consider the £90 Vanguard
UP-Rise 45 and the £50 Lowepro
CompuDay Photo 250.

1) The landscape novice

Soyou fancy yourself as the next Joe Cornish or David Noton? You're probably drawn to the

landscape by a general love of the great outdoors but have never taken more than snapshots
while out on walks or enjoying other pursuits. Now you've added photography to your list of

other hobbies it's time to up the ante. Here's a rundown of what you'll need to do just that...

Entry-level
APS-C digital SLR

There are no poor DSLRs or CSCs —
even the least expensive models give
you fantastic image quality — so don't
worry if your budget won't stretch

to a pro-spec model as you really
don't need one. What you do need is
arelatively compact and lightweight
DSLR that you can carry around all day
and not notice, that's quick and easy
to use and has the features to let you
gradually take more control as your
knowledge and experience grows.
Models to consider include the £370
Nikon D3200, £600 Nikon D3300 and
the £600 Nikon D5200.

Memory cards

You'll have to be quite shutter-happy
tofilla4GB card, even ona good
day, so one in the camera should

be more than enough — though it's
worth carrying a spare 4GB card just
in case you get carried away.

Remote release

When your camera’s mounted on
atripod, firing the shutter with your
finger can cause shake. Avoid it with a
remote release that plugs into a socket
on the side of your camera. Go fora
basic model from Hama, Yongnuo or
Hahnel. The £25 Hahnel 280 Remote
Shutter Release is a great choice as
your first remote.

Basic outdoor clothing

If you plan to be outdoors all day, you
need to make sure you're suitably
dressed for the elements. The £25
Sprayway Explore Tee is a comfortable
base layer, while the £68 Paramo
Challenger is lightweight, reversible
and offers excellent protection from
wind and rain.

Tripod

You may not like the idea of carrying a
tripod around, but trust us, it is worth
the effort — especially when you're
shooting in low light at dawn or dusk.
It's far better to use a tripod and set a
low ISO rating for high image quality
than trying to handhold at high ISO.
Decent models to consider include
the £120 Velbon Sherpa+ 630 and the
£150 Slik Pro 700DX.
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2) The advanced enthusiast

Soyou've been shooting seriously for
two or three years now, you've picked up
a lot of knowledge and experience along
the way and yourimages are pretty
good. Family and friends are asking you
for prints for the walland you're feeling
pretty confidentabout your
photography, so the time has come to
upgrade your landscape kit. Here's the
gear that you might wantto consider...

Remote release

Adecent remote release is a must. You could stick
with a corded release, like the Hahnel 280 Remote
Shutter Release shown on the previous page.
However, you might also want to consider a wireless
remote too, such as the £50 Hahnel Combi TF. As
well as offering a four-second timer, it can be used in
the studio to fire your flash system, making it a better
choice if you also shoot portraits.

ND grad filters

When shooting landscapes, the sky is almost always
brighter than the land so when you expose for the
land, the sky blows out and looks horrible. The
quickest and easiest way to avoid this is to pop an
ND grad filter on your lens. A 0.6ND (two-stop) grad
is fine for general use, while the 0.9ND (three-stop)
grad is better at dawn and dusk. Cokin’s Z-Pro ND
grads cost £50 each, while Hitech's ND grads cost
from £50 upwards for its 100mm filters.

Filter system

Although you could still get away with using a Cokin
P-system holder with lenses as wide as 14mm, the
fact that you've bought an ultra wide-angle zoom
will probably be encouragement enough to go for
alarger 100mm system. Lee Filters will probably

be over your budget, but the Cokin Z-Pro system

or Hitech 100mm system are a more affordable
alternative. Holders cost around £50 each and

Tripod and head

Serious landscape photography means using
atripod all the time, so go for a well-made and
sturdy model that's going to last, butisn't so big

and heavy it's a chore to carry. The £250 Manfrotto
190CXPRO3 is a worthy contender as is the £190
Giottos MTL 8261B. Both will need a head unless you
buy them in kit form. The £55 Manfrotto 804RC2
head is an excellent option, as is the

£55 Giottos MH5001 three-way head.

Backpack

It's worth investing in a decent backpack that will
take all your gear, offers a good degree of weather
resistance and is comfortable to carry when walking
long distances over rough ground. The Lowepro
Vertex 100 AW is an older model but a great buy

if you can find it. Also consider the £200 Tamrac
Expedition 7x and £90 Lowepro Flipside 400 AW.

adaptor rings are under £20 each. 4
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Top-end APS-C digital SLR

You want the best that you can afford in APS-C
format so that you can produce top quality images
and print the files to 16x12in or bigger, without
worrying about them looking unsharp or grainy.
Nikon offers a decent choice of models. The £800
Nikon D5300 is one of its newest models and
boasts 24.2-megapixels. A more robust option

is the excellent Nikon D7100, a 24.1-megapixel
model that's more expensive at £1,110 body-only
but a far tougher model.

Standard zoom

If you've been using a kit zoom up to now, it's
time to upgrade to a quality standard zoom. Focal
lengths around 16mm are ideal for general use

as they're wide enough to produce dramatic
compositions. Around 35mm you'll get a similar
angle of view and perspective to the human eye,
while 50mm and beyond takes you into short
telephoto territory. Digital SLR Photography ran a
comparison test of standard zooms and rated the
£440 Nikkor AF-S DX 16-85mm f/3.5-5.6G ED VR
as a Best Buy. If that's a bit too pricey, then check
out the Tamron 17-50mm f/2.8 Di ll VC XR, which
received a Highly Rated accolade.

Sereen proteetor

If you want your DSLR’'s monitor screen to do its
job properly, it needs to be kept in good condition,
so buy and fit a screen protector. The plastic
clip-on variety available for some cameras are
okay but are rather on the thick side and with a
tendency to take on a ‘frosted’ look after a while.
Self-adhesive protectors, like the £6 protector by
Hama, are actually better options and also a lot
more wallet-friendly.

Proteetive elothing

Comfort and protection is a must when your
jobinvolves being out in all weather shooting
landscapes - if you get wet and cold you won't
perform at your best and your work will suffer.
Thankfully, technical outdoor clothing is better
than ever so there’s no excuse for getting caught
out. In addition to wearing layers to trap heat
and keep you warm, plus a hat to stop heat loss
through your head, a breathable waterproof
outer layer will protect you from both wind and
rain. Regardless of whether you're a beginner,
enthusiast or serious landscape photographer,
the need to stay dry and warm is the same. Brands
to consider include Paramo, Berghaus, The
North Face, Mountain Equipment, Sprayway and
Mountain Hardwear, among others.

The £190 Velez Adventure Smock offers one
large kangaroo pocket, which can fitan OS map
or filters. It's a short, comfortable waterproof top
that's also light in weight. As with other Paramo
waterproofs, the Velez Adventure pumps away
perspiration so that when you stop, you don't get
cold as you don't have any liquid close to your skin
cooling you down.

While a pair of jeans are ideal for everyday
use, they're not a good choice when you're
spending a day out shooting as they're not
weatherproof and will become clammy and
heavy should you get caught in a shower. You
are far better off wearing rainpants, which are
comfortable, durable and above all waterproof.
Shown here are the £40 Sprayway Havana pants,
which offer a decent budget option.

Inthebag...

1) ULTRAWIDE-ANGLE ZOOM

Though you still tend to reach for your
standard zoom first, it's worth adding

an ultra wide-angle zoom to your kit as
well so you can start to experiment with
dramatic compositions, exploiting lines and
foreground interest and creating images
with a powerful sense of depth and scale.
This s likely to become your standard

lens as you discover its benefits so make
sure you buy a good one. The £370 Sigma
10-20mm f/4-5.6 EXDC HSM and £460
Sigma 10-20mm /3.5 EXDC HSM are
good independents, while the Tokina AT-X
12-28mm f/4 Pro is even better. The £640
Nikkor AF-S 10-24mm f/3.5-4.5 DX ED
delivers a great performance too.

2) TELEZOOM

You won'tuse a telezoom as much but it's
worth buying one to compress (great in
misty weather), reduce depth-of-field and to
fill the frame with details in the landscape. A
70-200mm is effectively a 105-300mm with
APS-C sensors, while a 70-300mm equates
t0 105-450mm — more than powerful
enough. Check out the £100 Sigma
70-300mm f/4-5.6 DG Macro, £150 Sigma
70-300mm f/4-5.6 DG APO Macro, £280
Nikon AF-S 55-200mm f/4-5.6 DX VR and
£290 Tamron 70-300mm f/4-5.6 USD VR.

3) MEMORY CARDS

Though most shoots only last a day, you
are venturing further afield and spending
weekends on location, so you need extra
cards. If you have four good days you could
easily shoot 20-30GB of Raw files, so carry
at least five 4GB cards.

4)HOOD LOUPE

Viewing images on your digital SLR’'s
preview screen can be tricky in bright

light and though you can resort to pulling
your jacket over the camera or cupping
your hands, the best solution is the £78
Hoodman Loupe as it always gives a bright,
distortion-free 1:1 view.

5) DEPSSICARD

Itonly costs £2.99, but this handy accessory
helps pinpoint the location of sunrise and
sunset throughout the year — just align

the card with True North and read off the
indicator. Turn the card over and you've

got a hyperfocal distance chart that tells
you where to focus your lens to maximise
depth-of-field.

6) ND FILTERS

Use ND filters to increase exposures when
shooting moving water to record that lovely
blur effect. The Cokin Z-PRO NDs will set
you back around £34 each and the ND4
and ND8 will be the most useful. Hitech’s
ND filters cost around £25 each.

7) POLARISER

A polarising filter will deepen blue sky,
reduce glare so colours appear richer, cut
through haze and eliminate reflections.
The £249 Cokin Z-PRO polariser is the
ideal choice for use with the Z-PRO filter
system, while Hitech's costs £130. If you
can't stretch to a slot-in polariser, consider
screw-in circular polarisers. Hoya offers
an excellent range of polarisers, prices vary
according to size, but expect to pay around
£65 fora 72mm or 77mmfilter.
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3) The semi-pro/pro

Making a good full-time living from landscape
photography is very difficult, but some manage it
by diversifying — shooting stock images, selling
prints, self-publishing cards and calendars,
writing books and magazine articles and leading
workshops. Semi-pros combine profitable
photography with other ways of making money.
Either way, if you fall into this category or want to,
you're going to need gear that can withstand
regular and sustained use in harsh conditions.
Think of itas an investmentin your future...

Glass polariser

If you've invested in a Lee Filters kit, you might as well
complement it with a top-quality polariser. The £220 105mm
Lee circular polariser attaches to the Lee filter holder via an
optional £33 105mm adaptor ring. However, the polariser

has a deep mount so if you use ultra wide-angle zooms or
lenses, consider a slimmer polariser, such as the expensive but
optically superb £230 Heliopan Kasemann.

Ultra wide-angle zoom

Focal lengths from 16-35mm on a full-frame digital SLR are
invaluable for landscape photography. An ultra wide-angle
zoom is therefore likely to be your standard lens, so make sure
you buy the best there is. From Nikon, the £1,300 AF-S 14-24mm
f/2.8G ED has a great reputation but unless you splash out on an
expensive holder, you'll have trouble using filters. More practical
is the £830 AF-S 16-35mm f/4G ED VR, which won a Digital

SLR Photography Best Buy award when tested in the magazine.
Alternatively, if you're on a budget try the £650 AF-S 18-35mm
f/3.5-4.5G ED, which scored a Highly Rated in the same test. Also
worth a look is the excellent Sigma 12-24mm f/4.5-5.6 Il DG HSM,
which also scored Highly Rated in the test.

Filter system

There's only one filter system that pro landscape photographers
use: Lee Filters. It has no rivalin terms of versatility and quality
and, though expensive (the basic holder is £55 and adaptor rings
£19-£55), it's built to last. More importantly, the 100mm wide
holder comes as a kit and can be set up with anything from one to
three filter slots, allowing you to adapt it for use with wide-angle
lenses. Fit two slots and you'll get vignette-free images with focal
lengths as wide as 16mm on a full-frame DSLR. There's also an
SW150 system for use with the Nikkor 14-24mm and other ultra —
wide-angle zooms that have a protruding front element.

Tripod head —

Tripod legs are only as good as the head you attach to them, so don't
blow your entire budget on fancy pins. A good, solid head is the £55
Giottos MH 5001 head - it's well-made and ideal for both single
shots and sequences for stitched panoramas. If you prefer ball heads,
professional photographers love Arca Swiss and Really Right Stuff.

Tripod

Asolid, sturdy tripod that will keep your heavy full-frame DSLR/
zoom combo stillin high winds is essential. Carbon-fibre is
common now amongst today’s tripods, with Gitzo being the
most popular brand with pros. Check out the £600 GT3541
Mountaineer. If you don't like the Gitzo's twist leg locks, consider
the £220 Manfrotto 055CXPRO3. If weight and space are a major
issue, then two models that will appeal are the £210 Giottos Silk
Road YTL 8354 and the £250 Giottos Vitruvian VGR8255, both
designed with travel photographers in mind.
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Full-frame DSLR

In pre-digital days, medium- and large-format film
cameras were the weapons of choice among pros,
but now medium-format quality can be achieved
using a full-frame DSLR, so it has become standard
issue. Image quality aside, top-end full-frame DSLRs
also boast excellent build quality, including full
weather-sealing, so they can cope with daily use in
extreme weather conditions and not even flinch.
Rain, snow, wind, sand, volcanic ash — you nameit.
Avoid flagship models, there are more affordable
full-frame DSLRs to choose from. The £1,800
24.3-megapixel Nikon D610 is a brilliant option.
However, for even higher resolution, consider the
36.3-megapixel D800 (£2,600) or £2,900 D8OOE,
which does away with the Optical Low Pass Filter.

Glass screen protector

The rear screen on your DSLR will come in for some
punishment so protect it with a £25 Giotto's Aegis
Pro Glass screen protector. You won't know there’s
a screen protector there at alland you can clean it as
often as you like, safe in the knowledge that the real
screen beneathiitis as good as new.

Remote release

Although you can get away with using a basic remote
release, being a pro you might want to splash out on
something a bit fancier, like the £130 Nikon MC-36.

It can be pre-programmed to make long exposures
— handy if you use a ten-stop ND filter or shoot
sequences of images at set intervals, which is useful
for star trail photography. A cheaper option that has
pretty much every facility you'll need is Hahnel's
feature-packed £60 Giga T Pro Il.

Ultimate outdoor clothing

It's well worth investing in quality waterproof clothing
if you plan to regularly shoot outdoors. Paramo's
£300 Halcon jacket has nine pockets, including large
pockets that can fit most filter systems (including
Lee), with plenty of room for batteries, memory cards
and other accessories. Shown is the best-selling £115
Paramo Cascada trousers, which offer full weather
protection and excellent comfort. You can further
preserve body heat by wearing a woollen hat from
outdoor brands such as Patagonia or Berghaus.

Sensible footwear

When you spend hours on your feet and regularly
walk miles over rough terrain — allin a day’s work for
alandscape pro — you need a decent pair of boots
that are comfortable, warm and protective. Check
out boots by The North Face, Asolo, Meindl, Berghaus
and Solomon. When shooting on boggy terrain, near
water or on beaches, a good pair of wellies is far more
useful as they will keep your feet bone dry. Aigle and
La Chameau are reputable brands to try.

Backpack

Invest in a backpack that's big enough to house all
your camera kit as well as have extra space for maps,
food, water, spare clothes — and is weather resistant.
Lowepro is the brand of choice among landscape
pros and one of the best packs is the £120 Pro Runner
450AW. Styled like a traditional rucksack, it has loads
of features including mesh side pockets, fully padded
interior and a laptop compartment. Also check out
top-end models from Vanguard, Kata and Tamrac.

Inthebag...

1) Fast standard zoom

A zoom from moderate wide to short
telephotois a vital part of the pro
landscaper's kit. Go for one with a fast f/2.8
maximum aperture so you get a bright
viewfinderimage. The £1,300 Nikkor AF-S
24-70mm f/2.8G ED is one of the sharpest
zooms around but it's expensive. Tamron’s
SP 24-70mm f/2.8 Di VC USD is worth
consideration ataround £850 Il lens,

while Sigma'’s 24-70mm /2.8 EX DG HSM
costs around £600.

2) Telezoom

Though it's likely to be your least-used
lens, a telezoom is still worth having for
compressing perspective and shooting
details in a scene. Nikon boasts two fast
premium telezooms - the £1,610 AF-S
70-200mm f/2.8G ED VR Il or the £1,100
AF-S70-200mm f/4G ED VR. Sigma'’s
£90070-200mm /2.8 EXDG OS HSM
boasts a Digital SLR Photography Best Buy
award, while the £1,100 Tamron SP 70-
200mm /2.8 Di VC USD scored a Highly
Rated accolade.

3) Back-up DSLR

If your budget will run to it, a second body
is worth having just in case your main one
decides to malfunction or you damage iton
location. In the ideal world you'd have two
of the same model but realistically, a good
safe option is an enthusiast-level APS-C
DSLR like the £1,100 Nikon D7100.

4) Spare batteries

Goes without saying really — nothing worse
than running out of batteries in the middle
of nowhere when the light's great. Always
set out with two fully charged batteries. As
well as branded batteries, Delkin, Hama and
Hahnelall offer alternatives.

5) Memory cards

Trips away can last a week or more and with
you shooting every day from dawn to dusk
when the weather plays ball, you'll soon start
filling up your memory cards. Downloading
full cards to a laptop is a daily routine, but if
you prefer not to reformat cards until you're
home, then carry at least 50GB of capacity,
in other words six or seven 8GB cards.

6) NDfilters

As well as your ten-stop ND filter, it's worth
carrying a couple of weaker NDs so you can
use slower shutter speeds when shooting
waterfalls and rivers to capture motion. A
polariser can be used like an ND filter as it
loses two stops of light (equivalent to an
0.6ND), but also add 0.9ND (three-stop)
and maybe 1.2ND (four-stop) as well so you
have more options. Lee Filters

ProGlass NDs cost around £110 each.

7) Ten-stop ND Filter

No self-respecting pro would be without
one. Go for the £130 Lee Big Stopper or
the B+W 3.0ND screw-in filter. Prices vary
depending on the filter size — for example,
a 52mm filter costs around £41, while a
77mm costs £130.

8) ND grads

The most useful filters of all for landscape
photography are Neutral Density (ND) grads
as they allow you to produce a well-exposed
landscape and a well-exposed sky in one
shot, in-camera. Investin a £200 ND grad
set from Lee Filters, which contains 0.3, 0.6
and 0.9 density grads, and we advise going
for the hard grads rather than soft grads as
they're more effective and easier to use.

9) Piece of card

A sheet of 10x8in stout card is handy to use
as a lens shade when shooting in strong
sunlight, to shield the front end of the lens
and prevent flare. A lens hood would do
that, but when using a filter holder, the
hood that came with the lens obviously
won't fit!

10) Sensor cleaning kit

You may not want to carry it in your
backpack, but keep a kit in your car. It's worth
having access to a decent sensor cleaning kit
in case you should need it, such as the £75
Arctic Butterfly 788 Brite sensor brush.

11) AppleiPhone4sor5

Not only invaluable for keeping in touch,
and taking decent photos with its eight-
megapixel camera, the Apple iPhone 4Sisa
powerhouse of technology. For example, if
you take reference shots using the camera,
you can pinpoint their location on Google
Maps by tapping the Places option in the
Camera Roll. The Apple iPhone’s GPS
capability lets you know exactly where your
landscape shots are taken, so you can find
your way back to the same spot — or share
the information with others. You can also
download the app The Photographer’s
Ephemeris (http://photoephemeris.com),
which allows you to establish the time and
direction of sunrise and sunset anywhere in
the world.
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Types of wide-angles

There are three maintype

lenses available, each offering its own

prosand cons. Here, we e
virtues of each...

1) ULTRA WIDE-ANGLE ZOOMS
This group of lenses has
become increasingly popular.
That's no surprise as the range
they cover offers incredible
versatility in such a smalland
inexpensive lens. In fact, the
ultra wide-angle zoom is
arguably one of the best value
lenses you could own, which is
why we've concentrated our series
of tests on this type of wide-angle.
There are a variety of focal lengths
available, with those around 11-
22mm being the most suitable for
cameras with an APS-C sized (DX-
format) sensor. In truth, all cover a
very similar range, although there
are one or two exceptions. The
most noteworthy is the Sigma
12-24mm, which is designed

to be used on both full-frame
(FX-format) and APS-C cameras.
Finally, while the 16-35mm lens

is popular for use with full-frame
sensors, the 24-53mm range

it covers when fitted toa DSLR
with an APS-C sensor is a little
limited, so we'd suggest you look
for zooms with a wider coverage,
suchasa10-24mm.

sofwide-angle

xplain the

= 4

2) FIXED WIDE-ANGLES

Small, lightweight and compact,
with high-quality optics, these

are very desirable lenses that are
available in various focal lengths
and have been designed to offer the
ultimate in wide-angles for digital
photographers. They start with the
ultra wide-angle 14mm, whichis
particularly suited to architectural
photography, when trying tofill the
frame with a building from a short
distance. Wide-angles from

20mm to 28mm are ideal for
landscape photography and are
also used by travel photographers.
However, their use with cameras
sporting an APS-C sensor is limited,
especially as a standard kit lens
covers thisrange.
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3) FISHEYE LENSES
The fisheye offers the most
extreme field-of-view. There are

two types — the circular and the
full-frame fisheye, both producing
very different results. Circular
fisheye lenses, when used on a
full-frame camera, provide round
images with a 180° angle of view.
They distort perspective, especially
when the subject is close and, with
close-focusing capabilities, are
perfect for comical portraits. The
full-frame fisheye (also known as a
diagonal fisheye) offers a 180° field
of view and can capture incredibly
wide vistas. They're very specialist,
very expensive and have limited
use, so hire one from a pro dealer
before you buy.

Why use a wide-angle?

Ever wanted to photograph a subject or a scene and found that you can't fit it all in the frame? Then you
need a wide-angle lens. With a field-of-view that extends far wider than the human eye, it's the perfect
optic for capturing wide vistas or cramming large objects in the frame. Using such a lens comes at the
price of characteristics like exaggerated perspective and distortion, but knowing what to expect and
how to use it creatively allows you to take shots that aren't possible with any other type of lens.

Understanding focal lengths: Wide-angles

The focal length stated on a lens usually relates to cameras using 35mm film or full-frame sensors. If
your camera has an APS-C sized sensor, then you're effectively cropping the image and so giving the
effect of a longer focal length lens. The chart below shows popular wide-angles and how the effective
focal length changes when matched with popular sizes of sensor on interchangeable-lens cameras.

- APS-H APS-C (DX) APS-C (Canon) | Four-Thirds
[ 13 15« [1ex x|

Focal length
onlens Full-frame (FX)

8mm 8mm
14mm 14mm
15mm 15mm
20mm 20mm
24mm 24mm
28mm 28mm
10-17mm 10-17mm
10-20mm 10-20mm
10-22mm 10-22mm
11-18mm 11-18mm
12-24mm 12-24mm
16-35mm 16-35mm
17-35mm 17-35mm
17-40mm 17-40mm

10mm 12mm 13mm 16mm
18mm 21mm 22mm 28mm
19mm 22mm 23mm 30mm
26mm 30mm 32mm 40mm
31lmm 36mm 38mm 48mm
36mm 42mm 45mm 56mm
13-22mm 15-25mm 16-27mm 20-34mm
13-26mm 15-30mm 16-32mm 20-40mm
13-29mm 15-33mm 16-35mm 20-44mm
14-23mm 16-27mm 18-29mm 22-36mm
16-31mm 18-36mm 19-38mm 24-48mm
21-45mm 24-53mm 26-56mm 32-70mm
22-45mm 25-53mm 27-56mm 34-70mm
22-52mm 25-60mm 27-56mm 34-80mm

1) Petal hood Ultra wide-angles
come supplied with a dedicated
hood to avoid vignetting and flare.
2) Large, concave front element
The front element normally has a
prominent curve, leaving it exposed
to dust and scratches, so take care
to keep it covered in transit.

3) Manual focus ring Normally it's
towards the front of the lensand is
reasonably wide. You'll rarely need
to useit, as wide-angle lenses have
excellent autofocus.

4) Zoomring This is normally found
towards the back of the barrel. Most
are wide with a grooved surface to
allow you to grip it easily.

5) Focus distance Many lenses have
the focus-distance scale marked on
the barrel, while some of the more
upmarket models have a focus-
distance window.

6) Hyperfocal scale (see inset) This
scale allows you to estimate how
much of the scene will appear
sharp at your choice of aperture.

7) Internal focusing If you're
planning to use filters, lenses

with an internal focusing system
have the benefit of the front of the
lens not rotating when focusing,
so you don't have to keep
readjusting them.

Digital-only lenses

When choosing a lens, checkit's
suitable for the sensor size of your
camera. Some are for use with
APS-C sensors only, while others
are designed for both full-frame
and APS-C sensors. Manufacturers
have designations for each type.
These include: Nikon DX (APS-C)
and FX (full-frame & APS-C); Sigma
DC (APS-C) and DG (full-frame &
APS-C); Tamron Di ll (APS-C) and
Di (full-frame & APS-C).
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How we test
thelenses

OURTESTS LOOK at the key factors
influencing image quality — sharpness,
distortion, chromatic aberrationand
vignetting. We also test performance of the
AF and image stabiliser (IS) systems. For IS, we
use an oscillating platform custom-made to
mimic handholding the lens. The platform’s
greatvirtueis thatit'san absolutely standard
test, soall lenses are tested in exactly the
same way for accurate comparisons.

® Sharpness: What we call sharpnessis a
combination of resolution (the fineness of
details) and image contrast (how clearly
those details are shown). Resolution and
contrast are directly linked and when one
goes up, the other goes down. We use
Modulation Transfer Function (MTF) analysis
to measure sharpness, as do lens
manufacturers. Results are shown as % MTF
at 24 lines-per-mm for full-frame lenses and
at 36 lines-per-mm for APS-C to adjust for
the crop factor, so sharpness is generally
slightly lower than full-frame, in line with
actual use. Multiple readings are taken and
averaged, and edge readings are taken from
points 1-2mm from the sensor edge. Peak
resolution shows maximum cpmm at 20%
MTF, which is the lowest level where light
and dark tones can be reliably measured,
though the difference is faint.

Unlike most lens test procedures that use
arelatively small test target that often has to
be shot atvery close range, eg wide-angles,
we use multiple individual targets of different
sizes to keep distances realistic. A focusing
wedge ensures absolute accuracy and
automatically adjusts for field curvature and
focus shifts that can skew other methods.
ANikon V1 cutomised for Nikon DSLR lenses
is used with a precision custom adaptor to
position any area of the testimage over the
centre of the sensor. This provides both a
level playing field and also an extremely high
resolution (equivalent to 74 megapixels on
full-frame) to ensure the camerais never the
limiting factor.

® Distortion: Distortion makes straight
lines towards the frame edges appear
curved. It changes with focal length and is
less noticeable on APS-C. Barrel distortion
lines curve outwards (indicated as a positive
percentage value, eg +1.5%); pincushion
distortion curves inwards (indicated as a
negative value, eg -0.5%). The lower the
stated figure, the better: 1% or less is good,
2% or more being increasingly noticeable.

@ Vignetting: Vignetting is darkening
towards the corners. It changes with focal
length and is also less prominent on APS-C.
Vignetting reduces quickly as the aperture is
closed down. It's easily removed in
post-processing, but when it's strong this
results in greater noise. Vignetting is
measured in Exposure Values (1EV equals
one stop). -1EV is usually not a problem.

Vignetting: Progressive darkening to corners

® Chromatic aberration: Also known as
CA or colour fringing, is usually only slightly
reduced at higher f/numbers, and is more
noticeable on APS-C format due to the crop
factor. Distortion, vignetting and CA can all
be substantially reduced or eliminated with
post-processing software.

@ Autofocus: Autofocus speed and
accuracy is a game of two halves — half
camera, half lens. On the lens side of things,
most of the differences relate to the
mechanics and build quality, and this is
commented on in the reviews.

®Image stabilisation: We use an
oscillating platform, custom-made to hold a
DSLR body in place and mimic handholding
characteristics, and in our testing it has
proved very realistic. The platform’s great
virtue is that it's an absolutely standard test.
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Lens terminology

® AF motors

Micro-motors are the older and more
conventional type of system used to
focus lenses and remain a fast and
reliable option. Better still are motors
using ‘'sonic waves' to rotate the lens,
which are faster and quieter. Most
brands now offer lenses that boast
sonic motors that are faster, quieter
and far more responsive. These
include: Nikon's Silent Wave Motor
(SWM) used in its AF-S series of lenses,
Sigma'’s Hypersonic (HSM) Motor and
Tamron Ultrasonic Silent Drive (USD).
All perform brilliantly.

® Aspherical lens element
High-quality elements designed to
improve performance, particularly
towards frame edges. Aspherical lens
elements are usually made from glass,
but there are also many moulded
glass/plastic hybrid elements, too.

@ Image stabilisation

Many lenses have a ‘floating’ element
linked to sensors that move it to
counteract movements when
handholding. Most brands offer
lenses with lens-based stabilisers.
They include: Nikon’s Vibration
Reduction (VR), Sigma's Optical
Stabiliser (OS) and Tamron's
Vibration Compensation (VC).

@ Internal Focusing (IF)

Also called inner focusing, this system
rotates elements within the lens
during AF so that the front of the lens
doesn'trotate. This is useful when
using filters as you don't have to
adjust filters after AF. Most ultra-wide
zooms use internal focusing.

® Premium glass elements
High-quality elements ensure the
best possible image quality, delivering
maximum sharpness, superior colour
reproduction and contrast, and
minimal chromatic aberration.
Common types include: Nikon ED
(Extra-low Dispersion), Sigma
Extraordinary Low Dispersion (ELD) &
Special Low Dispersion (SLD), Tamron
Extra Refractive (XR).

How to read the lens sharpness graphs

Our bar graphs provide you with a visual
representation of lens sharpness. Each
graph shows the centre and edge
performance of the lens at full f/stops from
maximum aperture to f/16 at different focal
lengths of the zoom. Centre sharpness is
shown inred; edge in green. The higher the
bar, the better the sharpness, with ratings as
follows: Below 10: Poor; 10-29: Fair; 30-49:

Good; 50-69: Very good; Over 70: Excellent.

Allour lens test analysis is performed using
Imatest software.

Lens Sharpness (%): Full-frame Centre Edge
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®Nikon AF-S18-35mm
f/3.5-4.5GED

HANDLING: This Nikon proves to be very light,
especially when compared to the Nikon
16-35mm f/4G. Manufactured in China, it
weighs very little, thanks to an extensive use of
plastics. Those are interesting rather than
significant points though, and don't reflect on
quality. There is a tiny bit of play in the manual
focusing ring, but not as much as the more
costly Nikon 16-35mm, made in Japan.

FEATURES: 12 elements in eight groups, with
ED glass and aspherical elements as usual. The
maximum aperture varies with focal length, and
f/3.5 at the 18mm end is one-third of a stop
faster than f/4, and f/4.5 at 35mm is one-third
of a stop slower. AF uses the Silent Wave Motor
with full-time manual override, filter size is
77mm, lens hood supplied.

AUTOFOCUS: Silent Wave Motor focusing
works quietly and efficiently. It's not quite the
fastest mover in town, though we're talking
fractions of a second here and you'd never miss
ashot because of it.

PERFORMANCE: At the important business of
sharp imaging, this lens excels. On full-frame,
the centre starts well into the excellent zone
and never goes below that standard at any time,
while the edges only dip just under it at the
highest f/numbers due to diffraction. The parity
between centre and edge is exceptionally
good. On APS-C, the higher resolution
demands of the smaller format naturally
depress the MTF figures, though no more than
expected and very much in line with other
similar lenses. For pixel-peepers seeking
ultimate resolution, the Nikon 18-35mm
peaked at 103 lines-per-mm in the MTF 20%
test. That's slightly lower thanrivals, though to
put things in context, even the mighty Nikon
D800 with 36-megapixels can ‘only’ resolve a
theoretical maximum of 102 lines-per-mm so
the lens is unlikely to be a limiting factor.

Onthe aberrations front, distortion,
vignetting and CA are plentiful, but no more so
than is typical for this type of lens. Fortunately,
all these things can be cleared up in post-
processing, usually with a mere mouse-click in
software like Lightroom that provides
automatic customised corrections. Indeed
many lenses are produced with software
correction in mind, giving lens designers more
scope to improve optics in other areas.

VERDICT: Introduced just a few months ago,
this Nikon G-series lens is a complete overhaul
of the older 18-35mm D-version, with all-new
optics and integral SWM autofocus. Its build
quality is high-end consumer grade rather than
pro-spec, though optically this lens is certainly
top drawer. Thankfully this lens has now
dropped more than £100 in price since its
launch, which means it offers much better
value to match its performance.

HANDLING
FEATURES
PERFORMANCE

19/20
16/20
36/40
16/20
87/100

VALUE FOR MONEY
OVERALL

DISTORTION (Full-frame) Poor DISTORTION (APS-C) Poor
VIGNETTING (Full-frame) Good VIGNETTING (APS-C) Excellent
CHROMATIC AB (Full-frame) Very good CHROMATIC AB (APS-C) Good

Nikon AF-S 18-35mm f/3.5-4.5 (full-frame) Nikon AF-S 18-35mm f/3.5-4.5 (APS-C)

Lens Sharpness (%): 18mm (FF) Centre Edge

Good V.good

Fair

Poor

Centre Edge
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Lens Sharpness (%): 18mm (APS-C) Centre Edge

Good V.good

Fair

Poor

Centre Edge

Good V.good

Fair

Poor
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®Nikon AF-S16-35mm
f/AGEDVR

HANDLING: This lens is considerably larger
than its 18-35mm sibling and getting on for
double the weight too. It handles beautifully
and is extremely well made, exuding class.
Zoom and focus rings are one-finger light,
though there was a bit of play in the manual
focusing ring of our review sample.

FEATURES: The headline here is VR image
stabilisation — afirst for a lens of this type. This is
at least partly responsible for the extra weight of
17 elements in 12 groups, with a generous
sprinkling of premium glass and aspherical
surfaces. Aperture is a constant f/4 and
compared to the Nikon 18-35mm, that little bit
wider focal length at 16mm adds a useful 7°
more coverage. It's also weatherproofed.

AUTOFOCUS AND VR: Nikon's SWM AF is
particularly impressive here, so fast and quiet
you hardly know it's working. Top marks for
that. The VR has a claimed four-stops
effectiveness and that was borne out at longer
focal length settings. The difficulty at the wider
end is four stops below the normal
handholding threshold means very long shutter
speeds around one full second when there are
not only shaky hands to combat, but also some
body sway that's beyond the scope of any
stabilisation system. Either way, it's certainly
possible to handhold this lens at some
crazy-long shutter speeds.

PERFORMANCE: Very sharp indeed, recording
the highest peaks here. On full-frame at 16mm
and 24mm, the centre is nudging 90% at f/4
with edges also well into the excellent zone.
Sharpness drops a little at 35mm, particularly
at the edges, thoughiit's still very high.
Resolution peaked at an impressive 120
lines-per-mm at MTF 20%.

Distortion is the weak point with this lens,
particularly at 17mm with heavy barrelling of
over 4%. For critical subjects like architecture,
correction in software is essential. On the other
hand, figures for both vignetting and CA were
the best, even if a more accurate description
would be the least poor. No super-wide zoom
is atall good on these aspects of performance,
especially at the wide end. To be fair, though,
distortion is much reduced at longer focal
lengths, and vignetting almost goes away at
mid-range apertures.

VERDICT: Without any doubt, Nikon has done
a fine job with this ultra-wide zoom lens,
incorporating Vibration Reduction into a very
high-grade optical package, even if it has to be
said that the benefits of VR diminish as focal
lengthis reduced, and this is one very wide lens.
The weatherproofing is always welcome,
though, and is a sure sign of pro-standard build
quality, inside and out. If all these aspects of
performance are important to you, and the
extra weight isn't too much of a problem, the
price is well worth paying.

HANDLING
FEATURES
PERFORMANCE

18/20
20/20
38/40
18/20
94/100

VALUE FOR MONEY
OVERALL

DISTORTION (Full-frame) Poor ' DISTORTION (APS-C) Poor
VIGNETTING (Full-frame) Good VIGNETTING (APS-C) Excellent
CHROMATIC AB (Full-frame) Very good CHROMATIC AB (APS-C) Good

Nikon AF-S 16-35mm f/4 (full-frame)

Lens Sharpness (%): 16mm (FF)

Centre Edge

Centre Edge

Good V.good

Fair

Poor

Centre Edge

Nikon AF-S 16-35mm f/4 (APS-C)

Lens Sharpness (%): 16mm (APS-C) Centre Edge

Centre Edge

Good V.good

Fair

Poor

Centre Edge
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®Sigma 12-24mm
f/4.5-5.6 I DGHSM

HANDLING: This is a well-made lens, with
Sigma'’s newer smooth black surface finish
that's more resistant to marking than the older
matt black. It's moderately heavy, and both
focus and zoom rings are well weighted and
silky smooth.

FEATURES: Standout feature is the mega-wide
zoom, which goes down to an incredible
12mm. This is way wider than anything else —
in fact, it's the widest rectilinear (non-fisheye)
lens of any kind made for full-frame. At 122°,
the field-of-view is a whopping 15° more than
the second widest lens here, the Nikon
16-35mm. The flipside of that is the focal
length at the longer end only extends to
24mm, and another downside is the bulbous
front element that prevents the use of normal
filters. There are specialist grad filter kits
available (eg Formatt Hitech), but they're both
enormous and costly, so you'd best bone up
onyour HDR technique as an alternative —
some prefer itanyway.

AUTOFOCUS: With so much depth-of-field
available, the Hypersonic AF system doesn't
have much to do, but it works very quietly and
efficiently, so you won't have any problems.

PERFORMANCE: Under the hood, there's a
whole stack of exotic glass and aspherical
surfaces, totalling 17 elements in 13 groups.
Just as well, as they have a hefty task managing
that vast angle-of-view, and delivering sharp
images without too much distortion, vignetting
and flare. Sigma has done a remarkable job and
performance is a lot better than you might
expect, in fact it stands shoulder to shoulder
with the best, despite its relatively low cost.

The modest maximum aperture, only f/4.5 at
12mmprising to f/5.6 at 24mm, givesita bit of a
head-start on the optical challenge, but even so
the lens is sharp, very sharp, hitting the excellent
standard right across a full-frame image from
maximum aperture. Only the edges lag a little at
the tele end, which isa common characteristic.
There's plenty of distortion, vignetting and
chromatic aberration, as there always is with
ultra-wides, but the Sigma'’s not any worse than
most others. Peak resolution is a high 118
lines-per-mm, recorded at 17mm /5.6 in the
centre. An area of caution is to watch out for
flare. Given the extensive field-of-view, areas of
sky and sun are bound to be included in the
frame, and the protruding front element
naturally falls victim to picking up specula
highlights. This is mostly inevitable, and more
something to be aware of than to worry about.

VERDICT: This is an amazing lens. In short, itis
sharp, built to a very high quality, has a smooth
operation and, all things considered, reasonably
priced. And at 12mm, the field-of-view is
incredibly wide, producing a unique style of
image unmatched by any other lens, zoom or
prime. Well worth consideration.

HANDLING 20/20
FEATURES 16/20
PERFORMANCE 36/40

VALUE FOR MONEY 18/20

OVERALL 90/100

DISTORTION (Full-frame) Poor DISTORTION (APS-C) Fair
VIGNETTING (Full-frame) Fair VIGNETTING (APS-C) Excellent
CHROMATIC AB (Full-frame) Good CHROMATIC AB (APS-C) Fair

Sigma DG 12-24mm f/4.5-5.6 (full-frame) Sigma DG 12-24mm f/4.5-5.6 (APS-C)

Lens Sharpness (%): 12mm (FF)

Centre

Centre

Edge
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Lens Sharpness (%): 12mm (APS-C) Centre Edge

Good V.good

Fair

Poor

Centre Edge

Good V.good

Fair

Poor
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®Nikon AF-S 10-24mm
f/3.5-4.5GDXED

HANDLING: Compact, light with smooth and
well-weighted controls. Good quality build —
made in Nikon's China plant.

FEATURES: Best zoom range in the super-wide
class for greatest versatility, though maximum
apertures are average. Has a rain-seal mount
gasket, and comes with a lens hood.

AUTOFOCUS: Silent Wave Motor is excellent as
usual, with full-time manual override.

PERFORMANCE: ‘Excellent’ levels of
sharpness in the centre at all focal lengths,
from f/3.5-4.5 and dipping down to ‘very good'
around f/8 as diffraction begins to bite. Edge
sharpness is lower, though comfortably within
the 'very good' band at all times, apart from at
the longer 24mm end that doesn't really get
going until f/8. Peak resolution is a little lower
than other comparative lenses we've tested, at
111 lines-per-mm. Distortion is high at 10mm
with a hefty +3.9%, though itimproves
dramatically at longer focal lengths and is close
to zero through most of the mid range.
Vignetting is low, rating ‘excellent’ overall, and
chromatic aberration control is typical of most
ultra wide-angles, in other words always
present and rating fair’.

VERDICT: Sharp, compact and light, great AF,
same maximum apertures and even more
useful focal length range. Edge sharpness at
24mm is the only weak spot, and the peak
resolution figure is slightly lower. It's quite
expensive at £640 though.

HIGHLY ,
RATED

DISTORTION: Severe barrel +3.9% at 10mm.
Overallrating: Good

VIGNETTING: Mild 0.9EVat10mmf/3.5.
Overallrating: Excellent

CHROMATICABERRATION: Reducesat
24mm. Overallrating: Fair

PEAKRESOLUTION: 111lines-per-mm
atMTF20%,10mmf/5.6 centre
HANDLING

FEATURES

PERFORMANCE

VALUE FOR MONEY
OVERALL

18/20
18/20
36/40
17/20
89/100

NikonAF-S10-24mmf3.5-4.5GDXED

Lens Sharpness (%): 10mm Centre Edge
100 =

Good V.good

Fair

Poor

®Nikon AF-S12-24mm
f/AGDXED

HANDLING: Effectively identical to the Nikon
10-24mm. Compact, smooth, high-quality
build — very nice.

FEATURES: Similar to the Nikon 10-24mm,
butat 12mmiit's not quite so wide. Maximum
aperture is a constant f/4. Hood supplied.

AUTOFOCUS: The Silent Wave Motor is as
good as ever — swift, quietand accurate,
plus full-time manual override.

PERFORMANCE: This is a ten-year-old optical
design, Nikon's first DX ultra-wide. Based on
our review sample, it displays ‘classic’
characteristics of high sharpness at the wide
end, steadily reducing as focal length is
increased, with edge sharpness always
lagging. At 12mm, sharpness in the centre is
‘excellent at f/4, the edges 'very good', and a
high standard of image quality is maintained
throughout the aperture range. As focal length
is raised though, both centre and edge
sharpness falls — to disappointing levels at
lower f/numbers, especially at 24mm.
Stopping down improves sharpness quite
dramatically and at f/8, it's ‘excellent’ to 'very
good' across the frame at all focal lengths.
Peak resolution measured 113 lines-per-mm
and aberrations control s par for the course.

VERDICT: Maybe we got a rogue test copy, but
based on these results it's hard to see why this
lens should cost a very substantial £840 —
£200 more than the Nikon 10-24mm that is
sharper and has an extra 2mm at the wide end.

DISTORTION: Strong barrel+2.8% at10mm.
Overallrating: Good

VIGNETTING: Mild 0.7EVat12mmf/4.
Overallrating: Excellent
CHROMATICABERRATION:
Highthroughout. Overallrating: Poor

PEAKRESOLUTION: 113 lines-per-mm
atMTF20%, 12mmf/4 centre

HANDLING
FEATURES
PERFORMANCE
VALUE FOR MONEY
OVERALL

18/20
17/20
33/40
15/20
83/100
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®Sigma10-20mm£/4-5.6
EXDCHSM

HANDLING: High build quality and finger-light,
super-smooth controls. Excellent, but Sigma's
velvet-matt finish can show scuff marks.

FEATURES: 10mm is as wide as they come, but
20mmiis a bit less than average. Maximum
aperture f/4-5.6 is also modest. Lens hood and
case supplied.

AUTOFOCUS: Sigma's Hypersonic Motor
(HSM) autofocus drive is as good as any,
ie excellent, and there is full-time manual
override, too.

PERFORMANCE: Sharpness in the centre is
always high, wellinto the ‘excellent’ zone up to
f/11 before diffraction takes hold. As always,
edge sharpness is lower, though never less
than 'very good’ with the exception of 10mm at
f/4 that stands out a bit as being disappointing.
However, it ramps up very quickly and by /5.6
it's 'very good' and from there onwards
sharpness is uniformly high across the frame.
Peak resolution hits 121 lines-per-mm. Barrel
distortionis a high +3.5% at 10mm, but falls
quickly and turns to -0.6% mild pincushion at
mid-range and longer focal lengths. Vignetting
is a little higher than average, but still 'very
good' overall, while CA controlis a little better
than some, rating 'good'.

VERDICT: No prizes for low-light performance,
but from f/5.6 to f/11 — probably the most
useful range for an ultra-wide — sharpness is
very high at all focal lengths. At only £370, the
price is even sharper.

DISTORTION: Severe barrel +3.5%at10mm.
Overallrating: Good

HANDLING
FEATURES
PERFORMANCE
VALUE FOR MONEY
OVERALL

18/20
16/20
35/40
20/20
89/100

Sigma 10-20mm f/4-5.6 EXDC HSM

Lens Sharpness (%): 10mm Centre Edge
100 —————— -

Good V.good

Fair

[elelg

100
920
80
70

®Sigma10-20mmf/3.5
EXDCHSM

HANDLING: Fractionally larger and heavier
than the Sigma f/4-5.6 variant, otherwise like
two peas in a pod. The test sample’s zoom
control was heavier and slightly less smooth.

FEATURES: Main feature is the constant f/3.5
maximum aperture, one third of a stop
brighter than /4, two-thirds more than f/4.5.
Hood and case included.

AUTOFOCUS: Sigma's Hypersonic focus
works quickly, but a little less quietly here.
Manual focus is full-time override.

PERFORMANCE: Sharpness is unusually high
in the centre, always 'excellent’ at all focal
lengths up to f/11. Edge sharpness is lower,
though mostly never out of the 'very good'
zone. At 10mm, the edges are noticeably less
sharp and don't respond much to stopping
down. At 15mm, the edges perk up and
throughout the mid-range focal lengths,
sharpness is high at all apertures. At 20mm
though, edge sharpness drops away again.
Peak resolution measured 122 lines-per-mm.
Barrel distortion is a decidedly ‘poor’ +3.5% at
10mm, but quickly drops to zero through the
mid-range before turning to mild -0.7%
pincushion at 20mm. Vignetting controlis
never less than ‘excellent’, CA 'fair' overall.

VERDICT: Always sharp in the centre, and the
edges too at mid-range focal lengths, less so
at either end of the zoom. Main appeal is the
constant f/3.5 maximum aperture, though the
cheaper Sigma f/4-5.6 version looks favourite.

DISTORTION: Severe barrel +3.5% at10mm
Overallrating: Good

VIGNETTING: Mild 0.8EV at10mmf/3.5.
Overallrating: Excellent

CHROMATICABERRATION: Moderate to
high. Overallrating: Fair

PEAKRESOLUTION: 122 lines-per-mm
atMTF20%,14mmf/4 centre
HANDLING

FEATURES

PERFORMANCE

VALUE FOR MONEY
(0)V/3:7:\NR

18/20
17/20
35/40
17/20
87/100

Good V.good

Fair

Poor

100
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®Tamron SP 10-24mm
f/3.5-4.5DillLD

HANDLING: Compact and light, well made,
too. Main handling difference is the focusing
ring turns during AF, and has to be switched
over for manual.

FEATURES: Great focal length range, broadest
in this class, for high versatility. Maximum
apertures less so at f/3.5-4.5. Hood provided.

AUTOFOCUS: No ultrasonic focusing, and the
micro-motor is a little slower as it whirrs along,
but works well enough.

PERFORMANCE: Sharpness is lower than most
others we've tested. On average, ultra-wides
tend to be 'excellent’ in the centre and 'very
good' towards the edges, while the Tamron
10-24mm runs one step lower — 'very good' in
the centre, and 'good' at the edges. Peak
resolution is also the lowest of this group,
reaching 107 lines-per-mm, recorded at 24mm
f/8in the centre. Distortion levels are ‘fair’
overall, with strong +3.2% barrelling at 10mm,
rating ‘poor’, steadily reducing to +1.6% barrel at
24mm. Vignetting is well controlled, never
more than 0.9EV at 10mm /3.5, rating
‘excellent’, and usually less than that. CA'is
higher than average, rating ‘poor’ overall.

VERDICT: The focal length range is excellent.
The maximum apertures are modest, but
perfectly workable, and the AF mechanism,
while not quite as sophisticated as the other
ultrasonics, does the job. It's only the optics
that disappoints here, and there are better
buys, even at £370.

DISTORTION: Severe barrel +3.2% at10mm.
Overallrating: Fair

HANDLING
FEATURES
PERFORMANCE
VALUE FOR MONEY
OVERALL

17/20
17/20
32/40
15/20
81/100

Tamron SP 10-24mm f/3.5-4.5Dill LD

Lens Sharpness (%): 10mm Centre Edge
100 —— e

Good V.good

Fair

Poor

Centre Edge

Good V.good

Fair

Poor

®Tokina AT-X12-28mm
f/4 Pro DX IEEA

HANDLING: Slightly larger and heavier than
most, the build quality is obvious. Styling is very
Nikon-esque. Switching from AF to manual
focus is by pulling the clutch-ring, though this
usually moves the exact distance slightly.

FEATURES: It's an all-new lens, sitting
alongside the acclaimed Tokina 11-16mm
f/2.8, trading constant f/4 maximum aperture
for much greater 12-28mm zoom range.
Hood included.

AUTOFOCUS: Tokina's SD-M Silent Drive-
Module works quickly and quietly. Top marks.

PERFORMANCE: Tokina has a reputation for
high image quality, so no surprises here. In the
centre, sharpness is well into the 'excellent’
zone at all focal lengths up to f/11. Edge
sharpness is lower, but never less than ‘very
good'. Performance is consistent at all settings
— no peaks, and no nasty surprises either. Peak
resolution measured a high 123 lines-per-mm.
Barrel distortion is +3.2% at 12mm, rating
‘poor’, though it quickly drops to +0.4% at
18mm (‘excellent’) and hovers around zero to
28mm. Vignetting is effectively insignificant
throughout; CAis a little higher than expected,
rating 'fair’ overall.

VERDICT: A fine lens. It feels good and works

great, with consistently high image quality at

all settings. The extra focal length at 28mmiis
useful, but at the expense of a couple of mms
less at the wide end. The price has dropped a

little since launch, too.

DISTORTION: Severe barrel +3.2%at12mm.
Overallrating: Good

VIGNETTING: Mild 0.8EVat12mmf/4.
Overallrating: Excellent

CHROMATIC ABERRATION: Reduces at
28mm. Overallrating: Fair

PEAKRESOLUTION: 123 lines-per-mm
atMTF20%,12mmf/5.6 centre
HANDLING

FEATURES

PERFORMANCE

VALUE FOR MONEY
(0)V/3:7:\N R

18/20
18/20
37/40
18/20
91/100

Good V.good " Ex¢

Fair

Poor
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Makc thc most of
wide-angle lenses

Shooting wide ensures your shots are full
of detailand impact. Here'swhy...

Adam Burton
Wide-angles are the lens of choice for the vast
majority of landscape photographers for very

good reason. These lenses allow you to squeeze

as much of a location into your viewfinder as

possible and capture a scene absolutely
brimming with detail and interest. This is an advantage for
landscape photographers as it means you can include
foreground interest as well as lots of detail in the far scene,
giving your image plenty of depth. By choosing interesting
foreground subjects, you can also grab the viewer's
attention and pullthem in to the picture.

Using wide-angle zooms can be so addictive that you
automatically use their widest setting at every opportunity.

But this can pose problems. Some lenses can be set so wide
that they show the corners of your equipment (lenses, filters
and holders) in the frame; this is known as vignetting. Another
issue with using extreme wide-angle lenses is barrel distortion,
which causes horizons to bend and buildings to lean.

Allthis can be avoided by training yourself to set your
wide-angle lens according to your subject matter. If shooting
a straight horizon, like a seascape, then using the focal length a
few millimetres up from the widest will reduce the appearance
of a bendy horizon. A mountainous terrain, which already has
an uneven horizon, can be shot as wide as you want. As well as
focal length, pay attention to the height and the angle of your
camera when you set it up on a tripod. Trees will lean when
composed from low to the ground, so try setting the camera
at head height and you may notice a big difference.

The benefits of shooting with wide-angle lenses far
outweigh these few considerations. The impact they can give
on your photographs is astounding, which is why it comes as
no surprise that most pro landscape photographers wouldn't
shoot without them.

Vignetting Low viewpoint CHOOSE AFORMAT:

My firstimage was takenina
horizontal format, which s
often the natural orientation
for landscapes. However, a
vertical format can work just
as well with wide-angle
shots. It allows more room
for foreground details while
stillincluding lots of sky.
NOT TOO WIDE:

Using the widest end of your
zoom may cause barrel
distortion (When the horizon
curves downwards) and
vignetting (when dark areas
appear in the corners of your
frame). The wider your focal
length, the greater the
chance the camera has of
including parts of your kit (eg
filter holders). Avoid these
problems by not setting your
lens to its widest focal length.

GO LOW: Aviewpoint
closer to the ground
dramatically increases the
impact of the foreground
subject matter and
provides a more dynamic
composition. Now the
viewer can focus their
attention on the rockpool,
which leads their eye into
the frame and towards the
distant castle.




TOPTIP

To ensure the entire scene
is sharp, set aperture-
priority mode, use a small
aperture like f/16 and
focus a third of the way
into the scene. Make sure
to set your digital camera
on a tripod for stability

Finalimage * .
Wide-angle landscapes are
most effective when there's
some prominent foreground
interest to pull the viewer in
to the scene. Don't be afraid
to compose so that your
foreground is big and bold!
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Pcrspcctivc
comprcssion

Photographers often talk about using a telephoto
to compress perspective, but what does it mean?

TECHNICALLY SPEAKING, telephoto lenses don't ‘compress perspective’,
but, practically speaking, you do get a different feeling of perspective
from a telephoto shot than from a scene captured with a wide-angle lens.
Wide-angle lenses open up perspective and create a sense of depth
because nearby objects appear big, and further objects appear to be
small, suggesting distance. Wide-angle lenses also create strong
diagonals, enhancing the sense of depth. On the other hand, telephotos
make distant objects appear larger, apparently compressing the planes of
the image and reducing the impression of depth. Lines tend not to stretch
into diagonals and parallels remain parallel, increasing the two-
dimensional feel. Compared to a wide-angle view, this alladds up to an
image that is more static. And, of course, the longer the lens, the greater
the effect. So what kind of images benefit from this compression effect
of longer lenses? The static character of telephoto images suits tranquil
scenes; hilly landscapes are ideal, especially where there are several
planes or ‘layers’ that can be visually pulled together so they appear to be
almost stacked on top of each other. The feeling of tranquility can be
enhanced by early morning mist, with the tops of the hills rising above the
haze. More dramatic images can be created in the right lighting
conditions, too — look for alternating bands of light and dark, creating a
‘layering of light". Urban landscapes also work well as you can use
compression to contrast elements or suggest a crowded environment.

Tclecphoto zooms

There is no argument that landscape
photographers should place a decent wide-angle
lens (be it prime or zoom) at the top of their
wishlist. However, that's not to say there shouldn't &
be a little room allocated in the gadget bag for a
telezoom. While you'll predominantly be filling
the frame with wide-angle vistas, you'llalso find
times when a telephoto can prove useful. This

will usually be when you want to isolate a specific
area or feature within the scene or when you want
to create a layering effect through perspective
compression (see below). There are a variety of
telephoto zooms available but we'd recommend
you opt for a focal length of around 55-200mm if
you use a DSLR with an APS-C sized sensor, or a
70-300mm or similar zoom if you have a full-frame
DSLR. You'll find the Tamron 55-200mm f/4-5.6 Di ll
to be great value, along with Sigma’s 70-300mm
f/4-5.6 DG zoom. Both of these will be perfect for filling the frame with
any wildlife you may encounter as you roam the countryside.




DID YOU KNOW?

While telephotos appear
to compress perspective,
the truth is that they don't.
Magnify an area of a shot
taken with a wide-angle

lens and you'll see that
it gives a virtually
identical effect!

28-35mm
The apparent distance
between the
foreground and castle
creates a sense of
depth, with the hills
and village behind the
castle stretching away
into the distance.

50-85mm

Even at moderate
telephoto settings,
the perspective seems
much flatter, and the
castle seems to loom
over the distant hills
and the village.

105-200mm

As the focal length
increases, perspective
seems to flatten out,
so that the castle

and the hills behind
seem to be almost on
the same plane.
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Landscapc filtcrs: systemsand types

Filters have long been the simplest and most inexpensive way to improve or alter your images in-camera.
Eveninthedigitalage, they have their place in every landscape photographer’s kit bag. We explain the main
types of filter systems, our recommended filter types and the major brands to consider...

THE WORTH OF FILTERS, now L
that we have Photoshop, is a topic
that still divides opinion amongst
amateur photographers. But for
those that like to getit right
in-camera, filters are still
invaluable tools, in particular with
outdoor photographers.

While some filters can give an
image a colour cast, other
popular types are neutralin
tone and instead enable
photographers to balance bright
and dark areas of a scene, or have
more scope for their choice of
apertures and shutter speeds.
There are many different uses for
filters to suit all types of
photography but in this guide, we
help you decide which type of
filter, as well as what filter system,
is the best choice for landscape
photography.

Filters come in two main types:
screw-in, which attach directly to
the filter thread at the front of your
lens barrel; and slot-in, which slip
into a holder held in place onthe
front of your lens by adaptor rings
screwed on to the filter thread.
Both have their pros and cons,
which you should consider before
deciding which to buy. As you'll
no doubt discover as you read on,
a combination of both types is
often the best solution for most
photographers.

Screw-infilters Slot-infilters

These are quick and easy to attach and
remove from your lens, so are a very
convenient choice. As they're made
from glass, they are of high optical
quality and more difficult to scratch.
Screw-in filters come in various sizes,
with 52mm to 77mm being the most
common. If you own a number of
lenses, each with different filter threads,
you will either need a filter in each size
or take the more affordable option of a
stepping ring (see tip below). Another
negative point worth considering is that
grad filters aren't well suited for use as a
screw-in, which will be off-putting for
landscape photographers in particular. You also need to take care when
using more than one screw-in filter at a time, as you run the risk of
vignetting (darkening at the image corners), especially with wide-angle
lenses. Another disadvantage is that occasionally you may find a filter
won't budge, in which case you'll need a filter clamp to help remove it.
@ Stepping rings: A cheaper option than buying
the same type of filter in various sizes is to buy the
largest size you need and a step-down ring,
which allows you to fit a large filter on a smaller
thread. For instance, if you have a 72mm filter and
buy a 72-67 ring, you can screw the filter to the
ring, which attaches easily to the lens. Don't go
for a step-up ring for attaching smaller filters to
larger lenses, as these can cause vignetting.

With these systems, you only need to
buy one filter even if you have several
lenses of different sizes. This is because
the filter slips into a holder, which
attaches to the lens via an adaptor ring.
So, instead of needing costly screw-ins
in various sizes, you can simply buy
affordable adaptor rings in the sizes you
need and swap the holder between
them. It does mean the initial investment
is higher but, over time, it proves to be far
more economical, especially if you have
severallenses. You'll find there is an
extensive range of filters available, in
particular graduates, which are among
the most popular types of filter for landscapes. Unlike screw-in filters,
slot-in filters are made from optical resin, which is incredibly tough and
lighter than glass, although more prone to scratches. Optically, they offer
excellent quality, with little discernible difference to screw-ins.

For the ultimate quality, look at pro brands like Lee
Filters, which use the very best materials.

@ Compatibility: You'll find most brands
make more than one size of slot-in system to
suit different types of DSLRs. The standard
size is 67mm but if you have wide-angle
lenses, we'd recommend you consider the
85mm or 100mm formats. Note that as these
sizes are standard, similarly sized holders will
accept filters from other brands.
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Ourfavouritefiltertypes

There are literally hundreds of different types of filter available, but our shortlist below
highlights those that prove most beneficial to your landscape photography

Using slot-infilters

LIONIGQOH SSOY :SIDVWI TV

@ Skylight/UV/Protection filters @ Polariser

These are essentially clear glass If you shoot outdoors regularly,

screw-in filters that protect the front buy a polarising filter. It saturates

element of your lens from dust, colours, in particular blue sky, as well

marks and damage. The UV filter can as minimising glare and reflections

also aid in the removal of haze, but from shiny surfaces like foliage

allthree are more or less the same. or water. The effect of a polariser

We would recommend that you can't be replicated accurately in

attach one to each of your lenses. Photoshop, which is why most i - -
landscape photographers never leave home 1) Screw in the appropriate adaptor ring
without one. Avoid linear polarisers — you need a 2) Attach the holder to the ring
circular polariser; otherwise your camerawon't 3) Slide the filter into the holder

meter correctly. Polarisers have a filter factor
of 4x and reduce the exposure by two stops, so

watch out for camera shake. While one of the
most expensive types of filter, they're definitely =1 1
worth the investment. SCI’eW n ﬁlters

0.9NDgrad Guide prices for popular brands

—
B+W
52mm £23 £76 £34
55mm £23 £87 £34
@ Close-up filters 58mm  £23 £89 £34
On brightdays when the sunis 62mm £26 £94 £36
high in the sky and not particularly 67mm £32 £111 £37
suitable for landscape photography, 72mm £40 £128 £43
many photographers turn their 77mm £45 £144 £47
attention to shooting detail. Close-
up filters are useful ifgyou don'town Hoya [ | [ |
amacro lens and want to shoot 52mm  fl14 £40 £25
small objects at high magnification. 55mm  £14 £40 £28
58mm £16 £40 £30
Nofilter & i+ * . NDfilter 62mm  £20 £40 £35
i et - o) 67mm £25 £40 £38
72mm £25 £60 £45
@ND araduate filt. 77mm £30 £80 £55
graduate filter
Graduates have a dark area [Kood | | | |
that fades to clear and are 52mm £10 £24 £12
used to balance bright sky 55mm £10 £24 £13
with a darker foreground. 58mm £10 £24 £15
They're available in a variety 62mm £10 £30 £15
of colours, but we'd say the 67mm £11 £30 £19
only grad to buy at firstis 72mm £11 £36 £28
the ND (Neutral Density) 77mm £13 £38 £29
graduate. These have a
gradual ND effect that does Tiffen | | | |
not change the colour balance of the sky, but 52mm £10 £31 £22
allows detail to be recorded in the scene. ND 55mm £10 £31 £22
grads are available in various densities, with the 58mm £13 £35 £22
0.6ND grad being a good first choice. You'll find 62mm £15 £39 £39
® Neutral Density that there are soft- or hard-edged variants, too, 67mm £16 £46 £39
These aren't essential filters, relating to how the grad effect falls off — we'd 72mm £23 £57 £50
but are very useful. A Neutral suggest you begin with a soft-edged grad. 77mm £24 £57 £50

Density filter is grey in colour
and doesn't alter the colour
balance of animage but instead
reduces the amount of light
passing through to the lens.
They are mainly used in bright
sunlight, when you need to use 06 4x
awide aperture to minimise depth-of-field ora 09 8x
slower shutter speed to emphasise movement. 12 16x

ND filter factors: This table explains the
relationship between exposures and filter
factors. Light loss is stated in stops.

| Density | Filterfactor | Lightloss | LOOK AFTER YOUR FILTERS!
0.3 2X 1

Filters can be easily scratched so be sure to

return them to their storage case or a filter
wallet when not being used. Use a microfibre
lens cloth to remove fingerprints and marks.

A WN
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Filtcr brands

There aren'ttoo many brands of filter but the choice they offer can be
confusing. We've highlighted the tried-and-tested filter brands that
offer greatvalue as well as high-quality products

B+W

www.bpluswfilters.co.uk

This prestigious German brand is
renowned for producing screw-in filters
with optimum quality, both in terms of the
metal filter ring and the manufacturing
process behind its premium optical glass.
It's a very popular brand with pros but it
does cost around twice as much as other
brands. If you need the ultimate in quality
from a screw-in filter, then B+W is the
option for you, otherwise Hoya is a great
choice. One string in its bow is the
ten-stop ND filter, which has proven
incredibly popular for daytime
long-exposure photography.

Hoya
www.intro2020.co.uk

Hoya makes around 60% of the world's
optical glass, so you can be assured it
offers excellent quality. Hoya offers the
most extensive range of any screw-in
filter system, with literally every type of
filter you canimagine. What's more, for
popular types of filter such as polariser or
UV, it has a number of options to suit all
levels of photographer, from amateur
through to pro. Its filters boast several
cutting-edge technologies, for instance,
the HD series boasts hardened glass and
several layers of multi-coating to improve
contrast and reduce flare, while the Pro 1
Digital series has been exclusively
designed for use with digital cameras. The
extensive Super HMC series covers the
majority of filter types and provides
fantastic quality at a great price. Revois its
latest series, offering the ultimate in
quality. Download Hoya's filter brochure
for a better idea of its full range of filters.

Cokin

www.intro2020.co.uk

For many photographers over the
decades, the search for high-quality and
affordable slot-in filters started and ended
with Cokin. Thisisn't a surprise as this
manufacturer was the innovator of
creative filters for amateur photographers
and has led the way ever since.

Cokin offers four filter sizes: 67mm
(A-series); 84mm (P-series); 100mm
(Z-Pro); and 130mm (X-Pro). The A-series
is aimed more for use with compacts or
camcorders, so the P-series is the best
introductory option. If you use
wide-angle lenses with a focal length
wider than 28mm, you should consider
the Z-Pro range, while the X-Pro is more
for medium-format photographers. All
the ranges offer plenty of options but the
P-series has everything the DSLR
photographer may ever need, with over
140 filters to choose from, including
polarisers and a variety of ND grads. Filter
rings are available for threads up to
82mm and the P-holder accepts up to
three filters at a time. The Z-Pro seriesis a
better choice for landscape
photographers — in particular those with
ultra-wide zooms. Adaptor rings are
available from 49mm to 96mm and
filters are 100mm square, except for the
grads which are 100x150mm.

All the filters are made from CR39
optical resin and deliver high-quality
results, and because it's such a popular
range, filters are very well priced. The ND
Grad Kit for the P-series is affordable at
£50 and consists of a Cokin P filter
holder, one P121L ND2 Light Grad, one
P121IM ND4 Grad and one P121S ND8
Soft Grad filter. The Cokin P164 circular
polariser is around £50, while for the
Z-Pro, you're looking at around £225 for
the Z164! Adaptor rings cost in the region
of: A-series: £8; P-series: £11; X-Pro:
£50; and Z-Pro: £22.
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Lcc Filters

www leefilters.com

Lee Filters is the ultimate choice for the
discerning photographer. Loved by pros
and relished by enthusiasts, Lee Filters are
as good as it gets in terms of optical
quality, but due to the stringent
manufacturing processes involved,
expect itto command high prices. Its
brilliant 100mm system is the cornerstone
of its success, with a high-quality and
versatile holder that can be made to your
own specification to hold varying
numbers of filters. The filters themselves
are brilliant quality and are manufactured
from a number of materials, including
glass, resin and polyester. Various kits are
available and we'd recommend the £200
Digital Starter Kit, which comprises an
assembled holder, 0.6ND ProGlass ND
hard grad, 0.6ND and cleaning cloth, all
packed neatly into a pouch. The other kit
is the £150 Starter Kit, which includes an
assembled filter holder, 0.6ND grad,
cleaning cloth, Coral 3 grad and pouch. Its
ten-stop 'Big Stopper’ ND (around £110) is
the best on the market. Adaptor rings
from49mmto 77mm cost £19; 82mm
and 86mm are £41; while 93mm, 95mm
and 105mmrings are £55. The filter
holder (the Foundation Kit) is £55.

If you intend making a living from
photography and investing in expensive
lenses, then these are the filters you
should aspire to own.

Q

>
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Filter aid
Do not underestimate
how filters can be used to
improve your images,
especially if you're keen
on shooting landscapes.

Formatt (Hitcch)

www.formatt.co.uk

Formatt makes a range of filters for
movies and stills photography. Its Hitech
filters are aimed specifically at digital SLR
photographers, made from optical resin
and are manufactured in the UK to
extremely high standards to provide
excellent optical quality. The 67mm,
85mm and 100mm filter systems are
compatible with other slot-in brands and
include an extensive range of graduates.
As well as hard- and soft-edged ND grads
(from 0.3-1.2), it offers a huge choice of
colour grads, as well as the Blender,
which graduates the effect through the
entire length of the filter. Hitech also
boasts the ProStop, a ten-stop ND filter
that costs only £60 for the 85mm version,
or £90 for the 100mm. An ND grad kit
with 0.3, 0.6 and 0.9ND grads costs £38
(85mm); £85 (100mm); and £111
(100x150mm). The circular polariser
costs £133 (85mm) or £139 (100mm).

A plastic holder costs under £10 and
plastic adaptor rings cost around £5 from
49mmto 77mm.

Kood

www.kood-international.com

Kood has its own range, with screw-in
filtersimported from Japan and slot-in
filters manufactured in the UK. The range
of screw-infiltersisn't large but includes
polarisers, protection and close-up filters,
as well as various special-effectitems
such as starburst and colour-correction
filters. Kood also has a good range of
stepping rings, too. Kood offers four sizes
of slot-infilters — 67mm, 84mm, 100mm
and 130mm — soits filters are compatible
with all the major slot-in brands. Made
from CR39 optical resin, they offer
decent quality and are a good budget
buy. Kood isn't available fromall
high-street outlets, so visit its website for
your nearest stockist. Kood's Circular
Polariser and ND grads in sizes 84mm to
130mm cost between £25 and £45, and
can be purchased from Kood direct as
well as a number of camera dealers.

Tiffcn

www tiffen.com

Tiffenis an American brand that has been
around for decades and is particularly
popular in the movie industry. Its range of
screw-infiltersisn't as comprehensive as
Hoya's, but it does cover all the key types
including protection filters, polarisers and
Neutral Density filters. It also has a
number of special-effect filters, in
particular lots of diffusion filters including
soft-focus, mist and fog, but these aren't
filters you'd use on a regular basis. While
the range is relatively small, quality is very
high and Tiffen filters come with a
ten-year guarantee. You'llalso find that
prices are competitive, too, making them
adecentalternative to brands like Hoya,
although the latter is more likely to be
stocked by your local photo dealer.

UNKNOWN BRANDS

Search the web and you'll find filters
from little-known brands like Helios.
Most stem from China and as there are no
official UK importers, it's hard to judge
optical quality — the safest bet is to stick
with recognised filter brands

LIONIQAOH SSOY
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Tripods foroutdooruse

Don't leave home without a three-legged friend

ATRIPOD SHOULD be viewed as an essential part of your outfit. You'll
usually be using a small aperture setting to maximise depth-of-field, along
with a low ISO rating to give the highest quality results, which will resultin
long shutter speeds. Handholding might be feasible with some shots, but
with a tripod you never need to worry about the shakes. You'll also find
that, by using a tripod, you can spend more time and attention on
fine-tuning the framing of the scene to get the best possible composition.
There's a huge variety of tripods on offer, so choosing oneisn't
straightforward, but there are two key factors to consider. The firstis
stability — while cheaper models may be tempting, they may not provide a
stable platform, so ensure you pick a model that is sturdy enough to keep
your kit totally still when shooting. The second factor to think about is how
much a tripod weighs, which isimportant as you'll be carrying it, along
with the rest of your gear, for considerable distances. Most tripods are
made from aluminium, which is sturdy and fairly lightweight, although
decent models weigh around 2kg or more. If you want a tripod that's as
sturdy but far lighter, you'llwant a carbon-fibre model, although you'll
have to be prepared to pay a premium. Our selection of tripods have all
received the highest ratings in Digital SLR Photography magazine. We've
chosen examples that cover various street prices (not the manufacturer's
RRP) to ensure you find one that suits your budget. Bear in mind that with
the more expensive models, you buy the tripod and the head separately.

Features

1) Head There are various
tripod heads available,
from ball-and-socket to
three-way pan & tilt. Some
are also interchangeable.
When choosing a tripod,
attach your DSLR securely
and ensure the head is free
from movement.

2) Quick-release plate
These allow you to quickly
attach and detach your
DSLR to/from the tripod.
All of the tripods in this
review have one.

3) Leg locks Most of the
tripods here feature ‘clip’
locks, which are easy to use
and are secure.

4) Leg sections Tripods
with three leg sections

or fewer tend to be the
most sturdy, as the more
sections you have, the less
stable they can become.

5) Spirit levels Useful for
landscape photography,
many tripods feature built-
in spirit levels to make sure
your images are straight.

If not, your local photo
store should sell one that
slots straight on to your
hotshoe.

6) Bag hook Some tripods
have hooks on the central
column, from which a
bag can be hung, using

its weight to add stability
to the tripod in windy
conditions.

7) Tripod feet Spikes are
good for grip outdoors
but will scratch flooring.
Rubber feet, on the other
hand, offer good grip
indoors and outside and
are the best choice for
generaluse.
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Interchangeable tripod

Most high-end tripods aren't supplied with a head,
allowing users to choose their preferred legs and a
specialist or general-purpose head. The two most
common types of heads are as follows:

®Ball-and-socket: These range from simple
heads with one control to complex units with
panoramic locks and gauges, grip-locks and
hydraulic ball-locking systems. Usually stronger
and quicker to adjust than pan & tilt heads, they
allow free movement in all directions.

®Three-way heads: Commonly known as
pan-and-tilt heads, these are great for all types
of photography. Panning gauges are useful
for panoramic shots and fluid heads have the
smoothest panning motion.

Ball-and-so.cket

Velbon Sherpa+ 630

® Length (closed): 56cm

® Height (legs extended): 163cm

® Number of leg sections: 3 Weight: 1.6kg

® Maximum load: 4kg Website: www.intro2020.co.uk

Velbon's Sherpa 630+ is a decent all-rounder that's lighter
than many of its similarly priced rivals. In the quest for
weight saving, you might suspect that stability has been
compromised, but while it's not quite the sturdiest model,
it's not at all bad. The legs are grooved to prevent rotation
and perhaps this also helps reduce flex. As usual, the legs
can be fixed at three different angles to get down low,
and the centre column (sans ballast hook) splits in half
to go even lower. The centre column lock is unusual
in being a lever rather than a ring or knob, and it all
works rather well. Its key feature is weight, so if that's
important to you, check it out!

Slik Pro700DX + 700DX pan & tilt head

® Length (closed): 76cm

® Height (legs extended): 190cm

® Number of leg sections: 3 Weight: 3.2kg

® Maximum load: 6.8kg Website: www.intro2020.co.uk

-

The largest tripod on review, the Pro700DX feels like it could
withstand any treatment. It's sturdy and stylish, and certainly
looks a tripod for serious use. Although it's heavy, it is still
portable. The locks are strong and secure, yet easy to open,
while the reversible central column allows users to take
low-leveland macro shots with ease. Itis particularly
effective when used with the legs open wide, which is

easy if using the three-position locks to hold them firmly

in place. The pan & tilt head features a panning lock and

a smooth panning motion. The quick-release plate is
circular, making it easy to attach and detach the camera.
There are two spirit levels but no bag hook.

Manfrotto 804RC2 head [EE)

® Weight: 712g

® Height: 110cm

® Base diameter: 60mm

® Maximum load: 4kg

® QR system: Manfrotto RC2

® Website: www.manfrotto.co.uk

This is a simple three-way head that does
the job welland is one of Manfrotto’s
bestsellers. It's a good size, about average
weight, with ample load-bearing capacity. The three
axes each have graspable control handles, are logically positioned, and
marked with degree scales and a spirit level. The RC2 quick-release plate is
one of the best, slotting in easily and locking automatically. A neat feature
is that the up/down movement is spring-loaded, increasing resistance as
the cameraiis tilted forwards or backwards. If you're looking for a tripod for
video use, though, you'll be better off looking at other options.
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Giottos MTL 8261B

@ Length (closed): 66cm

® Height (legs extended): 169cm

® Number of leg sections: 3 Weight: 1.6kg

® Maximum load: 8kg Website: www.giottos-tripods.com

You can't have it all, and the ideal requirements of high
strength, low weight and competitive price tend to be
mutually exclusive. Compromise is the name of the game,
and some tripods make a better fist of it than others — like
this Giottos. It's tall and strong, very light at only 1.6kg, and
although it uses pricey carbon-fibre to achieve that, the
costis reasonable atjust under £200. This is a classic
three-section tripod, which puts it in the middle of the
popular size scale as the best all-rounder. It's more than
big enough for most, strong enough to take anything
short of the heaviest super-teles and light enough to

be carried anywhere. It does everything you need.

Giottos Silk Road YTL 8354

® Length (closed): 54cm

® Height (legs extended): 138cm

® Number of leg sections: 4 Weight: 1.38kg

® Maximum load: 5kg Website: www.giottos-tripods.com

Released in the summer of 2013, this innovative model
became an instant favourite with outdoor photographers —
especially those who regularly travel. It's the first to feature
a'Y'-shaped column that allows the legs to fit more snugly
together when closed, saving around 30% space while
retaining the strength and stability of a conventional
column. The design and the use of carbon-fibre
means it's relatively light, too. With legs fully

extended, the height of 138cm is useful and can be
raised further to 171cm via the centre column. It's sturdy and
well designed, with foam covering much of the upper leg section.
Combine it with one of the heads below and you've a versatile outfit.

Manfrotto 055CXPRO3 )

® Length (closed): 66cm

@ Height (legs extended): 175cm

® Number of leg sections: 3 Weight: 1.7kg

® Maximum load: 8kg Website: www.manfrotto.co.uk

Manfrotto is actually part of the same company as Gitzo,
owned by the UK-based Vitec Group. Between them,
they've got everything covered. This Manfrotto, part of the
popular 055 series, is a decent size for serious work, similar
to the Giottos MTL 8261B, and capable of handling all but
the heaviest outfits. It's available with three or four-section
legs, with or without the tilting column. This is a simplified
version of the tilting column idea, and while it can only

be locked upright or horizontal, in practice that doesn't
compromise versatility. You can still get to ground level

by adjusting the height with the normal leg levers or by
selecting one of the four leg angle positions.

Manfrotto 1990CXPRO3 + 494RC2 head [EX]

® Length (closed): 58cm

® Height (legs extended): 146cm

® Number of leg sections: 3 Weight: 1.62kg

® Maximum load: 5kg Website: www.manfrotto.co.uk

This Manfrotto is light and its sleek design looks fantastic.
Despite its thin legs, it was sturdy and supported our test
camera with ease. The twist locks are strong and quick
to use. The central column can be raised and moved into
horizontal position without removing it from the legs,
making the tripod perfect for macro and low-level shots.
The multi-position leg locks have a depressible button,
making them easier to use than those with clips that
must be lifted. The ball-and-socket head is smooth and
one switch controls everything, so it's ideal for quick
positioning, but not as precise as some of the other
heads on test. There is a spirit level and a bag hook.

Giottos Vitruvian VGR8255 kit EX)

® Length (closed): 40cm

® Height (legs extended): 136cm

® Number of leg sections: 5 Weight: 1.28kg

® Maximum load: 4kg Website: www.giottos-tripods.com

The legs of the Vitruvian fold 1802 to surround the centre
column, reducing the length to 40cm. Open the legs

and it extends to an impressive 1.36m (1.57m with centre
column raised, too). Made from six-layer carbon-fibre, it's
lightweight and stable with aluminium alloy in the main
casting increasing robustness. Twist locks are fastand easy
to use and the centre column can be removed to turn
itinto a monopod. The supplied ball-and-socket head
moves smoothly and has a friction lock, spirit level and
quick-release plate with safety lock. A maximum load of
4kg makes this a suitable choice for most. There'salso a
cheaper aluminium version (VGR9255).

Gitzo GT3541 Mountaineer L)

® Length (closed): 54cm

® Height (legs extended): 168cm

® Number of leg sections: 4 Weight: 1.9kg

® Maximum load: 18kg Website: www.gitzo.co.uk

You can tell this is a really good tripod just by looking at it.
Another clue is the price. Gitzo makes nothing but the best
tripods, and while some Chinese clones run close by on
performance, and beat them on price, there's none better
than this classy Italian brand. Weight is low, yet everything
feels taught, rigid, locking solid. Making a good tripod is
not rocket science; they all have three telescoping legs
hinged to a central camera platform. The differenceisin
the design integrity of the joints, quality of materials and
manufacturing precision. Gitzo has all that totally sorted.
If £600 is too much, Gitzo's aluminium and basalt
versions are significantly cheaper and only a bit heavier.

Giottos MH 5001 head [IER

® Weight: 8489

® Height:109cm

@® Base diameter: 59mm
® Maximum load: 6kg
® QR system: Giottos

® Website: www.giottos-tripods.com

This three-way Giottos head is substantially
built, getting on the heavy side, and with large
handles that offer plenty of leverage for fine
control — although they can be unscrewed for
packing away and storage. Where it scores over the Manfrotto 804RC is in
the smoothness of operation. It doesn't really make that much difference
for stills, but it's not far off the standard of a fluid damped head, offering
just the rightamount of gentle resistance as you pan, without any jerkiness.
So if you're amongst the growing ranks of photographers who like a bit of
video, too, the Giottos makes for a more versatile choice.

Slik SBH-280E [EX1

® Weight: 303g + 399

® Height: 100cm

@ Base diameter: 51mm Ball size: 25mm
® Maximum load: 5kg

® QR system: Slik 6183

® Website: www.intro2020.co.uk

Very well made, with a design that's slightly unusual,
the Slik SBH-280E head comprises one large knob to
control everything, including locking the smallish
25mm ball. It's rated for a modest 5kg load but can
take much more. This is a tough head and works well. There's minimal
shift on locking down — in fact, we found it to be one of the best tested.
It's nice to use, too. The main knob has a finely machined grippy

surface, locking solid in only 1/8th of a turn. The quick-release plate has a
non-slip cork surface and drops easily into place as the lever snaps shut.
Allin all, this is a good offering from Slik at a reasonable price.
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Bagsandbackpacks

Expert advice on storage to protect your camera gear

MOST OUTDOOR PHOTOGRAPHERS prefer backpacks as they distribute
weight over your shoulders and back, making it far easier to carry gear
over long distances. The daypack holds photo gear in the bottom section
and general items in the top compartment, while dedicated photo
backpacks are designed with larger kits in mind. Consider the following:

® Comfort: As you carry more kit, the weight increases, so shoulder straps
are important. The wider and more padded they are, the less they dig into
your shoulders. Waist straps are useful, as they relieve tension from the
lumbar region and help keep your back straight. Another important factor
is the bag's frame. Some are sturdier than others which may seem
uncomfortable at first, but it helps keep your back straight on long treks.

@ Capacity: Think about how much kit you plan to carry. All the bags here
have adjustable compartments, so are quite versatile.

®Build quality: How well the backpack is put together, including the
stitching, zippers and weatherproofing, determines how long it ought to
last, how strong itis and how well it protects your equipment.

@ Features (see panel below): Some photographers just want a bag with
lots of space, others are more demanding over specific features. Most
have front pockets, designed to help you organise your memory cards
and batteries into used and unused.

®Price: We have stated the average street price from a number of popular
retailers and not the manufacturer’s guide price.

Features

1) Straps Check to see if
the straps are adjustable,
padded and wide to stop
them from cutting into your
shoulders on long journeys.
Also look for waist straps.

2) Padding Some bags
have pressure pads on the
back, which will take a lot of
the strain out of long journeys
and spread the weight of the
gear over a larger area.

3) Storage/capacity

Does the bag hold all the
equipment you need for your
photography? If there is too
much empty space, the bag
will be unbalanced, which
can be bad for your back. All
the bags featured here have
adjustable dividers and offer
quite a bit of versatility.

4) Weatherproofing/

rain cover Most bags are
weather resistant. Some "
are weatherproof, and N )
others have all-weather et 3

covers that can be pulled out
from a hidden compartment,
usually on the base.

5) Laptop compartment
Make sure that the laptop
compartment is big enough
for your computer, as they
vary in size. The padding is
also important here.

6) Accessory clips Some
bags allow you to attach
further bags, tripods and
monopods, but be aware that
some are only compatible
with the bag manufacturer’s
own clip systems.

7) Zips If you go out a lotin
bad weather or near water,
make sure that the zips are up
to it. Wildlife photographers
should also consider the noise
made by the zips as animals
can be easily frightened off.

THE NIKON GUIDE TO LANDSCAPE PHOTOGRAPHY

Fitting and wearing a bag properly

If you're carrying a lot of heavy kit, it's important that your bag sits correctly
on your back or at your side. This advice can prevent all kinds of back and
posture problems. With a backpack, ensure that both straps are over your
shoulders and tightened so that the bag sits in the centre of your back. If it
has waist and chest straps, make sure you use them to distribute the
weight evenly across your back, rather than just your shoulders. For
shoulder bags, pull the strap over your head to the opposite shoulder. This
should distribute the weight better than if it were on the closest shoulder
and stop it from slipping off your shoulder or being easily snatched.

Gadgetbag Backpack P

-

Lowepro CompuDay Photo 250 [}

® Dimensions: 40x32x18cm

® Weight: 900g

® Warranty: Lifetime

® Contact: 01902 864646

® Website: www.lowepro.com

This laptop bag has plenty of room
for everyday items and a padded
side compartment big enough for

a DSLR with standard zoom. While
the camera aspect is not exactly an
afterthought, the large and deep
main compartment is better suited
to aflask and sarnies than

anything specifically

photographic. There are no
dividers, but there’s room for a spare
lens or flashgun if protected in a

soft wrap. The top zip also has a rain
flap. It's a great concept for carrying
a camera alongside your general
workday kit. There are pockets for
documents and a separate interior bag for a laptop charger and leads. The
harness is simple, just shoulder straps, though the contoured shape makes
it easy to carry the bag over one shoulder with quick access to the camera.

Lowepro Flipside 400 AW [EX)

® Dimensions: 45x30x24cm

® Weight: 1,540g

® Warranty: Lifetime

® Contact: 01902 864646

® Website: www.lowepro.com

This is a serious backpack, designed
for carrying lots of camera gear with
comfort and security. The whole of
the back unzips to open a storage
area the full size of the bag, large
enough for a couple of cameras,
four or five lenses up to almost any
length, flash and accessories.
Whenyou're carrying it, there's no
access to the main compartment —
for you or anyone else. Comfortis
assured by shoulder strapsand a
chest strap, the waist band is deep
and heavily padded, and includes
accessory loops. Lowepro claims you
can rotate the bag around to your front and

access gear while it's attached to your waist, but that's asking a lot when it's
full. The front compartment is quite shallow and thinly padded, but deep
and large enough for small personal items and an iPad, but not a laptop.
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Vanguard UP-Risc 45

® Dimensions: 43x32x22cm

® Weight: 1,600g

® Warranty: Limited lifetime

® Contact: 01202 651281

® Website: www.vanguardworld.co.uk

The UP-Rise tag refers to Vanguard's
expansion system, supposedly
unzipping extra space when needed
but, in practice with the 45, it makes
barely any difference. Not that it is
short on space, or features.

The main compartmentis large
enough fora DSLR with up to
70-200mm zoom attached, plus two
or three extra lenses and a flashgun.
Grabbing the camera through the side
flap is easy, with lesser-used items
accessed by unzipping the back. The
padded top compartment s large,
and the bottom can be detached to swing
down and form one very large holdall. There
are a number of thoughtful touches, like the camera compartment
secured with fast-pull twin zips, plus Velcro and a clip. There are dual grab
handles, a rain cover and a good tripod slot with adjustable straps.

Vanguard Hcraldcr 33

® Dimensions: 42x27x35cm

® Weight: 1,620g

® Warranty: Lifetime

® Contact: 01202 651281

® Website: www.vanguardworld.co.uk

You get a lot for your money
just crammed with features,
too many to mention

here. Take for granted

that this is a big bag with

all the normal stuff, plus a
generous helping of extras.
For instance, the top zip
opens wide for direct access
to the main compartment,
which can be removed
completely so that the bag
becomes a general holdall. The
padded laptop pouch lifts out, too.
A decent-sized tripod sling appears
like magic from the front, and a rain cover from the back. The shoulder
strap has an extra support strap that you may need when this heavy bag is
full (or go for the optional-extra full shoulder harness) and there's a handy
mini-bag included for things like batteries and cables, too.

Tamrac Evolution 6

® Dimensions: 42x26x19cm

® Weight: 1,510g

@ Warranty: Lifetime

® Contact: 01628 674411

® Website: www.intro2020.co.uk

This is one of Tamrac's clever Evolution
series, which includes two larger
versions in the range. There are three
ways of carrying it: as a backpack,

or as either a left- or right-handed

sling. There are three entry points to

the main camera compartment:

from both sides and the front.

It works well as a sling for fast access,
with the other shoulder strap and
waistband tucked away behind the rear
padding. Camera access is through the
side, where there’'s room for a DSLR and
medium-sized zoom. There's also enough
space for another lens or maybe two, plus
flash, and you can get at those either through the front flap, or from the
opposite side. The top compartment has useful extra capacity, wide
enough fora 70-200mm zoom. The outer is well padded, but any
equipment in there would need its own protection.

Lowcpro Pro Runncr450 AW

® Dimensions: 34x29x50.5cm
® Weight: 2,700g

® Warranty: Lifetime

® Contact: 01902 864646

® Website: www.lowepro.com

The Pro Runner 450 AW holds a lot
of gear, with room for two large
DSLRs with zooms attached, and
space for several extra lenses,
flashguns, a third body and a

17in laptop, too. The shoulder
straps are thickly padded and
adjustable, and the waist beltand
carry handle will be appreciated
when carting about all that weight.
The compression straps help
reduce the bulk on the 450 AW for
easier transportation, there'sa
built-in all-weather cover and loops
are handy for carrying a tripod. The front
pocket will hold a few personal items, the

three internal pockets feature windowpane panels to help keep things like
filters on display, and there are two dedicated memory card pouches, too.
This bag is a great option for carrying a large outfit as well as personal gear.

Tamrac Advcnturc 9

® Dimensions: 28x33x51cm

® Weight: 900g

® Warranty: Lifetime

® Contact: 01628 674411

® Website: www.intro2020.co.uk

Tamrac’s Adventure range includes
four backpacks and this is the smallest,
with light weight and mobility in mind.
It features a clamshell design — the
main compartment unzips and hinges
open to reveal a modest space just big
enough for a smaller DSLR with kit
zoom and maybe an extra lens or
flash, but no more. Protection is

good. The top compartment is
roughly the same size, and large
enough for lenses up to a 70-200mm
zoom, plus another lens or a flashgun,
but the outer fabric has no additional
padding. The front pocket takes a
couple of filters and a phone, and drinks can be tucked into the side
pockets. The harness makes no concessions to size, offering good
support and comfort. It's a full three-point jobbie with adjustable chest
and waist straps, including accessory loops.

Tamrac Ultra Pro 13 B

® Dimensions: 46x31x31cm
® Weight: 2,584g

® Warranty: Lifetime

® Contact: 01628 674411

® Website: www.intro2020.co.uk

This Tamrac bag is suited to
larger outfits. Instead of a
separate laptop case, there's
alarge slotin the front, plus

two good ZipDrop front
pockets and two more under
thelid, allwith Tamrac’s
see-through Windowpane-
mesh. When the bag is set
down and open, there’s good
access to everything. The
standard layout is to have two
pro-size DSLRs with lenses
attached across the top, though
the dividers can be customised. The top is secured by a zip, four clips and
Velcro tabs to take the weight, with a large central handle. The rain cover is
in an accessory pouch on the side where there are twin loops at either end.
Tamrac's Strap Accessory System is similar to Lowepro's SlipLock and
Think Tank Skins — good for expanding capacity.
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Metered to perfection!
Scenes with bright skies can
lead to exposure error. Use
agrey card and you should
have no problems.

Howtousc your mctcring White Balance cards

THE NIKON GUIDE TO LANDSCAPE PHOTOGRAPHY

TOPTIP

Be sure to bracket!
Whether you use the grey
card or not, in tricky lighting
conditions, bracket your
exposure by +/-1 stops
using your camera’s
exposure compensation or
AEB functions to ensure
you get the shot

The 18% grey card can be used to ensure perfect exposures when shooting in tricky lighting conditions. Both
reference cards can also be used to set a custom White Balance. Depending on the camera you use, you need to
take a White Balance reading off the grey or the white card (your camera'’s instructions will show you how)

NIKON DIGITAL SLRS USE sophisticated exposure systems and all work
using the same assumption that the average of the scene thatis being
metered from is a mid-tone, or 18% grey to be exact; ie the average of all
dark, lightand mid-tones mixed together is 187% grey. It's the basis of all
metering patterns and works surprisingly well, but while it's fine for the
majority of shooting situations, it can lead to incorrect exposures when the
scene or subject is considerably lighter or darker in tone than 18% grey. For
example, very dark areas can fool the metering system into overexposure.
Similarly, very light subjects, such as a snow scene, can fool the camera into
underexposing them — making them appear darker than they are — as the
light meter will take a reading designed to render them as a mid-tone. Asa
camerais trying to render animage ‘grey’, it's your job to ensure you
compensate to keep the tones true to life. You can do this by using one of
your DSLR’s exposure override facilities, such as exposure compensation or

-'--'{."‘

Getting started Place your grey card on the
ground angled towards you and ensure it's
located in a spot that is bathed in the same light
as the majority of the scene you plan to shoot.

Take a meter reading Ensure that the entire

metering area is filled by the grey card (in this
instance we're using multi-zone metering) and
lock the exposure with the AE-Lock button.

the AE-Lock button, or by metering from an area of the scene that has a
mid-tone. And that's where our grey card comes in. Using it is very simple as
our step-by-step guide below illustrates. Remember that you need to place
the grey card in similar lighting to your scene: for instance, dont place itina
shaded area if your scene is bathed in sunlight. Also make sure that the card
fills the metering area — we recommend you use spot metering as the card
won't need to fill the entire image area, but any is suitable. You can either
lock the exposure using your camera’s AE-Lock facility or note the aperture
and shutter speed, and then switch to manual mode and set these
(although this method isn't suitable to days where lighting is variable). The
card has AF reference lines to help your camera’s autofocus lock on toit.
However, you don't necessarily need it to be in focus to work correctly. The
grey card (as well as the white card) can also be used to take a custom White
Balance reading from, too.

Compose & shoot With this exposure locked,

you can compose your scene and take your
shots. When you check it on your LCD monitor,
the exposure should be perfect.
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